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Introduction 
 

Thanks for choosing the MPC Touch. Fusing Akai Professional’s legendary MPC layout and workflow 
with the power of your computer, MPC software is an unrivaled instrument for music production. 

Introducing a new approach to music production with an ultra-fast and super-intuitive workflow, the 
Touch is powered by a radiant 7” color multi-touch display. Literally grab and pinch waveforms, draw 
midi events, adjust envelopes, chop samples, add effects and precisely set your controls using your 
fingertips. Combined with the classic MPC feel, sound and vastly improved pads, the MPC Touch 
embodies the best elements of our past while taking music production tech into the future. 

 
Welcome to the MPC family. 

 
Akai Professional  

 
 
System Requirements and Product Support 
 

For the latest information about this product (system requirements, compatibility information, etc.) and 
product registration, visit akaipro.com. 

For additional support, visit akaipro.com/support. 

http://www.akaipro.com
http://www.akaipro.com/support
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About This User Guide 
 

This manual should help you get familiar with using the MPC Touch to control your MPC software. 

For consistency, the terminology throughout is based on the MPC parameter names.  

We also used specific formatting to indicate particular topics of significance: 

 

Important / Note / Tip: Important or helpful information on a given topic. 

 

Names of buttons, controls, parameters, settings, and other options are written in bold characters 
throughout the manual. 

Examples: Press the Play Start button. 

Turn Q-Link Knob 4. 

Tap the Mute button. 

The Velocity ranges from 0 to 127. 

Set the Sample Play selector to One-Shot. 

Click BPM, and then use the numeric keypad to enter a 120 as the tempo. 

 

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic 
blue characters. Click the text to skip immediately to that section. 

Examples: Read the Important Notes section before proceeding. 

For more information about installing the necessary drivers and software, please see 
the Installation section. 

To learn more about using send effects, please see General Features > Effects > 
Send/Return Effects. 
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Important Notes 
 

• Read the included Safety & Warranty Manual before using the MPC hardware. 

• Before getting started and connecting devices to the MPC hardware or turning the hardware on/off, 
make sure all devices are switched off. 

• Before installing the MPC software, make sure your computer meets the system requirements 
described at akaipro.com. This applies whether you’ll use MPC software as your host software or 
as a plugin. 

• Before connecting the MPC hardware to your computer, install the drivers and software. Visit 
akaipro.com to download the latest versions. Refer to the Installation section for more information. 

 
 
Setup 
 
1. Installation 
 

To download and install the required drivers and MPC software: 

1. Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, 
you will be prompted to create one. 

2. Download the MPC Software Package. 

3. Open the file and double-click the installer application. 

4. Follow the on-screen instructions to complete the installation. 

Note: By default, the MPC software will be installed in [your hard drive] \ Program Files \ Akai Pro \ 
MPC (Windows®) or Applications (Mac® OS X®). A shortcut will be created on your Desktop, as well. 

 

http://www.akaipro.com
http://www.akaipro.com
http://www.akaipro.com
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2. Connection 
 

Here is just an example of how to use MPC Touch in your setup. Items not listed under Introduction > 
Box Contents of your included Quickstart Guide are sold separately. 

 

 
 
 
 

Computer Drum Machine Powered Monitors 

Power 
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3. Getting Started 
 

1. Power on MPC Touch. 

2. On your computer, open the MPC software. 

3. Follow the on-screen instructions to authorize your version of MPC. For more specific instructions, 
see the following section, Unlocking Your MPC Software. 

4. In the MPC software, click the Edit menu, and select Preferences. Click the Audio tab and select 
the sound card you want to use. Click OK when you are done. 

5. Remove the protective film from the MPC Touch display, and start making music! 

Important: To view the MPC software User Guide click the Help menu and select MPC Help. 
 

Important Note for Mac OS X Users: 

If you want to be able to use other apps on your computer as you are using the MPC Touch display, 
please do the following: 

1. On your computer, open the System Preferences. 

2. Select Mission Control. 

3. Check Displays have separate Spaces. 

4. Close the System Preferences. 
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Unlocking Your MPC Software 

 

To unlock the MPC software: 

1. Connect your MPC Touch to a USB port on your computer and to a power source. 

2. Power on the MPC Touch. 

3. Open the MPC software. 

4. In the dialogue box that appears, click Unlock Now. 

5. Enter your information in the window that appears. 

6. If your computer is connected to the Internet, click Unlock Now, and enjoy your MPC!  

If your computer is not connected to the Internet, follow these additional steps: 

7. Click Use Web Form. 

8. The window that appears will have your name, serial number, and software ID number. Click Save 
Details to save this information as a .txt file, or copy the information from each field into another file 
of your choosing. 

9. On a computer connected to the Internet, go to authorizations.akaipro.com/MPC, enter the copied 
information, and click Unlock My MPC. 

10. Copy the unlock code from the window that appears. 

11. In your MPC software, go to the window from Step 5 and click Enter Code. 

12. Enter your name and the unlock code generated by the webpage. 

13. Click Unlock, and enjoy your MPC! 

http://authorizations.akaipro.com/MPC


                 

 
15 

 

 

Features 
 
This chapter explains the features and functions of your MPC hardware. 
 
 
Top Panel 
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1. Display: This full-color multi-touch display shows information relevant to MPC Touch’s current 

operation. Touch the display (and use the hardware controls) to control the MPC software. See the 
later Display section to learn how to use some basic functions. 

2. Display Brightness +/–: Use these buttons to increase/decrease the brightness of the display. 

3. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values 
of the selected field in the display. 
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4. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The 
knobs can control one column of parameters at a time. The lights above the Q-Link Knobs indicate 
the currently selected column. Press the Q-Link button above them to change which column of 
parameters they currently control. 

5. Q-Link Button: Press this button to change which column of parameters the Q-Link Knobs currently 
control (indicated by the lights above the Q-Link Knobs). Each press will select the next column. 

Press and hold Shift and then press this button to select the previous column instead. 

6. Pads: Use these pads to trigger drum hits or other samples in your software. The pads are velocity-
sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads 
will light up different colors, depending on how hard you play them (ranging from yellow at a low 
velocity to red at the highest velocity). You can also customize their colors. 

7. Pad Bank Buttons: Press any of these buttons to access Pad Banks A–D. Press and hold Shift 
while pressing any of these buttons to access Pad Banks E–H. Alternatively, double-press one of 
these buttons. 

8. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample 
repeatedly. The rate is based on the current tempo and Time Correct settings. 

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, 
you do not have to hold the Note Repeat button for it to be activated. Press Note Repeat once more 
to unlatch it.  

9. Full Level/Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will 
always trigger their samples at the maximum velocity (127), regardless of the amount of force you use. 

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, 
the pads will always trigger their samples at half-velocity (64). 

10. 16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit 
will be temporarily copied to all 16 pads. The pads will now output the same note number as the 
initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers 
increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press 
them. In the window that appears, use the Type selector to choose the parameter: Velocity, Tune, 
Filter, Layer, Attack, or Decay. See Operation > General Features > 16 Level to learn more. 

11. Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note 
event for that pad at the current playback position. This is a quick way to delete note events from 
your Sequence without having to stop playback. 
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12. Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray 
writing). Alternatively, double-press the desired button. 

Double-press this button to see which buttons have secondary functions—the buttons will flash for a 
few seconds.  

13. Menu/Browse: Press this button to open the Mode Menu. You can tap an option on the Menu 
screen to enter that mode, view, etc. 

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate 
and select programs, samples, sequences, etc. on your computer as well as in the current project. 

14. Main/Track: Press this button to enter Main Mode in the display and software. 

Press and hold Shift and then press this button to enter Track View Mode in the display and software. 

15. Undo/Redo: Press this button to undo your last action. Hold down Shift and press this button to 
redo the last action you undid. 

16. Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, 
press the “source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is 
selected, press the “destination” pad. You can select multiple destination pads, and you can select 
pads in different pad banks. Tap Do It to continue or Cancel to return to the previous screen. 

Press and hold Shift and press this button to delete. 

17. –/+: Press these buttons to decrease/increase the value of the selected field in the display. 

18. Play: Press this button to play the sequence from the audio pointer’s current position. 

19. Play Start: Press this button to play the sequence from its start point. 

20. Stop: Press this button to stop playback. You can double-press this button to silence audio that is 
still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI 
panic” and shut off all voices and stop all audio processing. You can also press this button to abort 
the loading any files that are being loaded (e.g., if you select a project or program by accident). 

21. Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. 
Recording in this way (as opposed to using Overdub) erases the events of the current sequence. 
After the sequence plays through once while recording, Overdub will be enabled.  

22. Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence 
without overwriting any previously recorded events. You can enable Overdub before or during recording. 

23. Tap Tempo: Press this button in time with the desired tempo to enter a new tempo (in BPM) in the 
software. 

Press and hold Shift and press this button to switch between the sequence tempo and master tempo. 
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Display 
 

Here is some general information about how to use the MPC Touch display: 

 

Tap a button or option to select it. Use the 
Data Dial or –/+ buttons to change its 
setting or value. 

 

 

 

 

 

 

 

 

 

Double-tap a button to access advanced 
editing options. In some cases, this will 
show a numeric keypad that you can use 
to enter a value (an alternative to the Data 
Dial or –/+ buttons). Tap the upper-left 
part of the display to return to the 
previous view. 

 

 

 

 

 x2
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Spread two fingers to zoom in (into a section of a 
waveform, for example). Pinch two fingers to zoom out. 

 

 

 

 

 

 

 

 

 

The upper edge of the display shows the 
toolbar, which contains information about the 
current view (often the name of the current 
track, sequence, audio pointer position, etc.). 
Tap an item to select it. 

The lower edge of the display shows various 
buttons that you can use in the current view. 
Tap a button to press it. 

To return to a previous view, either tap outside 
of the window currently in the display or tap 
the left arrow () in the upper-left part of the 
display. 

When the left-most button at the bottom of 
the touchscreen shows an upward arrow (), 
it means there are additional buttons you can 
use when you press and hold Shift. Press and 
hold Shift to show the secondary buttons, and 
any of them, if desired. Release Shift to return 
to the previous buttons. 
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Rear Panel 
 
 

12 3 4 56 7
8 9

10 11

 
 
 
1. Power Input: Use the included power adapter to connect MPC Touch to a power outlet. 

Alternatively, you can power MPC Touch via the USB port only, but the display will be disabled. 

2. Power Switch: Turns MPC Touch’s power on/off. 

3. USB Port: Use the included USB cable to connect this high-retention-force USB port to an available 
USB port on your computer. This connection allows MPC Touch to send/receive MIDI and audio 
data to/from the MPC software.  

You can power MPC Touch via the USB port only, but the display will be disabled. 

4. Rec Vol: Turn this knob to adjust the volume of the inputs. 

5. Master Vol: Turn this knob to adjust the volume of the outputs and phones output. 

6. Inputs: Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to an audio source (mixer, 
synthesizer, drum machine, etc.). In the software, you can select whether you want to record either 
channel or both channels in stereo or in mono. 

7. Outputs: Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors, mixer, 
etc.). In the software, you can select whether you want to record either channel or both channels in 
stereo or in mono. 

8. Phones: Connect standard 1/8” (3.5 mm) stereo headphones to this output. 
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9. MIDI Out: Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this output to 
the MIDI input of an external MIDI device (synthesizer, drum machine, etc.). 

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI Out. Use 
the included 1/8”-to-5-pin adapters to connect MIDI devices only. 

10. MIDI In: Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this input to 
the MIDI output of an external MIDI device (synthesizer, drum machine, etc.). 

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI In. Use the 
included 1/8”-to-5-pin adapters to connect MIDI devices only. 

11. Kensington® Lock Slot: You can use this slot to secure your MPC Touch to a table or other surface. 
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Quick Start / Tutorial 
 

This chapter should help you to familiarize yourself with some basic MPC features. To get the most out 
of this tutorial, we recommend reproducing each of the described steps. 

The display on your MPC Touch reflects what it is controlling in the software, but due to space and 
character limitations, the hardware display is slightly different (e.g., parameter names may be 
abbreviated, the layout may be different or spread across multiple tabs, etc.). 

Important: MPC Touch’s Q-Link Knobs control one column of parameters at a time. Whenever this 
manual instructs you to use the Q-Link Knobs to adjust parameters, you can use the Scroll Knob 
(above the Q-Link Knobs) to move through the different columns. 

On the following pages we will create a short song to show you important aspects of using the MPC 
software in conjunction with the MPC Touch. 

 
 
Starting Up 
 

Make sure you have completed all of the steps described in Introduction > Setup. This includes: 

• Installing the necessary drivers and software. 

• Connecting your MPC Touch to a power source using the included power adapter and powering it on.  

• Connecting your MPC Touch to your computer with a standard USB cable. 

• Open and unlocking your MPC software. 
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Creating a Drum Kit 
 

Let’s start by making a simple drum kit. 

 

Press Shift+Menu/Browse to show the Browser. Then, use the touchscreen to navigate to where your 
drum sounds are located: 

• To view the files and folders on your computer, tap Project in the lower-left corner. 

• To view the pads and the project’s sample pool, tap Samples in the lower-left corner. 

• To move to the previous folder, tap the up (∧) button in the upper-left corner. 

• To move through a list, swipe up or down. To move more quickly, use two or three fingers. 

• To skip to the top or bottom of the list, swipe left or right (respectively) with two fingers. 

• To select a file or folder, tap it. 

• To enter a selected folder, tap it once more or tap Open. 

• To load a selected sample file, tap it once more or tap Load. This will load it to the currently 
selected pad (lit green) and the project’s sample pool. 

• To load an entire folder of samples, press and hold Shift, and then press Load All. This will load 
all samples in the selected folder to the project’s sample pool. 

• To preview a selected sound, tap Play () at the bottom of the touchscreen. 

 

  
                            Viewing folders in the Browser.                                            Viewing files in the Browser. 
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There are two ways to load samples in this mode: using the Project tab or the Samples tab. Let’s try 
each of them. 

 

First, load a bass drum using the Project tab: 

1. Make sure the Project button in the lower-left 
corner of the touchscreen is marked red. If it 
isn’t, tap it. 

2. Press Pad 1 or tap Pad 1 in the touchscreen to 
select it. The pad will be lit green. 

3. Use the techniques listed above to find a bass 
drum sample you like. 

4. To load it to the selected pad (Pad 1, in this 
case), either double-tap it, or tap the Load 
button in the lower-right corner. Now, you can 
press Pad 1 to play the bass drum sample. 

Tip: To load an entire folder of samples, press 
and hold Shift, and then press Load All. 

 

Next, load a snare drum using the Samples tab: 

1. Tap Samples at the bottom of the touchscreen. 
This lets you view the pads and project’s sample 
pool. 

2. Press Pad 2 or tap Pad 2 in the touchscreen to 
select it. The pad will be lit green. 

3. Use the techniques listed above to find a snare 
drum sample you like. 

4. To load it to the selected pad (Pad 2, in this 
case) double-tap it. Now, you can press Pad 2 to 
play the snare drum sample. 

 

To create a simple drum set, repeat the above steps for other pads. We recommend loading a closed hi-
hat and an open hi-hat. 

The Project tab in the Browser 

The Samples tab in the Browser. 
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Recording a Drum Sequence 
 

Now that your drum kit is set up, let’s record a drum sequence. 

 

1. Press the Rec button to activate Record Mode. 

2. To start the actual recording, press the Play button. The pre-count will count one measure before 
the software starts to record. We recommend recording only one sound (pad) at a time, especially if 
you are not familiar with playing drums on the pads. 

3. Play a simple bass drum pattern. The note events you just recorded will automatically be placed in 
the grid (in this case, on 16th notes). The initial measure length is two bars. After the two bars, the 
recording will enter Overdub Mode automatically; the sequence plays again from the beginning and 
keeps looping, allowing you to record further notes. Don’t stop the recording! 

4. Play the snare drum part, then a hi-hat part. 

5. When you’re done recording, press the Stop button. 

 

If you start recording again on this sequence, keep in mind that the pads you play in your new recording 
will automatically replace existing notes played with the same pads. To prevent this, you can start again 
from Step 1 but press the Overdub button instead of the Rec button. Overdub lets you record additional 
note events over the existing Sequence. 

The Undo button functions differently while in Record Mode. Normally, pressing Undo will undo just the 
last event. When there is an event to undo, the Undo button will be lit solid. While recording, the Undo 
button will flash. In this case, pressing Undo will erase all events from that recording (i.e., since Play or 
Play Start was pressed). 

 
 



                 

 
26 

 

 
Organizing Samples 
 

We recommend doing some renaming of your programs and samples before going further.  

The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged 
into a program. When you load this program in the future, you will be able to use all of the samples that 
belong to it. 

Let’s rename the exisiting program as we’ll want to create more programs later on. 

 

To rename a program: 

1. Press Main to enter Main Mode. 

2. In the Program section in the lower part of the touchscreen, tap the cursor icon on the right edge. 

3. Use the virtual keyboard that appears to enter a new name (e.g., “Drums”), and then tap Do It. 

 

 

Renaming a program in Main Mode. 
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To rename your samples, let’s use your computer. In the Project Information panel, right-click a sample 
name a sample (e.g., “1980Kick1”) and select Rename. Use your computer keyboard to rename the 
sample (e.g., “Bass Drum”). Repeat this for the other samples in the program. This will help keep your 
program organized as you add more samples to it. 

 

The Project Information panel in the software. 

 

Now would be a good time to save your project. 

 

To save your project, using your computer, click the File menu and select Save Project. Alternatively, 
press Ctrl+S (Windows) or +S (Mac OS X). 
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Editing Note Events 
 

In the grid, you can see your recorded notes (or note events) as a sequence. 

To enter Grid View, press Main, and then tap the grid icon on the left side of the touchscreen. 

 

 

The Grid View with Pad A02 selected. 
 

In the Grid View, you can do any of the following: 

• To zoom in or out, tap the magnifying-glass icon in the upper-right corner. Then, in the grid, spread 
two fingers apart or pinch two fingers together. You can do this for each axis, horizontal or vertical. 

• To select all notes for a pad, press the desired pad. 

• To select a single note, tap the select box in the upper-right corner. Then, in the grid, tap the note. 

• To move the selected notes, tap Nudge at the bottom of the touchscreen, and then use the Data 
Dial or –/+ buttons to shift the notes left or right. 

By default, you can position notes only by quantization values, defined by the Time Correct value 
(see below). 

To change the position of notes without restricting (“snapping”) them to the grid, tap and hold 
Don’t Snap in the lower-left corner of the touchscreen, and then use the Data Dial or –/+ buttons 
to shift the notes. In this case, each nudge is equivalent to 4 ticks. 



                 

 
29 

 

 

• To adjust the start point or end point of the selected notes (without changing their position), tap 
Edit Start or Edit End at the bottom of the touchscreen, and then use the Data Dial or –/+ buttons. 

• To transpose the selected notes up or down, tap Transpose at the bottom of the touchscreen, 
and then use the Data Dial or –/+ buttons. 

• To adjust the velocity of the selected notes, tap Velocity at the bottom of the touchscreen, and 
then use the Data Dial or –/+ buttons. 

• To show or hide the velocity lane, tap the up (∧) button in the lower-right corner of the 
touchscreen to show the velocity lane below the grid. Each note’s velocity is represented by a 
vertical bar. The higher and more red the bar is, the higher the velocity is.  

Tap the up (∧) button once more to show a taller version of the velocity lane after which it will turn 
into a down (∨) button, which you can then tap to hide the velocity lane. 

 

 

Adjusting velocities in the Grid View. 
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• To open the Timing Correct settings, press and hold Shift, and then tap TC at the bottom of the 
touchscreen. See Operation > Modes > Main Mode to learn about these settings. 

• To open the metronome settings, press and hold Shift, and then tap Click at the bottom of the 
touchscreen. See Operation > Modes > Main Mode to learn about these settings. 

• To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + 
(respectively) at the bottom of the touchscreen. 

• To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the 
bottom of the touchscreen. 
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Making Basic Sound Edits 
 

Let’s make sure the samples are properly tuned and have good levels. 

Press Menu, and then tap Program Edit to enter Program Edit Mode. 

 

 

Adjusting Pad A01’s parameters in Program Edit Mode. 
 

Press a pad to show its parameters in the touchscreen. 

• To adjust its volume, tap and drag the Volume knob up or down. Alternatively, use the Data Dial 
or –/+ buttons. To make finer adjustments, double-tap the knob and adjust the larger version that 
appears. Tap anywhere else to return to the previous screen. 

• To adjust its stereo panning, tap and drag the Pan knob up or down. Alternatively, use the Data 
Dial or –/+ buttons. To make finer adjustments, double-tap the knob and adjust the larger version 
that appears. Tap anywhere else to return to the previous screen. 

Adjust the level of each pad to suit your taste. We recommend spreading the panning of the bright 
sounds (e.g., cymbals, snare drum) a little. Additionally, you can tune the bass drum by adjusting the 
Semi and Tune knobs in the same way you adjusted the Volume and Pan knobs. 
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The snare drum may need some reverb to give it a more spatial sound.  

Tap Effects at bottom of the touchscreen to view the Insert Effects tab. Press the pad with your snare 
drum sound to select it. 

 

 
Adding insert effects to Pad A02 in Program Edit Mode. 

 

To add an effect: 

1. Double-tap the desired slot. A list of effects will appear.  

2. Swipe up or down to move through the list. 

3. To load an effect, double-tap it. Alternatively, tap it once and then tap Select or push the Data Dial. 
Let’s try Reverb Medium. 

4. To close the list, tap Close. 

 

To adjust the effect’s parameters, tap the pencil icon. To empty the effect slot, tap the trash can icon. 
Switch the effect on or off by tapping the On/Off button for the slot.  
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Recording a Bass Track 
 

Let’s try recording a bass line. Unlike a drum kit, it’s important to be able to play and record a bass 
sound chromatically, so this will be slightly different than setting up the drum kit. 

Adding a bass line over the drum part means we need to work on a new track. A track is simply a layer 
of a sequence. You can work with multiple tracks in a single sequence (e.g., a drum track, a bass track, 
a piano track, etc.). when you play the sequence, all of them will play simultaneously.  

First, we’ll select a new track. 

 

To select a new track:  

1. Press Main to go back to Main Mode. 

2. Double-tap the Track field in the center-left part of the touchscreen, and then tap Track 2 (unused) 
in the list of tracks that appears. 

Alternatively, simply tap the Track + button at the bottom of the touchscreen until (unused) appears 
in the Track field. 

 

 
Selecting a new track in Main Mode. 
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Let’s create a new program to assign to this empty track. 

 

To create a new program:  

1. In the Program section in the lower part of the touchscreen, tap the + button next to Program. 

2. On the right side of the touchscreen, tap the cursor icon. 

3. Use the virtual keyboard that appears to enter a new name, and then tap Do It. 

4. Back in the Track section in the middle of the touchscreen, tap the piano icon. This makes the program 
a keygroup program, which is necessary to play the bass sound chromatically with the pads. 

 

 
Creating a new program in Main Mode. 



                 

 
35 

 

 

To load and edit a bass sound, let’s use the software window instead of MPC Touch: 

1. If the Browser panel is not visible on the left side of the window, click the triangle () in the lower-left 
corner to show it. 

2. In the Browser, locate and select a bass sample. 

3. Double-click a sample to add it to the project. Keep in mind that the sample isn’t assigned to a pad yet. 

 

Let’s continue to set up the keygroup program: 

1. Click the Program Edit icon in the upper-left corner of the window to enter Program Edit Mode. 
Alternatively, press Ctrl+2 (Windows) or +2 (Mac OS X) on your computer. 

2. In the Layer section, click the Layer 1 drop-down menu and 
select the bass sample you just loaded (you’ll see your drum 
samples in this list, as well). Because you’re working with a 
keygroup program instead of a drum Program, this sample is 
now playable across all pads. 

Tip: On your MPC Touch, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. 
You should hear the bass sample played back with its original pitch. You can use the other pads to 
play your sample chromatically.  
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Let’s add a second layer and set the layers’ velocity ranges so the bass will sound different when played 
at a higher velocity (as a real bass would): 

1. Go back to the Browser and select a different bass sample that sounds similar but a little bit brighter. 

2. Double-click a sample to add it to the project. 

3. Back in the Layer section, click the Layer 2 drop-down menu and select the new bass sample. 
Press a pad—both samples will sound at once. Maybe this new sound is interesting as it is, but let’s 
make some quick edits to get as close as we can to a real-life bass sound. 

4. Set Layer 1’s Velocity slider to cover the velocity 
range from 0 to 80, and set Layer 2’s Velocity 
slider to cover the range from 81 to 127.  

Now when you press a pad, the lower velocities will 
trigger the Layer 1 sample only, while higher 
velocities will trigger the Layer 2 sample only. 

 

Let’s record that bass line now. Prepare your recording as described earlier, and record some bass 
notes. You can edit your recording just like we’ve done earlier. 
 

 

A sequence using a keygroup program in the software window. 
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Once you’ve recorded it, let’s tweak the sound a bit in the Filter section: 

1. Click the Type drop-down menu, and select a filter. Let’s try working with 
the Low 4 type. 

2. Click and drag the Cutoff and Reso (resonance) knobs up or down until 
your bass sample sounds good to you. 

3. Click and drag the Amp Atk (amp envelope attack) and Amp Rel (amp 
envelope release) knobs up or down. These control the overall level 
characteristics of the sound. 

 

 

 

Do you want to add an effect? Do this in the Keygroup Inserts section at 
the end: 

1. Click the downward triangle () in the Insert 1 drop-down menu to 
show a list of effects. 

2. Click the Internal Effects group to expand it. 

3. Select an effect type for your bass line (e.g., Chorus 2-
Voice). 

4. Click Select to confirm your choice, or click Close to 
cancel. 

5. To adjust the settings of the effect, click its name in the 
insert slot to open a window that shows its parrameters.  

6. To activate or deactivate all keygroup insert effects, click 
the On/Off button in the upper-rigth corner of the section. 

 
So far, we’ve created a simple drum sequence and a bass 
line to go with it. Repeat this process to create a second 
sequence. 
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Creating a Song 
 

This section explains how to make a song out of your sequences. Before starting, make sure that you 
have recorded some sequences (which we described earlier in this chapter). 

To enter Song Mode, press Menu, and then tap Song. You’ll see each of the sequences you’ve 
created in this project assigned to a pad. The sequence playlist is to the left of the pads. 

As a song plays, it moves through each step of the sequence playlist. Each step contains a sequence 
you assigned. 

Each step can be repeated, determined by the value in the Repeat column (the repeat icon). A Repeat 
value of 1 means the sequence will play through only once. The Bars column on the right indicates the 
length of that step: [the number of bars in the sequence] x [the number of times it repeats]. 

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM 
column.  

 

 

Song Mode. 
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To insert a step at the current position, tap Insert. 

To delete the currently selected step, tap Delete. 

To set which sequence plays for a step, tap the step’s Sequence field, and then turn the Data Dial to 
select a sequence. 

To set how many times a sequence repeats, tap the step’s Repeat field (under the repeat icon), and 
then turn the Data Dial to select a number. 

To name the song, in the software window, double-click the Song 
drop-down menu (where is shows the song number and (unnamed)), 
enter a name using the computer keyboard, and then press Enter. 

 
 
 
 
 
Exporting the Song 
 

Want to share your new song? Just export it first. 

While in Song Mode, in the software window, click the File menu, select Export, and select As Audio 
Mixdown. Alternatively, press Ctrl+Shift+E (Windows) or +Shift+E (Mac OS X) on your computer 
keyboard. 

In the Audio Mixdown window that appears, do the following: 

• Set the Start field to 1, and set the End field to the last bar of your song. 

• As you’ll likely share the song online, select the mp3 file format option. 

Click Export. Choose where you want to save it, and then click Save to start exporting. 

To learn more about audio mixdown options, please see the MPC software’s User Guide: click the Help 
menu and select MPC Help. 
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Other Features Explained 
 

This chapter describes various advanced features. For a fuller explanation of these features, please refer 
to their corresponding sections in the Operation chapter. 

 
 
Step Sequencer 
 

You’ve already learned how to record note events on a track, but you can quickly enter note events in 
the Step Sequencer by using the pads as “step buttons,” simulating the experience of a traditional step-
sequencer-style drum machine. 

 

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. Alternatively, in some 
modes, you can tap the steps icon on the left side of the touchscreen. 

 

1. Let’s create a sequence on a new track. Tap the Track field in the upper-left corner, and then use 
the Data Dial or –/+ buttons to select an (unused) track. Alternatively, double-tap the Track field, 
and then tap a track to select it. 

2. To set a length for the track, tap the Track Length field at the top of the touchscreen, and then use 
the Data Dial or the –/+ buttons to select a length. If you select the minimum value, Sequence, the 
track will be however long your sequence it. 

Tip: This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum 
sequence repeatedly under a 4-bar bass line. 

3. To return to the previous screen without changing anything, tap the grey area in the upper-left corner 
of the touchscreen. 

4. Tap the Bar –/+ buttons at the bottom of the touchscreen to select the bar whose steps you want to 
create or edit. The bar number will appear in the Bar field in the upper-left corner. 

5. Tap the Pad –/+ buttons at the bottom of the touchscreen to select the pad whose steps want to 
create or edit. The pad number will appear in the Pad field in the upper-left corner.  

6. Press the Play button to start your sequence.  
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7. Each pad represents a step in the bar. If the pad already has note events on the selected track, the 
corresponding pads (steps) will be lit with colors corresponding to their velocities.  

To enter a note at a step, press an unlit pad. The pad will light up with a color corresponding to its 
velocity. 

8. To delete the note from a step, press a lit pad. The pad will become unlit. 

To delete all notes from the entire bar, press and hold Shift, and then tap Clear Bar in the lower-
right corner. 

 

 

The Step Sequencer. 
 

See Operation > Modes > Step Sequencer to learn more about this feature. 
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Drum Loops and Chop Mode 
 

Modern music producers often use drum loops to add grit and nuance to programmed beats. This 
section explains how to use Sample Edit Mode to work with drum loops. 

Use the Browser to locate a drum loop on your computer, and then double-tap it to add it to the current 
program. The loop does not have to match the tempo of anything in the project. 

 

To enter Sample Edit Mode, press Menu, and then tap Sample Edit. 

 

1. Tap the Sample field at the top of the touchscreen, and then use the Data Dial or –/+ buttons to 
select the loaded drum loop. You can scroll through all loaded samples in the project. Alternatively, 
double-tap the Sample field, and then tap a sample to select it. 

2. Tap the Trim/Chop button at the bottom of the touchscreen to switch between Trim Mode and 
Chop Mode. Select Chop Mode, which will let us cut the drum loop into slices. 

3. Tap the Threshold button, and then tap the Threshold field to the right of it. Use the Data Dial or –
/+ buttons select a value. Alternatively, double-tap the Threshold field and use the numeric keypad 
that appears to enter a value. The higher the threshold, the more slices will be created. Be sure to 
select a value so that every transient peak of the drum loop has a corresponding a slice marker. 

Tip: Each slice will be automatically assigned to a pad: Pad A01 plays Slice 1, Pad A02 plays Slice 
2, etc. Press each pad to play the slice with the same number. 

 
Using Chop Mode while in Sample Edit Mode. 
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Now, let’s create a new program containing all of these slices as individual samples. It will also 
automatically create corresponding note events to play back these slices sequentially. 

 

1. Press and hold Shift and then tap Convert at the bottom of the touchscreen to enter the Convert or 
Assign Slices window. 

2. Tap the Convert To field, and then use the Data Dial or –/+ buttons to select New Program with 
New Samples. 

3. Make sure Crop Samples is checked. If it is not, tap it. 

4. Make sure Create New Program is checked. If it is not, tap it. 

5. Make sure Create Events is checked. If it is not, tap it. 

6. Tap the Bars field, and then use the Data Dial or –/+ buttons to select how many bars the entire 
sample should use in your program. 

7. Tap Do It to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note 
event in the track. When you play that tack, it will play each pad (each slice) in the original order. 
Press Menu and then tap Grid View to see how the sample appears in your sequence. 

8. Press Play and listen to how the drum loop matches your song tempo now. 

 
Grid View with a sliced sample assigned to pads with notes. 
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You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with 
the note events playing their corresponding slices has been automatically created. Tap the TC button at 
the bottom of the touchscreen to use Time Correct to quantize the note events so they fall on exact, 
even time intervals. 

You can also rearrange the note events, thus creating a new playback order for the slices. You can also 
edit each slice or sample in Program Edit Mode. You can add effects for slices or use the filter function 
to change the frequency range of a selected slice. There are almost no limits to what you can do. 

See Operation > Modes > Sample Edit Mode > Chop Mode to learn more about this feature. 
 



                 

 
45 

 

 
Pad Muting and Track Muting 
 

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the 
sequence sounds like without those samples or parts. 

 

To enter Pad Mute Mode, press Menu and then tap Pad Mute. 

 

 

Pad Mute Mode. 

 

1. Press Play to play the sequence. 

2. Tap the Program field at the top of the touchscreen, and then use the Data Dial or –/+ buttons to 
select your drum program. Alternatively, double-tap the Program field, and then tap a program to 
select it. 

3. Mute a pad by pressing it once or tapping it on the touchscreen. The muted pad will be lit red. You 
can mute multiple pads at the same time. 

4. To mute pads on another program, repeat Steps 3–4. 
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You can also mute entire tracks by using the similar Track Mute function. 

 

To enter Track Mute Mode, press Menu and then tap Track Mute. 

 

 
Track Mute Mode. 

 
1. Press Play to play the sequence. 

2. Tap the Sequence field at the top of the touchscreen, and then use the Data Dial or –/+ buttons to 
select the desired sequence. Alternatively, double-tap the Sequence field, and then tap a sequence 
to select it. 

3. Each pad is assigned to a track. Mute a track by pressing the corresponding pad or tapping it on the 
touchscreen. The pad will be lit red. You can mute multiple tracks at the same time. 

4. To mute pads on another program, repeat Steps 3–4. 

Tip: To mute a track only at precise note intervals (“quantizing” your mutes, essentially), tap Time 
Division to set a musical timing value. Tap the desired musical value (e.g., 1 Bar). Alternatively, use the 
Data Dial or –/+ buttons. Tap Close to close the page. Now, when you press a pad in Track Mute Mode, 
the mute will occur precisely at the beginning of the following time division (in this example, 1 bar). This 
lets you test musical combinations of patterns—the preliminary stage to building a song structure. 

See Operation > Modes > Track Mute Mode to learn more about track mutes. 
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Sample Recording 
 

This section describes recording new samples of your own, which you can use in your projects.  

Important: To record any audio, you need to connect an audio source to your MPC Touch or to your 
computer’s audio interface. 

 

To open the Sampler, press Menu and then tap Sampler. 

 

 
Recording using the Sampler. 

 
1. Connect a microphone to the input(s) of your MPC Touch.  

2. Turn the Rec Gain knob to set the input level while speaking into the microphone. You should now 
see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be 
“peaking” constantly). 

3. To set the threshold, tap and drag Threshold slider. Alternatively, use the Data Dial or –/+ buttons. 
Set it to a fairly low level (e.g., -50 dB). 

4. Tap the Arm button to record-arm the Sampler.  

5. Sing or say something into the microphone. The sampler will start recording immediately when the input 
level reaches the threshold value. Alternatively, tap the round Record button to manually start recording. 

6. To stop recording, tap the round Stop button. The Keep or Discard Sample window will appear. 
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In the Keep or Discard Sample window: 

• To name the new sample, tap the Edit Name field and use the virtual keyboard to enter a name.  

• To assign the new sample to a program, tap the Program field, and then use the Data Dial or –/+ 
buttons to select the desired program. Alternatively, double-tap the Program field, and then tap a 
program to select it. 

• To assign the sample to a pad in the program, tap the Assign to Pad field, and then press the 
desired pad. Alternatively, use the Data Dial or –/+ buttons to select the desired pad number, or 
double-tap the Program field, and then tap a pad number. 

• To confirm your selections, tap the Keep button at the bottom of the touchscreen.  

• To discard the recording and return to the previous screen, tap the Discard button. 

• To play the recording, tap the Play button at the bottom of the touchscreen. 

 

 

Keeping or discarding the recorded sample. 

 
See Operation > Modes > Sampler to learn more about this feature. 
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Sample Editing 
 

You may need to edit your newly recorded samples using Sample Edit Mode. 

 

To enter Sample Edit Mode, press Menu and then tap Sample Edit. 

 

 
Using Trim Mode while in Sample Edit Mode. 

 
In Sample Edit Mode: 

• To switch between Trim Mode and Chop Mode, tap the Trim/Chop button at the bottom of the 
touchscreen. (In this example, use Trim Mode.) 

• To set the sample’s start point, press Q-Link to select the first bank: Q1, Q5, Q9, and Q13. Use the 
Q-Link Knobs to adjust the start point with varying degrees of resolution. Alternatively, tap and 
drag the S marker in the waveform. 

• To set the sample’s end point, press Q-Link to select the second bank: Q2, Q6, Q10, and Q14. 
Use the Q-Link Knobs to adjust the end point with varying degrees of resolution. Alternatively, tap 
and drag the E marker in the waveform. 

• To hear your edits, press Pad 10 to play the sample from the start point to the end point. 
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Let’s apply some processing to the sample. 

 

To open the Process Sample window, tap the Process button at the bottom of the touchscreen. 
 

 

The Process Sample window in Sample Edit Mode. 
 

1. To select the desired process in the Function field, use the Data Dial or –/+ buttons. Alternatively, 
tap the Function button or double-tap the Function field, and then tap the desired process. Let’s 
select Pitch Shift to change the overall pitch of your sample. This will transpose the sample without 
affecting its length. 

2. Tap the knob in the center of the window up or down. Alternatively, use the Data Dial or –/+ buttons. 
To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap 
anywhere else to return to the previous screen. 

3. To confirm your selections, tap Do It. 

To cancel the process, tap Cancel. 

 

See Operation > Modes > Sample Edit Mode to learn more. 
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Recording Automation with the XY Pad 
 

Automating various parameters is a good way to add some motion and dynamism to your sequences.  

1. Press Menu to open the menu, and then tap XYFX to enter XYFX Mode. 

2. When you first enter this mode in a project, you will be prompted to “load” XYFX to the program. Tap 
Insert XYFX to do this. 

3. Tap Setup to show the Setup panel, which controls how the XY pad behaves. 

4. Double-tap the Preset field, and tap an effect to select it. (These are just the effects available in 
XYFX Mode, not all MPC effects.) Swipe up or down to view the entire list. 

5. Tap and drag any of the knobs (Attack, Release, or Wet/Dry) up or down to set their values as 
desired. Below them, you can see parameter what the X axis and Y axis control. 

Note: XYFX uses an envelope to control how quickly the effect crossfades between the dry signal 
and wet signal. The Attack knob determines how long it takes the completely dry signal to reach the 
wet signal (determined by the Wet/Dry knob) after you touch the XY pad. The Release knob 
determines how long it takes the wet signal (determined by the Wet/Dry knob) to return to the 
completely dry signal after you touch the XY pad. 

6. Tap the automation button in the upper-right corner to cycle through the available automation 
modes. Make sure it shows the red Write (W) option. 

 
XYFX Mode. 
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7. Press Play Start to start recording. 

8. As you record, move your finger over the XY pad on the touchscreen. The changes in the sound are 
being recorded as automation of both the X axis and Y axis parameters. 

9. When you are done recording, press Stop. 

10. Tap the automation button in the upper-right corner to select the green Read (R) option. This 
ensures your track uses the automation you just recorded when you play it back. 

 

See Operation > Modes > XYFX Mode to learn more about using this feature. 

 

 

Using MPC as a Plugin 
 

If you are using another digital audio workstation (DAW), you can use the MPC software as an 
instrument plugin (VST, AU, RTAS, or AAX format) within your DAW, which will act as the host software. 
The MPC plugin offers the same features and functionality as the standalone software version but with 
some notable differences, which are discussed in the Operation > General Features > Differences 
Between Plugin and Standalone Usage chapter. 

Note: To learn how to load and use an instrument plugin in a host application, please refer to the 
corresponding chapter of your host application’s manual. 
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Operation 
 

This chapter explains the complete features and functions of your MPC Touch with the MPC software.  

Important: 

• When using the MPC software as a plugin, its features and functions are very similar to how it is 
described in this chapter but with some notable differences, discussed in the Operation > General 
Features > Differences Between Plugin and Standalone Usage chapter. 

• The MPC Touch display/touchscreen reflects what it is controlling in the software, but due to space 
and character limitations, the hardware’s display and your computer’s display may show different 
things (e.g., parameter names may be abbreviated, the layout may be different or spread across 
multiple tabs, etc.). 

• When accessing the secondary functions of buttons on your MPC Touch, you can do this one of two 
ways: (1) pressing and holding Shift and then pressing the desired button or (2) double-pressing the 
desired button. This manual describes these operations using only the first option, but both are 
acceptable. 

• Almost every mode shown in the touchscreen has 1–6 buttons at the bottom edge. Each of these 
buttons select a different tab in that mode or perform a specific function in that mode. 

• When the left-most button at the bottom of the touchscreen shows an upward arrow 
(), it means there are additional buttons you can use when you press and hold Shift. 
Press and hold Shift to show the secondary buttons, and any of them, if desired. 
Release Shift to return to the previous buttons. 

• When a parameter is highlighted and has a red outline, this means that it is selected. 
You can then change it by turning the hardware’s Data Dial or using the –/+ buttons. If 
the parameter is a number, try double-tapping it to show a numeric keypad in the 
touchscreen, and use that to enter a specific value. 

• When the touchscreen shows a group of four parameters with an orange outline and 
a Q in the upper-left corner, this means that the current bank of Q-Link Knobs will 
control those parameters or settings. Turn a Q-Link Knob to adjust its corresponding 
parameter value or setting in that group. You can also press the Q-Link button to 
select another group of four parameters.  
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General Features 
 
Control Types 
 

The MPC Touch uses the following types of control elements: 

 

Knobs 

To set the value for a knob, do any of the following : 

• Tap and drag the knob up or down. 

• Tap the knob to select it, and then use the Data Dial or –/+ 
buttons to adjust the value. 

• Double-tap the knob, and then tap and drag the larger version 
that appears, or use the Data Dial or –/+ buttons to adjust the 
value. Tap anywhere else to return to the previous screen. 

 

Parameter Values 

To set the value for a parameter, do either of 
the following: 

• Tap the field to select it, and then use the 
Data Dial or –/+ buttons to adjust the value. 

• Double-tap the field or hold your finger on it for a second. In the window that appears, use the 
numeric keypad, the Data Dial, or the –/+ buttons to adjust the value. Alternatively, tap and drag 
the value up or down. 

You can also tap /2 to halve the value or x2 to double it. 

To confirm the value and return to the previous screen, tap Do It. 

To return to the previous screen without changing anything, tap the grey area in the upper-left 
corner of the touchscreen.  
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Drop-Down Menus / Lists 
To select an option for a drop-down menu, do any of the following: 

• Tap the field to select it, and then use the Data Dial or –/+ buttons to select an option. 

• Double-tap the field. In the list that appears (examples below), tap the desired option. Alternatively, 
use the Data Dial or the –/+ buttons to select an option. 

In some windows, tap the relevant button at the bottom of the touchscreen to confirm your 
selection or to cancel without changing anything. 
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Selectors 

Selectors show all available options. One of them is always selected. 
The selected option is highlighted while the others are dark. 

To select an option, tap it. 

 

 

 

 

Buttons 

Buttons usually have two states: selected and deselected (active or inactive, 
respectively). 

To select or deselect a button, do either of the following: 

• Tap it. 

• If it is outlined in red (and is not a mute button), use the Data Dial or –/+ 
buttons to switch it to its opposite state. 
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Tabs 

Some modes have buttons at the bottom edge of the touchscreen that let you cycle 
through several similar tabs. For instance, you could view the send level that is routed 

to each of 4 returns—each level is shown on a separate tab. With each tap, you will 
move to the next tab, indicated by the squares below it. 

  
To select a tab, tap it. Each time you tap it, it will select the next tab. 

 
Sliders 

To adjust the position of a slider, do any of the following: 

• Tap and drag the slider to the desired position. 

• Tap the desired position (this works only on some sliders). 

• Tap the slider to select it, and then use the Data Dial or –/+ buttons to adjust the position (this 
works only on some sliders). 

• Double-tap the slider, and then tap and drag the larger version that appears, or use the Data Dial 
or –/+ buttons to adjust the value. Tap anywhere else to return to the previous screen. 
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Envelopes 

To set the stages of an envelope, do either of the following: 

Tip: Tap the rectangular icon above the envelope to show a closeup view. 

• Tap and drag a “handle” of an envelope stage in the desired direction. 

• Set the numeric value of an envelope stage by adjusting or entering it as a parameter value 
(described earlier). 

 
The Filter Envelope tab in Program Edit Mode. 

 

  
 Closeup of an AD-type filter envelope.  Closeup of an AHDS-type amp envelope. 
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Grid View Tools 

In Grid View, these four icons enable you to use different functions 
in the grid. Tap one to select its mode: 

 

Pencil: Draw Mode: 

• To enter a note in an empty grid square, tap the square. 

• To select a note, tap it. 

• To move a note, tap and drag it to another grid square. 

• To erase a note, double-tap it. 

 

Eraser: Erase Mode: 

• To erase a note, tap it. 

 

Select Box: Select Mode: 

• To select a note, tap it.  

• To select multiple notes, tap and drag across the grid to create a box around them. 

• To move a note, tap and drag it to another grid square. 

• To move multiple notes, select them as described above, and tap and drag them. 

 

Magnifying Glass: Navigation Mode: 

• To move to another part of the grid, tap and drag it. 

• To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this 
vertically, horizontally, or both at the same time. 
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Programs 
 

About Programs 

 

A program is a file that contains (1) a list of all samples used and (2) the settings for 
each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.) 
Program Edit Mode lets you edit and assign samples. A single project can hold up 
to 128 programs. 

There are two kinds of programs that use samples as their sound source: drum 
programs (used mostly for creating drum parts and quickly and easily assigning 
samples to pads) and keygroup programs (in which you can assign one or more 
samples to one or more keys and play them chromatically with a MIDI keyboard or 
the MPC hardware pads). 

Two other kinds of programs use MIDI data only: plugin programs and MIDI 
programs. This section covers how to create each program type. To learn about 
editing your programs to your preference, see the Modes > Program Edit Mode 
chapter. 
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Drum Programs 

 

To create a drum program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the four-squares icon, which 
indicates a drum program. 

3. If the project does not contain a drum program yet, a new 
drum program will automatically be added to the project 
and appear in the Program field below. 

If the project already contains a drum program, it will be 
selected automatically and appear in the Program field 
below. To create another drum program, tap the + icon 
above the Program field. A new drum program will be 
created and given a number (e.g., Program 002). 

4. To name your program, tap the cursor icon on the right 
edge of the Program section. Use the virtual keyboard that 
appears to enter a new name, and then tap Do It. 
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To load a sample into a drum program: 

1. Tap Shift+Menu/Browse to show the Browser. Find and select a sample, and then tap Load to load 
it to the program. (See Modes > Browser to learn more about using the Browser specifically.) 

2. Tap Samples at the bottom of the touchscreen. This lets you view the pads and project’s sample pool. 

3. Tap a pad to select it. The pad will be lit green. 

4. In the Sample Pool list, double-tap a sample to assign it to the pad. Alternatively, use the Data Dial 
or –/+ buttons to assign a sample and/or change the assigned sample. 

To clear the assigned sample from a selected pad, press the Data Dial. 

To assign samples to additional pads, repeat Steps 3–4. 

  

                            Viewing files in the Browser.                                            The Samples tab in the Browser. 

 

Tip: Remember that a drum program has 128 pads total—16 pads across 8 banks. 
 



                 

 
63 

 

 

Alternatively, load samples into a drum program this way: 

1. Press Menu and then tap Program Edit to enter Program Edit Mode. 

2. Tap Samples at the bottom of the touchscreen. This lets you view the samples assigned to all four 
layers of the current pad as well as tuning and level parameters for each layer. 

3. Tap a pad to select it. The pad will be lit green. 

4. Tap the field for a layer, and then use the Data Dial or –/+ buttons to select a sample. Alternatively, 
double-tap the field for a layer, and then tap a sample to select it. 

Tip: Press Q-Link to select the first bank, and then use the Q-Link Knobs to quickly select a sample 
for each layer of the selected pad. 

Tip: Remember that a drum program has 128 pads total—16 pads across 8 banks. 

 

 

The Samples tab in Program Edit Mode. 
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Keygroup Programs 

 

To create a keygroup program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the piano-keys icon, which 
indicates a keygroup program. 

3. If the project does not contain a keygroup program yet, a 
new keygroup program will automatically be added to the 
project and appear in the Program field below. 

If the project already contains a keygroup program, it will 
be selected automatically and appear in the Program field 
below. To create another keygroup program, tap the + 
icon above the Program field. A new keygroup program 
will be created and given a number (e.g., Program 002). 

4. To name your program, tap the cursor icon on the right 
edge of the Program section. Use the virtual keyboard 
that appears to enter a new name, and then tap Do It. 
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To load a sample into a keygroup program: 

1. In the software window, if the Browser panel is not visible on the left side, click the triangle () in the 
lower-left corner to show it. 

2. In the Browser, find and select a sample, and then double-click it to add it to the project. Keep in 
mind that the sample isn’t assigned to a pad yet. 

3. Click the Program Edit icon in the upper-left corner of the window to enter Program Edit Mode. 
Alternatively, press Ctrl+2 (Windows) or +2 (Mac OS X) on your computer. 

4. In the Layer section, click the Layer 1 drop-down menu and 
select the sample you loaded earlier. This sample is now 
playable across all pads. 

Tip: On your MPC Touch, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. 
You should hear the bass sample played back with its original pitch. You can use the other pads to 
play your sample chromatically.  

 

To create complex keygroup programs, you can add more keygroups (up to 128). This is useful when 
working with multi-samples (e.g., when programming a real piano). 

Tip: Remember that a keygroup program offers up to 128 keygroups, and each keygroup can hold up to 
four samples (Layers 1–4). This is a total of 512 samples. 
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Plugin Programs 

 

A plugin program lets you send your 
track’s MIDI data to a loaded plugin. This 
lets you set multiple tracks to use the 
same plugin instead of loading an instance 
of a plugin on every track (which can be 
cumbersome and CPU-intensive).  

 

 

To create a plugin program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the plug icon, which indicates a plugin program. 

3. If the project does not contain a plugin program yet, a new plugin program will automatically be 
added to the project and appear in the Program field below. 

If the project already contains a plugin program, it will be selected automatically and appear in the 
Program field below. To create another plugin program, tap the + icon above the Program field. A 
new plugin program will be created and given a number (e.g., Program 002). 

4. Double-tap the Plugin field. In the list that appears, tap the desired plugin. Alternatively, use the 
Data Dial or the –/+ buttons to select a plugin. 

You can tap the Type or Manufacturer button at the bottom of the touchscreen to enable or disable 
sorting of your plugins by type or maker. 

Tap Select to select the plugin, or tap Close to cancel. 

Note: You have to specify the disk directory where your plugins are located. This can be done in the 
software’s Preferences (in the Edit Menu). See the User Guide in the MPC software to learn more: 
click the Help menu and select MPC Help. 
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5. To select the MIDI channel the program will use, double-tap the MIDI Ch field. In the list that appears, 
tap the desired channel. Alternatively, use the Data Dial or the –/+ buttons to select a channel. Use 
this setting when you are working with a virtual instrument plugin that supports multi-mode. 

6. To select a preset in your plugin (if any), double-tap the Preset field. In the list that appears, tap the 
desired preset. Alternatively, use the Data Dial or the –/+ buttons to select a preset. 

7. To name your program, tap the cursor icon on the right edge of the Program section. Use the virtual 
keyboard that appears to enter a new name, and then tap Do It. 

 

By default, the volume and pan values will initially appear in the software window as ?, 
indicating the program is not sending any volume or pan changes. These values will 
appear as normal in the touchscreen, though (in Channel Mixer Mode). 

 

To adjust the volume and panning of a track using the plugin program: 

1. Press Menu and then tap Channel Mixer to enter Channel Mixer Mode. 

2. Double-tap the Mixer field in the upper-left corner, and then tap Tracks. 

3. Tap the square that represents the track with the plugin program to select it. 

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this 
once, you can adjust the volume and panning of the plugin program normally. 

Important: 

If you copy a sequence, the volume and pan values will be copied with that sequence. If 
you move to a new sequence and put the same plugin program on a new track, though, 
these values will appear in the software window as ?, as described above. 

By default, some plugins do not support MIDI volume and pan. In this case, adjust volume 
levels and panning on the track. 
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MIDI Programs 

 

A MIDI program lets you send your track’s 
MIDI data to an external MIDI device like a 
synth or drum machine.  

 
 
 
 
 
 
 
To create a MIDI program: 

1. Press Main to enter Main Mode. 

2. Next to the Track field, tap the bars icon, which indicates a MIDI program. 

3. If the project does not contain a MIDI program yet, a new MIDI program will automatically be added 
to the project and appear in the Program field below. 

If the project already contains a MIDI program, it will be selected automatically and appear in the 
Program field below. To create another MIDI program, tap the + icon above the Program field. A 
new MIDI program will be created and given a number (e.g., Midi 002). 

4. There are 5 additional settings to configure for a MIDI program: the MIDI Port, program change 
message (Prog Ch), MIDI channel (MIDI Ch), Bank MSB (Most Significant Byte), and Bank LSB 
(Least Significant Byte). See Modes > Main Mode > MIDI Programs to learn more. 

For each one, double-tap its field. In the list that appears, tap the desired option. Alternatively, use 
the Data Dial or the –/+ buttons to select an option. 

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). 
See the User Guide in the MPC software to learn more: click the Help menu and select MPC Help. 

5. To name your program, tap the cursor icon on the right edge of the Program section. Use the virtual 
keyboard that appears to enter a new name, and then tap Do It. 
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By default, the volume and pan values will initially appear in the software window as ?, 
indicating the program is not sending any volume or pan changes. These values will 
appear as normal in the touchscreen, though (in Channel Mixer Mode). 

 

To adjust the volume and panning of a track using the MIDI program: 

1. Press Menu and then tap Channel Mixer to enter Channel Mixer Mode. 

2. Double-tap the Mixer field in the upper-left corner, and then tap Tracks. 

3. Tap the square that represents the track with the MIDI program to select it. 

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this 
once, you can adjust the volume and panning of the MIDI program normally. 

Important: If you copy a sequence, the volume and pan values will be copied with that 
sequence. If you move to a new sequence and put the same MIDI program on a new 
track, though, these values will appear in the software window as ?, as described above. 
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Menu 
 

The Menu lets you select any of the 20 modes on MPC Touch that control the MPC software.  

 

To open the Menu, press Menu, or tap the icon in the upper-left corner of the touchscreen while on the 
normal page of your current mode. 

When viewing the Menu, do any of the following: 

• To enter a mode, tap it. 

• To return to the previous mode, tap the gray area in the upper-left corner, or press Menu again.   

 

 
The Menu. 

 

Each mode shown above is described in the following Modes chapter. Click a button above to skip 
directly to that chapter. 
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16 Level 
 

Press the 16 Level button on your MPC Touch to activate or deactivate 16 Level. 

 

 

 

When activated, the last pad that was pressed will be temporarily copied to all 16 pads. The pads will 
now output the same note number as the initial pad, but a selectable parameter will be fixed at values 
that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), 
regardless of how hard you press them. 

 

In the 16 Levels window that appears, use the Type selector to choose the parameter: Velocity, Tune, 
Filter, Layer, Attack, or Decay.  

 

To select the pad, do any of the following: 

• Press it. 

• Tap the Pad field, and use the Data Dial or –/+ buttons. 

• Double-tap the Pad field, and tap the desired pad in the list that appears. 
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Effects 
 

The MPC software offers various effects that you can apply to the pads, keygroups, programs, 
submixes, and master outputs, using insert and send/return effects. This chapter can help you get a 
good overall understanding of how the effects work. 

 

See Appendix > Effects and Parameters for a list of all available effects (with a brief description of 
each) and their editable parameters. 

 

 

Overview 
 

In a program, each pad or keygroup can have up to 4 insert effects applied to it. See Insert Effects > 
Pads or Insert Effects > Keygroups to learn more about this. 

 

An entire program can also have up to 4 insert effects applied to it, as well. See Insert Effects > 
Programs to learn more about this. 

 

Additionally, pads, keygroups, programs, and submixes can each be sent to up to 4 send channels. 
Their audio will be routed through effects on the send channels, and the processed audio will be 
returned to their original channel. See Send/Return Effects to learn more about this. 

 

For even further flexibility, each of the 8 submixes can have up to 4 insert effects applied to it. You can 
route pads/keygroups and programs to a submix, which is then routed to a master output. See Insert 
Effects > Submixes to learn more about this. 

 

Finally, you can apply up to 4 insert effects to each master output (a stereo pair of channels: Outputs 
1/2, Outputs 3/4, etc.). See Insert Effects > Masters to learn more about this. 
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There are three other parts of the software that handle effects differently: 

• The Sampler can use up to 4 insert effects, which are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. Learn more about the Sampler in 
the Modes > Sampler chapter. 

• Similarly, the Looper can use up to 4 insert effects, which are applied to the audio as you record 
it. This means that the effects cannot be “removed” from the sound later. Learn more about the 
Looper in the Modes > Looper chapter. 

• In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name 
of the insert effect you have to load to the program before you can use this mode. Learn more 
about XYFX Mode in the Modes > XYFX Mode chapter. 

 
 

To view, load, edit, or clear effects, tap the pencil icon in the upper-right corner 
of the Inserts field. This usually appears in a channel strip (next to a level slider 
and pan knob). 
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When viewing loaded effects, you will see this window: 

 

 

 

In this window: 

• To select an effect, use the field for each insert slot. A window (described below) will appear. 

• To edit the parameters of a loaded effect, tap the pencil icon next to the insert slot. 

• To clear the insert slot, tap the trash can icon next to it. 

• To enable or disable an effect slot, tap the On/Off button next to it. 

• To enable or disable all 4 effect slots, tap the All On/All Off button in the upper-right corner. 
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When selecting an effect, you will see this window: 

 

 

 

In this window: 

• To move through the list, swipe up or down. Alternatively, use the Data Dial or –/+ buttons.  

• To sort or unsort the effects by type or manufacturer, tap Type or Manufacturer in the lower-
left corner. 

• To load an effect, double-tap it. Alternatively, tap Select, or press the Data Dial. 

• To cancel, tap Close or anywhere outside of the list. 
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When you edit an effect, you will see this window: 

 

 
 
In this window: 

• To adjust a parameter, tap and drag its slider. Alternatively, use the Data Dial or –/+ buttons. To 
make finer adjustments, double-tap the pad and adjust the larger version of the slider that appears. 

Tip: Turn the Q-Link Knobs to quickly adjust the corresponding 4 parameters. Use the Q-Link 
button to select another set of 4 parameters the Q-Link Knobs control. 

• To select another page of parameters, tap the Parameters –/+ buttons at the top of the 
touchscreen. 

• To enable or disable the effect, tap the On/Off button in the upper-right corner. 

• To edit parameters for another insert effect on the same pad, program, etc., tap a different 
Insert tab at the bottom edge of the touchscreen to select it. 

• To close the window, tap Close or the upper part of the touchscreen. 
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Insert Effects 
 

Pads 

You can load up to 4 insert effects to each pad. You can do this in Main Mode, the Pad Mixer, or 
Program Edit Mode. 

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you 
could apply unique combinations of effects to each pad within a program. If you want to apply the same 
effect to all pads, do this with a program insert effect (see Insert Effects > Programs). 

 

To load a pad insert effect in Main Mode: 

1. Use the Track field to select the track that uses the program with the desired pad—the program it 
uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small triangle () icon below the Project field to show it. 

3. Tap the first (pad) icon at the top of the channel strip. The channel strip will now show settings for 
the current pad.  

4. Press the desired pad to select it. Alternatively, use the Pad field at the top of the program channel strip. 

5. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 

 

To load a pad insert effect in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to select the desired program. Alternatively, use 
the Track field at the top of the touchscreen to select the desired track—the program it uses will be 
selected automatically.  

2. Press the desired pad to select it, or tap it in the touchscreen. Alternatively, double-tap the Pad field 
below the Program field. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, tap the Insert tab at the bottom of the touchscreen (tap it multiple times to select a 
different insert slot), and then double-tap the desired pad in the touchscreen. You could also use the 
Data Dial or –/+ buttons to select an effect immediately. 
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To load a keygroup insert effect in Program Edit Mode: 

1. While using the desired program, press the desired pad to select it. 

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects. 

 

 

Keygroups 

You can load up to 4 insert effects to each keygroup. You can do this in Main Mode, the Pad Mixer, or 
Program Edit Mode in the software. 

Important: When using keygroup insert effects, they will be applied to the entire keygroup program. This 
is because a keygroup program uses the same sound across all pads, as opposed to drum programs 
where each pad can have its own insert effect. You can still load up to four insert effects per keygroup, 
but all of them will affect the entire program. 

 

To load a keygroup insert effect in Main Mode: 

1. Use the Track field to select the track that uses the program with the desired pad—the program it 
uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small triangle () icon below the Project field to show it. 

3. Tap the first (pad) icon at the top of the channel strip. The channel strip will now show settings for 
the current keygroup. 

4. Press a pad to select its corresponding keygroup, or tap it in the touchscreen. Alternatively, use the 
Keygroup field below the Program field. 

Important: Remember that regardless of the keygroup, the effect will be applied to the entire 
keygroup program. You can still load up to four insert effects per keygroup, but all of them will affect 
the entire program. 

5. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
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To load a keygroup insert effect in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to select the desired program. Alternatively, use 
the Track field at the top of the touchscreen to select the desired track—the program it uses will be 
selected automatically. 

2. Press a pad to select its corresponding keygroup, or tap it in the touchscreen. Alternatively, double-
tap the Keygroup field below the Program field. 

Important: Remember that regardless of the keygroup, the effect will be applied to the entire 
keygroup program. You can still load up to four insert effects per keygroup, but all of them will affect 
the entire program. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, double-tap the desired pad in the touchscreen. You could also select one of the four 
Insert tabs at the bottom of the touchscreen, and then use the Data Dial or –/+ buttons to select an 
effect immediately. 

 

To load a keygroup insert effect in Program Edit Mode: 

1. In the software window, click the Program Edit tab at the top of the screen. Alternatively, press 
Ctrl+2 (Windows) or +2 (Mac OS X) on your computer keyboard.  

2. In the Keygroup section in the lower-left corner of the window, use the KG Select menu to select the 
desired keygroup. 

Important: Remember that regardless of the keygroup, the effect will be applied to the entire 
keygroup program. You can still load up to four insert effects per keygroup, but all of them will affect 
the entire program. 

3. If the button above the Keygroup Inserts slots is set to Off, click it 
so it changes to On. 

4. Click the downward arrow () of one of the insert slots, and then 
use the window that appears to load effects. 

To edit an effect’s parameters, double-click its name in the insert 
slot, and then use the window that appears to edit it.  
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Programs 

You can load up to 4 insert effects to each program. You can do this in Main Mode, XYFX Mode, 
Program Edit Mode, and the Channel Mixer.  

Note: In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name 
of the insert effect that is loaded when use this mode. 

 

To load a program insert effect in Main Mode: 

1. Use the Track field to select the track that uses the program with the desired pad—the program it 
uses will be selected automatically. 

2. If the channel strip is not already shown, tap the small triangle () icon below the Project field to 
show it. 

3. Tap the second (four-squares) icon at the top of the channel strip. The channel strip will now show 
settings for the current program. 

4. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 

 

To load XYFX for a program in XYFX Mode: 

1. Select the desired program in another mode, and then enter XYFX Mode. 

2. If you have not yet used XYFX Mode for this program, tap Insert XYFX on the touchscreen to load it 
and show the XY pad. 

Note: If you already have 4 insert effects loaded, you will need to clear one of the insert effect slots 
before doing this.  

If you have already used XYFX Mode for this program, the XY pad will appear. 

3. If the Setup panel is not shown, tap Setup in the lower-right corner to show it.  

4. Use the Preset field to load an effect. Use the controls below the Preset field to edit the effect. 
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To load an insert effect in Program Edit Mode: 

1. In the software window, click the Program Edit tab at the top of the 
screen. Alternatively, press Ctrl+2 (Windows) or +2 (Mac OS X) on 
your computer keyboard.  

2. If the button above the Program Inserts slots is set to Off, click it so 
it changes to On. 

3. Click the downward arrow () of one of the insert slots, and then use 
the window that appears to load effects. 

To edit an effect’s parameters, double-click its name in the insert slot, 
and then use the window that appears to edit it.  

Important:  

For drum programs, if the Pad Audio Route menu is set to anything other than Program, then the 
effect will not be applied to that pad. 

For keygroup programs, if the Keygroup Audio Route menu is set to anything other than Program, 
then the effect will not be applied to that entire keygroup program. 

 

To load a program insert effect in the Channel Mixer: 

1. Set the Mixer field in the upper-left corner to Programs. 

2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap 
the Program field below the Mixer field. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, tap the Insert tab at the bottom of the touchscreen (tap it multiple times to select a 
different insert slot), and then double-tap the desired pad in the touchscreen. You could also use the 
Data Dial or –/+ buttons to select an effect immediately. 
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Submixes 

You can load up to 4 insert effects to each submix. You can do this in the Channel Mixer only. 

 
To load a submix insert effect: 

1. Set the Mixer field in the upper-left corner to Submixes. 

2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap 
the Submix field below the Mixer field. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, tap the Insert tab at the bottom of the touchscreen (tap it multiple times to select a 
different insert slot), and then double-tap the desired pad in the touchscreen. You could also use the 
Data Dial or –/+ buttons to select an effect immediately. 

 
 
 
Masters 

You can load up to 4 insert effects to each master output (a stereo pair of channels: Outputs 1/2, 
Outputs 3/4, etc.). You can do this in Main Mode or the Channel Mixer. 

 
To load a master insert effect in Main Mode: 

1. If the channel strip is not already shown, tap the small triangle () icon below the Project field to 
show it. 

2. Tap the fourth (crown) icon at the top of the channel strip. The channel strip will now show settings 
for the current master output. 

3. Use the Outputs field at the top of the channel strip to select the desired master output (Outputs 
1/2, Outputs 3/4, etc.).  

4. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
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To load a master insert effect in the Channel Mixer: 

1. Set the Mixer field in the upper-left corner to Masters. 

2. In the touchscreen, tap the pad that corresponds to the desired master output (Outputs 1/2, 
Outputs 3/4, etc.). Alternatively, double-tap the Outputs field below the Mixer field. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, tap the Insert tab at the bottom of the touchscreen (tap it multiple times to select a 
different insert slot), and then double-tap the desired pad in the touchscreen. You could also use the 
Data Dial or –/+ buttons to select an effect immediately. 
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Send/Return Effects 
 

Send/return effects work in the following way: 

1. A pad, keygroup, program, or submix sends its audio to up to 4 returns at its designated send level. 

2. That audio is processed by the effect(s) on the return. Each return can have up to 4 effects loaded. 

3. The processed audio is sent back to its pad, keygroup, program, or submix at a designated return level. 

 

You can load send/return effects and set return levels only in the Channel Mixer, described below. The 
rest of this section describes the different ways to set the desired send levels for pads, keygroups, 
programs, or submixes. 

 

To load a send/return effect to a return: 

1. In the Channel Mixer, set the Mixer field in the upper-left corner to Returns. 

2. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the 
Return field below the Mixer field. 

3. Tap the pencil icon next to Inserts, and then use the window that appears to load or edit effects. 
Alternatively, tap the Insert tab at the bottom of the touchscreen (tap it multiple times to select a 
different insert slot), and then double-tap the desired pad in the touchscreen. You could also use the 
Data Dial or –/+ buttons to select an effect immediately. 

 

To set the return level: 

1. In the Channel Mixer, set the Mixer field in the upper-left corner to Returns. 

2. Tap the Level tab in the lower-left corner. 

3. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the 
Return field below the Mixer field. 

4. Use the Data Dial or –/+ buttons to adjust the level of the currently selected return. Alternatively, use 
the Level slider in the channel strip, or turn the corresponding Q-Link Knob. To make finer 
adjustments, double-tap the pad and adjust the larger version of the slider that appears. 
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Pads 

You can set the send levels for pads in Program Edit Mode or the Pad Mixer. 

 

To set the send levels for a pad in Program Edit Mode: 

1. While editing the desired program in Program Edit Mode, press the desired pad to select it. 

2. Tap the Effects tab in the lower-right corner. 

3. Use the Send knobs to set the send level for each return.  

 

To set the send levels for a pad in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to select the desired program. Alternatively, use 
the Track field at the top of the touchscreen to select the desired track—the program it uses will be 
selected automatically. 

2. Tap the Send tab at the bottom of the touchscreen (tap it multiple times to select a different send 
level). 

3. Press the desired pad to select it, or tap it in the touchscreen. Alternatively, double-tap the Pad field 
below the Program field. 

4. Use the Data Dial or –/+ buttons to set the send level. To make finer adjustments, double-tap the 
pad and adjust the larger version of the slider that appears.  
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Keygroups 

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer. 

 

To set the send levels for a keygroup in Program Edit Mode: 

1. In the software window, click the Program Edit tab at the top of the screen. 
Alternatively, press Ctrl+2 (Windows) or +2 (Mac OS X) on your computer keyboard.  

2. If the Send button above the desired keygroup’s channel strip is not already selected, 
click it. 

3. Click and drag the knob that corresponds to each return up or down. 

 

 

 

 

To set the send levels for a keygroup in the Pad Mixer: 

1. Use the Program field at the top of the touchscreen to select the desired program. Alternatively, use 
the Track field at the top of the touchscreen to select the desired track—the program it uses will be 
selected automatically. 

2. Tap the Send tab at the bottom of the touchscreen (tap it multiple times to select a different send 
level). 

3. Press the desired pad to select its corresponding keygroup, or tap it in the touchscreen. 
Alternatively, double-tap the Keygroup field below the Program field. 

4. Use the Data Dial or –/+ buttons to set the send level. To make finer adjustments, double-tap the 
pad and adjust the larger version of the slider that appears.  
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Programs 

You can set the send levels for programs in the Channel Mixer only. 

 

To set the send levels for a program: 

1. In the Channel Mixer, set the Mixer field in the upper-left corner to Programs. 

2. Tap the Send tab at the bottom of the touchscreen (tap it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap 
the Program field below the Mixer field. 

4. Use the Data Dial or –/+ buttons to set the send level. To make finer adjustments, double-tap the 
pad and adjust the larger version of the slider that appears. 

 

 

Submixes 

You can set the send levels for submxies in the Channel Mixer only. 

 

To set the send levels for a submix: 

1. In the Channel Mixer, set the Mixer field in the upper-left corner to Submixes. 

2. Tap the Send tab at the bottom of the touchscreen (tap it multiple times to select a different send level). 

3. In the touchscreen, tap the pad that corresponds to the desired submix. Alternatively, double-tap the 
Submix field below the Mixer field. 

4. Use the Data Dial or –/+ buttons to set the send level. To make finer adjustments, double-tap the 
pad and adjust the larger version of the slider that appears. 
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Differences Between Plugin and Standalone Usage 
 

When using the MPC software as a VST, AU, RTAS, or AAX plugin, its features and functions are very 
similar to its operation as your host software but with some notable differences discussed here. 

Important: This Operation chapter contains information about using the MPC software as a standalone 
software program. This section describes the differences. 

 

Note: To learn how to load and use an instrument plugin in a host application, please refer to the 
corresponding chapter of your host application’s manual. 

 

Saving: Make sure to save your work in the MPC software plugin as well as saving all of your work in 
your host application. For ease of use, we recommend saving your host application projects and their 
associated MPC projects in the same folder. 

Software Menus: The MPC plugin doesn’t offer a top menu like in the standalone application. 
The menu button is located to the left of the Main Mode tab. 

Audio Input and Output: Your audio input and output are set in your host application rather than in 
MPC. MPC’s Preferences will not have the Audio tab. 

MIDI Ports: All MIDI Out ports will be assigned to your digital audio workstation (DAW). In MPC’s 
Preferences, the MIDI tab will display DAW as the only available MIDI Out port assignment. 

DAW Projects Folder: In MPC’s Preferences, the Plugin tab will let you select a DAW Projects Folder 
location. 

Tempo and Sync: The MPC plugin is automatically synchronized to the tempo of your host application. 
MPC’s Preferences will not have the Sync tab, and the BPM in the Transport Section will be greyed out. 

Playback Controls: The Stop, Play, and Play Start buttons will be greyed out. You must start and stop 
playback using your host application’s playback controls. 

Playback Start and Stop: The start and stop commands are always synchronized to the host application. 
When the playback of the host application is started, the MPC plugin playback starts simultaneously. 
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Modes 
 

MPC Touch has a Menu page that lets you select any of the 20 modes on MPC Touch that control the 
MPC software. This chapter describes the various features and functions of each mode. 

 

 

The 20 modes as shown in the Menu. 

 

Click a button above to skip directly to that chapter. 
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Main Mode 

 

Main Mode gives you an overview of the most-used functions.  

 

 

To enter Main Mode, do one of the following:  

• Press Main. 

• Press Menu, and then tap Main. 

 

 

Main Mode. 
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The upper edge shows the project name and transport information. 

 

 
 

The Project field shows the name of the current project. 

To view the project information, tap the Project field. A list will appear of the available programs, 
sequences, and samples in the project. 

In the Project window, in additional to typical functions you can perform in lists, you can do any of the 
following: 

• To expand or collapse the list of programs or sequences, tap the arrow (∨ or >) to its left. 

• To immediately select a sample and enter Sample Edit Mode, double-tap it. 

• To save the project, tap Save. 

• To return to the previous screen, tap Close, the X in the upper-right corner, or anywhere outside 
the window. 

• To delete samples from the project, tap Purge. In the screen that appears, tap Unused Samples 
to delete all unused samples from the project, tap All Samples to delete all samples from the 
project, or tap Cancel to return to the previous screen. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

The In and Out boxes indicate the software is receiving or sending (respectively) MIDI messages from or 
to your computer. 
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you 
can easily jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

• To enter Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

There are also two small icons to the right of these that control the channel strip. 

To show or hide the channel strip, tap the triangle ( or ) icon. 

 

The channel strip contains some important settings for the current pad, program, track, or master 
output, depending on the currently selected icon: 

• To view the pad channel strip, tap the square icon. 

• To view the program channel strip, tap the four-squares icon. 

• To view the track channel strip, tap the bars icon. 

• To view the master strip, tap the crown icon. 
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When viewing the pad channel strip: 

• The first field shows the current pad number. Press a pad or tap 
the field to select a different pad. 

Tip: This is useful for mixing your pads without having to enter the 
Pad Mixer. 

• The second field shows where the pad is routed, which you can 
change. Usually, this is set to Program. 

• The Inserts field shows any enabled or disabled effects for that 
pad. Tap the pencil icon to open a window where you can change 
and enable or disable the effects. 

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To change the panning or level of the pad, adjust the pan knob or 
Level slider. 

 

When viewing the program channel strip: 

• The first field shows the current program number and name, which 
you can change. 

• The second field shows where the program is routed, which you 
can change. 

• The Inserts field shows any enabled or disabled effects for that 
program. Tap the pencil icon to open a window where you can 
change and enable or disable the effects. 

• To solo or mute the program, tap Solo or Mute (respectively). 
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• To change the program’s automation, tap the automation button to cycle through its three states:. 

When off, the program will ignore automation data. If you have already recorded 
or entered automation, tapping this will switch between Read (R) and Write (W) 
only, but you can override this and turn it off by pressing and holding Shift while 
tapping the button. 

Important: If you have already recorded automation and turn it off, the track will 
still use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record 
any additional automation over it. You can still manually edit and enter 
automation. (Think of this as a protective feature to prevent accidental changes to 
your automation while recording.) 

When set to Write (W), the program can record automation. (If you have any Q-
Link Knobs assigned to automatable parameters, make sure not to touch any 
accidentally while you are recording.) 

Tip: You can quickly set all programs to the same automation in XYFX Mode. See 
the XYFX Mode chapter to learn how to do this. 

• To change the panning or level of the program, adjust the pan knob or Level slider. 
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When viewing the track channel strip: 

• The first field shows the current track number, which you can 
change, and its name. 

• The second field shows the name of the program the track is 
using. 

• To solo or mute the track, tap Solo or Mute (respectively). 

• To change the panning of velocity of the track, adjust the pan 
knob or Velocity slider. 

Note: If the track is using a plugin program, then the slider will 
send CC #7 (Volume) and the knob will send CC #10 (Pan) to your 
instrument plugin. The plugin will then handle these messages as it 
normally would. 

 

 

When viewing the master strip: 

• The first field shows the current master output as a stereo pair, 
which you can change. 

• The Inserts field shows any enabled or disabled effects for that 
master output. Tap the pencil icon to open a window where you 
can change and enable or disable the effects. 

• To mute the master output, tap Mute. 

• To change the panning or level of the master output, adjust the 
pan knob or Level slider. 
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The Sequence section shows the current sequence and its information. 

 

 
 

Use Sequence field to select a sequence. 

To edit the name of the sequence, tap the cursor icon on the right edge of the section, and use the 
virtual keyboard that appears. 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo or a master 
tempo, tap the Sequence/Master button under the BPM field. 
Alternatively, press and hold Shift+Tap Tempo. 

 

Use the Bars field to adjust the length of the sequence in bars. 

 

The Loop button shows whether the sequence (or a part of it) will loop or not. 

To enable or disable looping, tap the button. 

To set the start point and end point of loop, tap the First or Last field (respectively) and then use the 
Data Dial or the –/+ buttons, or double-tap the field and use the numeric keyboard that appears. (Keep 
in mind that the Last Bar value depends on the total length of the sequence.) 

 

Use the Transpose field to set the transposition (in semitones) of the entire sequence.  
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To edit the sequence, tap the pencil icon on the right edge of the section. The Sequence Edit/Copy 
window will open. 

 

 

The Sequence Edit/Copy window. 

 

You can use any of these functions as described below. 

 

To return to Main Mode, tap Cancel or the left arrow () in the upper-left corner of the touchscreen. 
Alternatively, press Main. 

 

To edit the name of the sequence, tap the top edge of the touchscreen and use the virtual keyboard 
that appears. 
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Erase 

This function erases all or part of a track in a specific sequence. 

 

 
 

To select the sequence you want to erase, use the Sequence field. 

To select the track you want to erase within the sequence, use the Track field. 

To set the time range of the sequence you want to erase, use the Bar, Beat, and Tick fields. The left 
fields set the start of the time range, and the right fields set the end of the time range.  

To select what types of events you erase, select one of the Erase options: 

• All erases all pad events from the designated time range and reset all of its settings. 

• Automation erases only automation from the designated time range. 

• Note erases only specific pad events from the designated time range. In the diagram of the eight 
pad banks that appears, press each pad in each bank to select or deselect its notes. 

• Except Note erases everything except pad events from the designated time range.  

 

To confirm your choice, tap Do It.  

To return to the previous screen, tap Function or anywhere outside the Erase window. 

To cancel and return to Main Mode, tap Cancel. 
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Clear 

This function erases all events from the sequence and resets all of its settings. 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 

 

Transpose 

This function transposes a range of events on a track in a sequence. (The events within that range will 
shift accordingly in the Grid View.) 
 

 
 

To select the sequence you want to transpose, use the Sequence field. 

To select the track you want to transpose within the sequence, use the Track field. 

To set the time range of the sequence you want to transpose, use the Bar, Beat, and Tick fields. 
The left fields set the start of the time range, and the right fields set the end of the time range.  

For drum programs, select the source and destination pads. Tap the left and right fields (respectively) 
and press the desired pad. (The “source” pad is the pad whose events you want to move. The 
“destination” pad is the pad where the events will be placed.) 
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For keygroup programs, plugin programs, and MIDI 
programs, set the range and amount of transposition 
using the MPC software window: 

• Range: Click and drag these fields up or down to set 
the range of notes of the events you want to 
transpose. Events within this note range will be 
transposed while events outside of this range will 
remain unchanged. 

• Transpose: Click and drag this field up or down to 
set how many semitones up or down you want to 
transpose the events. 

 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere outside the Transpose window. 

To cancel and return to Main Mode, tap Cancel. 

 



                 

 
101 

 

 

Delete Bars 

This function removes a range of bars from a sequence. 

 

 

 

To select the sequence whose bars you want to delete, use the Sequence field. 

To set the range of bars you want to delete, use the First Bar and Last Bar fields. The bar in each 
field and all bars in between them will be deleted. 

 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere outside the Delete Bars window. 

To cancel and return to Main Mode, tap Cancel. 
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Insert Bars 

This function adds empty bars to a sequence at a specified 
point. 

 
To select the desired sequence, use the Sequence field. 

To set how many bars you will insert, use the # of Bars field. 

To set the time signature of the inserted bars, use the two 
Time Sig fields. 

To set where you will insert the bars, use the Before Bar 
field. The bars will be inserted before this one. 

 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the Insert Bars window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

Half Length 

This will immediately delete the second half of the sequence. 

 

 

Double Length 

This will immediately double the sequence and copy all events from the first half to the second half. 
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Copy Sequence 

This function copies the contents of one sequence to another. 

 

To select the source sequence, use the Copy Contents of 
Sequence field. The “source” sequence is the one whose events 
you want to copy. 

To select the destination sequence, use the Over Contents of 
Sequence field. The “destination” sequence is the one where the 
source sequence will be copied. 

 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the Insert Bars window. 

To cancel and return to Main Mode, tap Cancel. 

 

 

Copy Track 

This copies the contents of one track to another. 

 

To select the source track, tap the Copy Contents of Track field. 
The “source” track is the one whose events you want to copy. 

To select the destination track, tap the Over Contents of 
Track field. The “destination” track is the one where the source 
track will be copied. 

 

To confirm your choice, tap Do It. 

To return to the previous screen, tap Function or anywhere 
outside the Insert Bars window. 

To cancel and return to Main Mode, tap Cancel. 
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Copy Bars 

This copies a range of bars from a sequence and adds them 
to another at a specified point. 

 

To select the source sequence, use the From Sequence 
field. The “source” sequence is the one whose bars you 
want to copy. 

To set the range of bars to copy in the source sequence, 
use the First Bar and Last Bar fields. 

To select the destination sequence, use the To Sequence 
field. The “destination” sequence is the one where the source 
sequence bars will be copied. 

To set where you want to add the copied bars, use the 
After Bar field. The copied bars will be inserted after this one. 

To set how many instances of the copied bars you want 
to add, use the Copies field. 

 

To overwrite the destination sequence, tap Replace. 

To add the events to the destination sequence without 
erasing anything, tap Merge. 

To return to the previous screen, tap Function or anywhere 
outside the Copy Bars window. 

To cancel and return to Main Mode, tap Cancel. 
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Copy Events 

This function copies a range of events from a sequence and add them to another at a specified point. 

 

 
 

To select the source sequence, use the From Sequence field. The “source” sequence is the one 
whose events you want to copy. 

To select the source track, use the From Track field. The “source” track is the one whose events you 
want to copy. 

To set the time range of the events you want to copy, use the Bar, Beat, and Tick fields. The left 
fields set the start of the time range, and the right fields set the end of the time range.  

To select the destination sequence, use the To Sequence field. The “destination” sequence is the one 
where the source sequence events will be copied. 

To select the destination track, use the To Track field. The “destination” track is the one where the 
source track events will be copied. 

To set where you want to add the copied events, use the Bar, Beat, and Tick fields. The events will 
be added after this point. 

To set how many instances of the copied events you want to add, use the Copies field. 
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To overwrite the destination sequence, tap Replace. 

To add the events to the destination sequence without erasing anything, tap Merge. 

To return to the previous screen, tap Function or anywhere outside the Copy Events window. 

To cancel and return to Main Mode, tap Cancel. 
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The Track section shows the current track, program type, and its information. 

 

 

 

The Track field shows the track number and its name. 

To edit the name of the track, tap the cursor icon on the right edge of the section and use the virtual 
keyboard that appears. 

 

The program selector indicates which of the four types of programs the track is using. You can also 
change the program type: 

• To select a drum program, tap the four-squares icon. 

• To select a plugin program, tap the plug icon. 

• To select a MIDI program, tap the bars icon. 

• To select a keygroup program, tap the piano-keys icon.  

 

Use the Length field to set how long the track is. If you select the minimum value, Sequence or 0, the 
track will be however long your sequence it. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum 
sequence repeatedly under a 4-bar bass line. 
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Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set 
to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the 
track will play twice as loud. The maximum velocity level is still 127, though. 

 

Use the Transpose field to set the transposition (in semitones) of the entire track.  

 

To edit the track, tap the pencil icon on the right edge of the section. The Track Edit window will open. 
 

 

The Track Edit window. 
 

You can use any of these functions as described below. 

 

To return to Main Mode, tap Cancel or the left arrow () in the upper-left corner of the touchscreen. 
Alternatively, press Main. 

To edit the name of the track, tap the top edge of the touchscreen and use the virtual keyboard that 
appears. 
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Clear 

This function erases all events from the track and resets all of its settings. 

 

To confirm your choice, tap Clear. 

To return to the previous screen, tap Cancel. 

 

 

Explode 

This function immediately splits the current track into multiple tracks—one for each distinct pad or note 
(pitch, not event). The current track also remains present and intact, while each track created from it is 
labeled with the track name and pad name or number. 

 

 

Double-Speed Events 

This function immediately halves the lengths of all note events on the track as well as the distance 
between them. In other words, the track’s notes are pressed closer together so the track sounds like it is 
playing at twice the previous speed. This does not actually affect the pitches of notes or the tempo. 

 

 

Half-Speed Events 

This function immediately doubles the lengths of all note events on the track as well as the distance 
between them. In other words, the track’s notes are spread further apart so the track sounds like it is 
playing at half of the previous speed. This does not actually affect the pitches of notes or the tempo. 
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The Program section shows the current program. This section will appear differently depending on the 
type of program selected. 

 

 

Drum Programs and Keygroup Programs 

 

The Program field shows the name of the program. 
 

  
 

To edit the name of the program, tap the cursor icon on the right edge of the section. Use the virtual 
keyboard that appears to enter a new name, and then tap Do It. 

To create another drum or keygroup program, tap the + icon above the Program field. A new 
program of the same type will be created and given a number (e.g., Program 002). 
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Plugin Programs 

The Program field shows the name of the program. 

 

 

 

To edit the name of the program, tap the cursor icon on the right edge of the section and use the 
virtual keyboard that appears. 

To create another plugin program, tap the + icon above the Program field. A new plugin program will 
be created and given a number (e.g., Program 002). 

 

Use the Plugin field to select the plugin the program is using. In the window that appears, you can tap 
the Type or Manufacturer button at the bottom of the touchscreen to enable or disable sorting of your 
plugins by type or maker. 

Note: You have to specify the disk directory where your plugins are located. This can be done in the 
software’s Preferences (in the Edit Menu). See the User Guide in the MPC Software to learn more: click 
the Help menu and select MPC Help. 

 

Use the MIDI Ch field to select the MIDI channel the program uses. Use this setting when you are 
working with a virtual instrument plugin that supports multi-mode. 

 

Use the Preset field to select a preset (if any) within the plugin the program is using. 
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MIDI Programs 

The Program field shows the name of the program. 

 

 

 

To edit the name of the program, tap the cursor icon on the right edge of the section, and use the 
virtual keyboard that appears. 

To create another MIDI program, tap the + icon above the Program field. A new plugin program will 
be created and given a number (e.g., Midi 002). 

 

Use the MIDI Port field to select the port over which the program sends its MIDI data. 

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See 
the User Guide in the MPC Software to learn more: click the Help menu and select MPC Help. 

 

Use the Program Ch field to select the program change message the program sends out. 

 

Use the MIDI Ch field to select the MIDI channel over which the program sends its MIDI data. 

 

Use the Bank MSB and Bank LSB fields to select the messages for Most Significant Byte and Least 
Significant Byte (respectively) that the program sends out. 
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The Timing Correct window contains various settings to help quantize the note events in your sequence. 

 

To open the Timing Correct settings, press and hold Shift, and then tap TC at the bottom of the 
touchscreen. 

 

 

The Timing Correct window. 
 

To apply the settings you selected, tap Do It.  

To cancel and return to the previous screen, tap Close. 
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Use the Type selector to set how timing corrections are applied. 

• Start: The start points of note events will be extended or shortened to align with the closest time 
division marker in the grid. The start points will remain untouched. 

• End: The end points of note events will be extended or shortened to align with the closest time 
division marker in the grid. The start points will remain untouched. 

• Length: The end points of note events will be extended or shortened so that each event’s length is a 
multiple of the time division, regardless of where it is in the grid. The start points will remain untouched. 

• Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase 
from the first note event’s start point to the last note event’s end point. Each note event will sustain until 
another note event starts. If multiple note events start at the same time (and are not the last note 
events), their lengths will become identical. Selecting Legato disables all other options in this window. 

 

   
                            Without legato applied.                  With legato applied. 

 

Use the Time Division selector to set the quantization value. Note events will “snap” to these time 
divisions on the grid. The T indicates a triplet-based value.  

Alternatively, double-tap the down arrow () in the upper-left corner of the grid and select a time division. 
You can also press and hold Note Repeat and use the 6 buttons at the bottom edge of the touchscreen. 

 

Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—
from subtle to extreme. 
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Use the Shift Timing field to shift all note events by clock ticks.  

 

Use the Window field to set how many notes around a quantize value will be quantized. Any notes 
outside this range will not be quantized; notes inside will. 

 

Use the Strength field to set how strictly notes will be quantized (i.e., shifted toward the quantize value). 
Lower values move notes a little bit towards the closest quantize value, resulting in a less mechanical 
feel than a strict quantization (a higher value). 

 

Use the Events selector to set the target range for the time correction. You can apply the time correction 
to All note events or to just the Selected ones. When Range is selected, you can define the bars as well 
as the pads or keys that will be quantized. 

 

 
Setting the Range in the Timing Correct window. 
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The Click/Metro menu contains all settings regarding the metronome (click track). 

 

To open the metronome settings, press and hold Shift, and then tap Click at the bottom of the 
touchscreen. 
 

 
The Click/Metro window. 

 

Use the Count-In field to set if/when the metronome counts before recording. 

• Off disables the metronome pre-count. 

• Record enables the pre-count during recording only. 

• Record + Play enables pre-count in both Record and Playback Modes. 

 

Use the Enable field to set if/when the metronome is enabled. 

• Off disables the metronome. 

• Play enables the metronome sound during playback only. 

• Record enables the metronome sound during recording only. 

• Record + Play enables the metronome to happen in both Record and Playback Modes. 
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Use the Rate field to select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 
or 1/32T. T indicates a triplet-based time division. 

 

Use the Sound field to select the sound that you want to hear for the metronome: Sidestick 1, 
Sidestick 2, Clap, Metroclick, Shake, Tambourine, or MPC Click. 

 

Use the Volume knob to set the volume of your metronome click. 

 

Tap the On/Off button to enable or disable the metronome. 
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Grid View 
 

Grid View lets you view and edit the note events of each track of a sequence 
in a project and their velocities. This mode has two different appearances: 
one for drum programs and one for keygroup programs, MIDI programs, and 
plugin programs. 

For drum programs, the left column shows you all available pads in a vertical view with their 
corresponding data.  

For keygroup programs, plugin programs, and MIDI programs, the left column shows a vertical “piano 
roll” keyboard.  

 

To enter Grid View, press Menu, and then tap Grid View. 

 

 

Grid View of a drum program. 
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Grid View of a keygroup program, plugin program, or MIDI program. 
 

 

The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can 
easily jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

• To enter Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 
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Use the Track field to select which track of the current sequence you want to show in the grid. 

To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + 
(respectively) at the bottom of the touchscreen. 

 

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom 
of the touchscreen. 

 

Use the Bars field to set the length of the sequence. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

 



                 

 
121 

 

 

The Settings window lets you select certain Grid View settings. 

To view the Settings, tap the gear icon. 

 

 

The Settings window in Grid View. 
 

Use the Hitting Pad Selects All Events selector to turn the feature on or off. When on, pressing a pad 
will automatically select all note events for that pad in the sequence on that track. When off, pressing a 
pad will simply play its sound without selecting any note events. 

 

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead. 

• Follow: Depending on the zoom setting, the grid will scroll along in the background, keeping the 
audio playhead centered. 

• Page: The grid display will “turn over” to follow the audio playhead. 

• Off: The grid will not move at all. 

These functions also apply to the sample waveform in Sample Edit Mode. 
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In Grid View, these four icons enable you to use different functions 
in the grid. Tap one to select its mode: 

 

Pencil: Draw Mode: 

• To enter a note in an empty grid square, tap the square. 

• To select a note, tap it. 

• To move a note, tap and drag it to another grid square. 

• To erase a note, double-tap it. 

 

Eraser: Erase Mode: 

• To erase a note, tap it. 

 

Select Box: Select Mode: 

• To select a note, tap it.  

• To select multiple notes, tap and drag across the grid to create a box around them. 

• To move a note, tap and drag it to another grid square. 

• To move multiple notes, select them as described above, and tap and drag them. 

 

Magnifying Glass: Navigation Mode: 

• To move to another part of the grid, tap and drag it. 

• To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this 
vertically, horizontally, or both at the same time. 
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Grid View. 

 

Regardless of which tool is selected, you can perform any of the following operations to move, lengthen, 
shorten, or transpose any selected note(s). 

 

To automatically set the grid to view 1 pad bank and 2 bars, tap the grid-and-magnifying-glass icon 
in the lower-left corner. 

 

To undo your last action, press Undo. 

 

To redo the last action you undid, press Shift+Undo/Redo. 

 

To select all notes for a pad, press the desired pad. 
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To move the selected notes, tap Nudge at the bottom of the touchscreen, and then use the Data Dial 
or –/+ buttons to shift the notes left or right. 

By default, you can position notes only by quantization values, defined by the Time Correct value (learn 
about this feature in the Main Mode chapter). 

To change the position of notes without restricting (“snapping”) them to the grid, tap and hold Don’t 
Snap in the lower-left corner of the touchscreen, and then use the Data Dial or –/+ buttons to shift the 
notes. In this case, each nudge is equivalent to 4 ticks. 

 

To adjust the start point or end point of the selected notes (without changing their position), tap Edit 
Start at the bottom of the touchscreen, and then use the Data Dial or –/+ buttons. 

 

To transpose the selected notes up or down, tap Transpose at the bottom of the touchscreen, and 
then use the Data Dial or –/+ buttons. 
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Grid View also contains a velocity lane where you can easily adjust note velocities. 
 

  
    The velocity lane in the Grid View.   The taller velocity lane in the Grid View. 

 

To show or hide the velocity lane: 

1. Tap the up (∧) button in the lower-right corner to show the velocity lane. 

2. Tap the up (∧) button once more to show a taller version of the velocity lane. The button will now 
show a down arrow (∨). 

3. Tap the down arrow (∨) to hide the velocity lane. 

 

Each note’s velocity is represented by a vertical bar. The higher and more red the bar is, the higher the 
velocity is. Yellow bars indicate a lower velocity. Bars with a gray line at the top indicate a currently 
selected note. 

To adjust the velocity of the selected notes, tap Velocity at the bottom of the touchscreen, and then 
use the Data Dial or –/+ buttons. The numeric value will appear on the screen. 

 

To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the 
touchscreen. This feature is described already in the Main Mode chapter. 

 

To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the 
touchscreen. This feature is described already in the Main Mode chapter. 
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Track View 
 

Track View gives you an overview of the tracks of each sequence. Use this 
mode to edit Tracks and Sequences simultaneously. 

 

To enter Track View, do either of the following: 

• Press Menu, and then tap Track View. 

• Press Shift+Main/Track.  

 
 

 
Track View Mode. 

 

Each horizontal strip represents a track in the current sequence. Swipe up or down to move through the 
list of tracks. 
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Use the Sequence field to select which sequence contains the tracks you want to show below. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

 

The Settings window lets you select certain Track View settings. 

To view the Settings, tap the gear icon. 

 

 

 

Use the Show Unused Tracks selector to turn this feature on or off. When on, tracks with a sequence, 
program, etc. will still appear in the Track View. When off, only tracks with a sequence, program, etc. will 
appear. 

 



                 

 
128 

 

 

The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can 
easily jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

• To enter Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

 

 

 

 

Use the Program field to select a program for the track. 

 

Use the Length field to set how long the track is. If you select the minimum value, Sequence or 0, the 
track will be however long your sequence it. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum 
sequence repeatedly under a 4-bar bass line. 

 

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set 
to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the 
track will play twice as loud. The maximum velocity level is still 127, though. 
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Use the Transpose field to set the transposition (in semitones) of the entire track.  

 

Use the Level slider to change the level of the track. 

 

Use the Solo and Mute buttons to solo or mute the track (respectively). 

Alternatively, tap Mute or Solo (respectively) at the bottom of the touchscreen to mute the currently 
selected track. 

 

To switch to the previous or next track, tap Track – or Track + (respectively) at the bottom of the 
touchscreen. 

 

To open the Timing Correct settings, tap TC at the bottom of the touchscreen. This window is 
described already in the Grid View chapter. 

 

To open the metronome settings, tap Click at the bottom of the touchscreen. This window is 
described already in the Grid View chapter. 
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Step Sequencer 
 

The Step Sequencer lets you create or edit sequences by using the pads as 
“step buttons,” simulating the experience of a traditional step-sequencer-
style drum machine.  

 

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. 

 

 

The Step Sequencer.
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The Track field shows the name of the current track. 

 

Use the Track Length field to set how long the track is. If you select the minimum value, Sequence or 
0, the track will be however long your sequence it. 

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum 
sequence repeatedly under a 4-bar bass line. 

 

Use the Bars field to adjust the length of the sequence in bars. 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo or a master tempo, tap the 
Seq/Mst button next to the BPM field. Alternatively, press and hold Shift+Tap Tempo. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can 
easily jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

• To enter Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

 

 

Use the Time Division selector to set the value that determines how many steps each bar of the 
sequence will have. The T indicates a triplet-based value.  

Alternatively, tap TC at the bottom of the touchscreen to open the Timing Correct window. This is 
described already in the Main Mode chapter. 

 

To enter or delete steps in a sequence: 

1. Use the Pad –/+ buttons at the bottom edge of the touchscreen to select the pad whose steps you 
want to enter or delete. The current pad number is shown in the upper-left corner. 

Alternatively, use the Pad Select feature. Tap and hold Pad Sel, press the desired pad, and then 
release Pad Sel. You can also use Pad Select as a “latching” feature: tap Pad Sel so it is activated, 
press the desired pad, and then tap Pad Sel once more so it is deactivated. 

2. Use the Bar –/+ buttons at the bottom edge of the touchscreen to select the bar of the sequence 
whose steps you want to enter or delete. The current bar number is shown in the upper-left corner. 

3. Press the pads of your MPC Touch, or tap a button at the bottom of the sequencer. Each pad 
corresponds to a step in the bar and will light with a color corresponding to its velocity. Keep in mind 
that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. Use 
the Pad Bank Buttons A and B to view all the steps within a bar. 
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For time divisions larger than 16, the bar’s steps will be represented by 
multiple pad banks. Use the left and right arrows (< and >) by the step 
numbers (1–16, 17–32, etc.) to change which steps are shown in the 
sequencer. The numbers by these arrows indicate which steps are shown. 

Alternatively, use Pad Bank Buttons to change which steps are shown. 

 

To adjust the velocities of the steps, do either of the following: 

• Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point. 

• Use the slider on the right to increase or decrease the velocities of all steps. 

 

Use the Nudge arrows (< and >) to shift each step left or right (respectively) one step. This is useful for 
experimenting with different rhythmic permutations. 

 

Use the slider on the right to increase or decrease the velocities of all steps.  

 

Use the Invert button (filled-and-empty-squares icon) to switch which steps have notes 
entered and which do not have notes. Steps that previously had no notes will now have 
notes at full velocity (127). Steps that previously had notes will now be empty. 
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Tap Presets to show or hide the preset sequence controls. These controls let you 
manipulate and transform the velocities of the current bar in the sequence. 

 

The first button will apply ascending or descending velocities to the steps. Each time 
you tap it, it will cycle through these options: 

• The velocities will ascend to a single peak at the end of the bar.  

• The velocities will ascend to 2 peaks—one after each half of the bar. 

• The velocities will ascend to 4 peaks—one after each quarter of the bar. 

• The velocities will descend from a single peak at the start of the bar.  

• The velocities will descend from 2 peaks—one after each half of the bar. 

• The velocities will descend from 4 peaks—one at the start each quarter of the bar. 

 

The second button will set the velocities of the steps to be at the maximum value (127) or minimum 
values (1), depending on their position in the bar. Each time you tap it, it will cycle through these options: 

• The velocities of the first half of the bar will be set to 1. The velocities of the second half will be set 
to 127. 

• The velocities of the first and third quarters of the bar will be set to 1. The velocities of the second 
and fourth quarters will be set to 127. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The velocities of 
the second, fourth, sixth, and eighth eighths will be set to 127. 

• The velocities of the first half of the bar will be set to 127. The velocities of the second half will be 
set to 1. 

• The velocities of the first and third quarters of the bar will be set to 127. The velocities of the 
second and fourth quarters will be set to 1. 

• The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The velocities 
of the second, fourth, sixth, and eighth eighths will be set to 1. 
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The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will 
cycle through these options: 

• Across the entire bar, the velocities will ascend to a peak and then descend from it.  

• In each half of the bar, the velocities will ascend to a peak and then descend from it. 

• In each quarter of the bar, the velocities will ascend to a peak and then descend from it. 

• Across the entire bar, the velocities will descend from a peak into a valley and then ascend back up 
to the peak. 

• In each half of the bar, the velocities will descend from a peak into a valley and then ascend back 
up to the peak. 

• In each quarter of the bar, the velocities will descend from a peak into a valley and then ascend 
back up to the peak. 

 

Tap the Reflect button (inward-pointing-arrows icon) to swap the first half and second 
half of the bar. In other words, the first half of the bar will become a mirrored image of 
the second half, and vice versa. 

 

Tap the Flip button (up-and-down-arrows icon) to invert the velocities of all steps with 
entered notes. The sum of the old and new velocities will equal 127. The exception is a 
velocity of 127 or 1 as a step with a note cannot have a velocity of 0. 

Examples: 

Steps with velocities of 40 will now have velocities of 87, and vice versa. 

Steps with velocities of 75 will now have velocities of 52, and vice versa. 

Steps with velocities of 127 will now have velocities of 1, and vice versa. 
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XYFX Mode 
 

XYFX Mode turns the touchscreen into an XY pad where each axis represents the range 
of an effect parameter. As you move touch or move your finger on the touchscreen, the 
current position will determine the current value of the two parameters. You can use this 
mode to create interesting effect automation on your tracks. 

The effect you control in XYFX Mode acts like an insert effect on that program. In fact, XYFX is the name 
of the insert effect you have to load to the program before you can use this mode. Learn more about this 
in General Features > Effects. 

 

To enter XYFX Mode, press Menu, and then tap XYFX. 

When you first enter this mode in a project, you may need to prompted to load XYFX to the program. 
Tap Insert XYFX to do this. 

Note: If you already have 4 insert effects loaded, you will need to clear one of the insert effect slots 
before doing this.  

 

 
Moving your finger on the touchscreen in XYFX Mode. 
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The left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can 
easily jump between them: 

• To enter Main Mode, tap the house icon. 

• To enter Grid View, tap the grid icon. 

• To enter Track View, tap the bars-and-magnifying-glass icon. 

• To enter the Step Sequencer, tap the vertical-bars icon. 

• To enter XYFX Mode, tap the XY icon. 

 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

The automation button in the upper-right corner controls the global automation, which sets the 
automation state for all programs in the project. Tap it to cycle through its three states: 

When off, the program will ignore automation data. If you have already recorded or entered 
automation, tapping this will switch between Read (R) and Write (W) only, but you can 
override this and turn it off by pressing and holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

When set to Read (R), the program will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of this 
as a protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the program can record automation. (Make sure not to touch the XY 
pad accidentally while you are recording.) 

Note: You can set automation for each program indepdendently in Main Mode. See the 
Main Mode chapter to learn how to do this. 
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Touch or move your finger on the gridded part of the touchscreen. A red marker will follow your finger to 
indicate the current position. The X axis is the horizontal axis, increasing in value as you move right. The 
Y axis is the vertical axis, increasing in value as you move up. 

 

While touching the XY pad, tap the Latch button to keep the marker on the XY pad even after you 
release it (the marker will become a white circle instead of a red circle). The marker will remain there until 
you touch another part of the XY pad or until you tap the Latch button again. 

 

Use the Setup button to show or hide the Setup panel, which controls how the XY pad behaves. 

 

 
The Setup panel in XYFX Mode. 
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Use the Preset field to select the effect you want to use in XYFX Mode. 

 

Use the Attack knob to set the length of the attack phase of the envelope, which is triggered when you touch 
the XY pad. In other words, this determines how long it takes the effect to fully respond to your touch. 

 

Use the Release knob to set the length of the release phase of the envelope, which is triggered when 
you release the XY pad. In other words, this determines how long it takes the effect to fully deactivate 
after you stopping touching the XY pad. 

 

Use the Wet/Dry knob to set the blend the original signal (dry) and the effect signal (wet). 

 

The X Axis and Y Axis fields show which parameters are controlled by each axis. This varies depending 
on the effect you are using. 
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Sample Edit Mode 

 

Sample Edit Mode lets you edit samples using various functions. 

 

 

To enter Sample Edit Mode, press Menu, and then tap Sample Edit. 

 

 

 

To select a sample to edit, do any of the following: 

• Use the Sample field at the top of the touchscreen. 

• In Main Mode, tap the Project field at the top of the touchscreen, and then double-tap a sample in 
the list on the right side. 

• In the Browser, tap the Project button with the P/page icon at the bottom of the touchscreen, and 
then double-tap a sample in the list on the right side. 
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The upper half of the screen shows the waveform. The lower half shows the editing controls. 

 

 

A sample waveform with a single start point and end point. 
 

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the 
waveform to move through it. 

Above the waveform is the timeline, shown in Samples, Time (in seconds and milliseconds), or Beats. 
You can select the measurement units you want to show in the Settings. 

 

To zoom in or out, do any of the following: 

• When the magnifying-glass icon (in the upper-right corner) is selected, spread or pinch your fingers 
(respectively) on the waveform. 

• Tap the Zoom + or Zoom – buttons (respectively) at the bottom edge of the touchscreen. 

• Turn the bottom-most Q-Link Knob in the fourth bank. 

 

To scroll through the waveform, do either of the following: 

• When the magnifying-glass icon (in the upper-right corner) is selected, swipe the waveform left or right. 

• Turn the third Q-Link Knob in the fourth bank. 
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The green marker and red marker are the start point and end point (respectively). These two points 
define the region of the sample that will be played. 

To move the start point or end point of the selected region, do either of the following: 

• Tap and drag its marker left or right. 

• Use the Start or End fields shown below the waveform. 

• Use the first bank Q-Link Knobs to adjust the start point or the second bank of Q-Link Knobs to 
adjust the end point. The top-most Q-Link Knob provides coarse adjustment. The bottom-most Q-
Link Knob provides fine adjustment. 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time 
it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to 
remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, 
having a “tight,” well-edited sample can enhance your production or performance. 

 

You can use Sample Edit Mode in three different ways: Trim Mode, Chop Mode, or Program Mode. 
The options for each mode are slightly different. Please refer to the following Trim Mode, Chop Mode, 
and Program Mode parts of this chapter to learn how each works. 

 

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop 
Mode. This allows for a more detailed view of a single slice than in Chop Mode and gives you more options 
for auditioning the slice. You can easily switch between Trim Mode and Chop Mode while doing this. 

 

To use both Trim Mode and Chop Mode to edit a sample slice: 

1. Tap Trim/Chop at the bottom edge of the touchscreen so it says Chop. 

2. Set all fields as desired to create your sample slices. 

3. Select the desired slice. 

4. Tap Trim/Chop at the bottom edge of the touchscreen so it says Trim. The region you are now 
editing is indicated by the normal start point and end point markers rather than slice markers. 

5. Tap Trim/Chop at any time to return to Chop Mode. 
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Trim Mode 

 

We recommend using Trim Mode to simply crop the end(s) from a sample. 

 

To enter Trim Mode, tap the Trim/Chop button in the lower-left corner so it says Trim. 

 

 

Trim Mode. 
 

Use the Start and End fields to set the position of the start point and end point of the sample 
(respectively). Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first bank 
Q-Link Knobs to adjust the start point or the second bank of Q-Link Knobs to adjust the end point. 
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Trim Mode includes a loop function. When on, the region of the sample between the loop point and end 
point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be 
earlier than the start point. 

 

To adjust the loop point, do any of the following: 

• Use the Loop field.  

• Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off). 

• Use the first bank of Q-Link Knobs (if Loop Lock is on) or the third bank Q-Link Knobs (if Loop 
Lock is off). The top-most Q-Link Knob provides coarse adjustment. The bottom-most Q-Link Knob 
provides fine adjustment. 

 

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the 
start point. When off, the loop point is independent from the start point. 

 

To turn the loop function on or off, tap the Loop button to cycle between the three modes: 

• Forward: When the loop reaches its end point, it will start playing again from the loop point.  

• Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point 
again, it will return to the end point and continue playing in reverse. 

• Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will start playing forward again from the loop point. 

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the 
touchscreen. 
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Use the MPC Touch pads (any bank) to play certain parts of the 
selected sample: 

• Play Loop (Pad 13) plays the sample repeatedly from the 
loop point to the end point. 

• Play Sample (One Shot) (Pad 10) plays the whole sample 
as it has been edited. Press the pad once to play it. 

• Play Sample (Note On) (Pad 11) plays the whole sample 
as it has been edited. Press and hold the pad to play it. 
Release the pad to stop playing it. 

Alternatively, select the headphones icon in the upper-right 
corner, and then tap and hold your finger on the waveform. 

• Play All (Pad 16) plays the sample region between the loop 
point to the end point. 

• Play to Loop Start (Pad 14) plays the sample region before the loop point. 

• Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample 
regardless of the end point. 

 

Pads 1–4 have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One 
Shots” (pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note 
Ons” (pressing the pad and holding it will play the part; releasing it will stop playback): 

• Play from Start (Pad 1 and Pad 5) plays the sample from the start point to the end of the sample 
regardless of the end point.  

• Play to Start (Pad 2 and Pad 6) plays the sample portion before the start point. 

• Play to End (Pad 3 and Pad 7) plays the sample portion from the start point to the end point. 

• Play from End (Pad 4 and Pad 8) plays the sample part from the end point to the end of the 
sample. 
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Use the Tune field to transpose the sample up or down from its original pitch. 

 

Tap From BPM to open the Calculate BPM window, which 
lets you tune a sample to the current sequence. 

Use the Number Of Beats field to match the number of 
beats in the sequence. 

To tune the sample to the sequence, tap Match. The Tune 
field will adjust automatically and close the window. The 
sample is now tuned to the sequence. 

To tune the sample to the sequence and adjust the 
sequence tempo, tap To Seq. This is the same as tapping 
Match but it also changes the sequence’s tempo to the BPM 
shown in the Tempo field on the right. 

To close the window, tap Close. 

 

Use the Root Note field to set the root note of the sample. This defines which note will play the sample 
at its original pitch when in a keygroup program. 

 

The Slice field does not work in Trim Mode. 

 

The Link Slices button does not work in Trim Mode. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-
crossings.” This can help to avoid clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom edge of the 
touchscreen. 

 

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the 
touchscreen. This switches the loop function between Forward and off. The loop function is described 
earlier. 
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Assigning Samples 
 

You can assign your new sample directly to a pad from Trim Mode. 

To assign a sample, tap Assign at the bottom edge of the touchscreen to open the Assign Sample window. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To field to Assign the slice to a pad, the pad 
will simply refer to the slice in this sample instead of creating a new 
sample. This is useful for reducing clutter in your project. 

 

Use the Pad field to select the desired pad. Alternatively, press the 
desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings will 
be set when the slice is assigned to it (see Program Edit Mode to 
learn more about the parameters mentioned below): 

• Non-Destructive Slice: The pad’s Slice setting will be set to 
the slice number. 

• Pad Parameters: The pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End will be set to the slice’s start point 
and end point values, and the Loop Position will be set to the 
slice’s start point but with Pad Loop deactivated. 

 

Use the Program field to specify the program to which you want to 
add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Assign To field to Make new sample, this will create a 
new sample in your project. (The original sample will remain as it is.) 

 

Use the Pad field to select the desired pad. Alternatively, press the 
desired pad. 

 

Check the Crop Sample box to delete the unused parts from the 
sample when it’s created and assigned. This feature is destructive, 
though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the sample 
when it is created and assigned. This way, you will still be able to 
edit the entire sample further even though you are using only part of 
it at the moment. 

 

Use the Program field to specify the program to which you want to 
add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 
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Processing Slices & Samples 
 

Tap the Process button to open the Process window, where you can 
select an editing option for the sample. 

 

Use the Function field to select an editing process. Double-tap it or tap 
Function at the bottom of the touchscreen to open the Function 
window, which gives an overview of all available editing processes. 

 

 

 
The Process window in Trim Mode. 

 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top edge of the touchscreen. 

Note: All Slice processes will affect only the part of the sample between the start point and the end 
point. The Sample processes (Bit Reduce and Stereo -> Mono) will affect the entire sample regardless 
of its start point or end point. 
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Discard 

This process deletes the regions before the start point and after 
the end point. 

 

 

 

 

 
Delete 

This process deletes the region between the start point and end 
point and closes the gap between them. 

 

 

 

 

 

Silence 

This process replaces the region between the start point and end 
point with silence. 
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Extract 

This process deletes the regions before the start point and after 
the end point and saves it as a new sample (with a name you 
enter) in your current project. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use 
separately in the project. 

 

 

 

Normalize 

This process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level 
settings when working with samples with a wide range of 
amplitudes.  

 

 

 
Reverse 

This process reverses the region between the start point and end 
point. 
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Fade In 

This process sets a fade-in between the start point and end point. 
The following types are available:  

• Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

• Log fades the audio in with a logarithmic curve—quickly 
rising at the start and flattening out towards the end. 

• Exp fades the audio in with an exponential curve—slowly 
rising in the beginning and growing steeper towards the end. 

 

Fade Out 

This process sets a fade-out between the start point and end 
point. The following types are available:  

• Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

• Log fades the audio out with a logarithmic curve—quickly 
rising at the start and flattening out towards the end. 

• Exp fades the audio out with an exponential curve—slowly 
rising in the beginning and growing steeper towards the end. 

 

Pitch Shift 

This process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence 
without affecting the sample’s tempo or duration. You can adjust it 
up to 12 semitones, up or down. Keep in mind that the audio 
quality may decrease at more extreme settings. 
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Time Stretch 

This process lengthens or shortens the sample without changing 
its pitch. This is useful for matching the durations of two samples 
with different pitches. You can enter the original tempo of the 
sample and the desired tempo after processing.  

Use the Beat field to set the desired value number of beats. 

Use the New Tempo field to set the new tempo. The Ratio field 
will then automatically show the time stretch factor. 

Alternatively, to adjust the ratio instead, use the Ratio field to set the 
desired ratio. The New Tempo field will then change automatically 
based on the new time stretch factor. 

 

Gain Change 

This process raises or lowers the volume of the sample. You can 
adjust it up to 18 dB, higher or lower. This function is different than 
Normalize because it will allow volumes beyond clipping level. This 
may be a desired effect, but remember to watch your output level! 

 

 

Copy 

This process saves a copy of the sample. Tap the Edit Name field 
and use the virtual keyboard that appears to enter a new name. 
Otherwise, the process will add a consecutive number after the 
sample name. 
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Bit Reduce 

This process lowers the bit resolution of a sample, effectively 
reducing its degree of faithful reproduction. You can reduce it 
down to 1 bit. (The sound is similar to the Resampler effect, but 
Bit Reduce will permanently alter the sample.) 

Tip: Use this on drum loops to get a dirty, “old-school” sizzle but 
with a digital “edge.” 

Note: This process affects the entire sample regardless of its start 
point or end point. 

 

 

 

Stereo -> Mono 

This process converts a stereo sample to a new mono sample and 
saves it as a new sample. Tap the Edit Name field and use the 
virtual keyboard that appears to enter a new name. Otherwise, the 
process will add a consecutive number after the sample name. 
The following options are available: 

• Left will convert the left channel only. 

• Right will convert the right channel only. 

• Sum will combine the left and right audio channels to a single 
mono channel. 

Note: This process affects the entire sample regardless of its start 
point or end point. 
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Chop Mode 

 

Whereas Trim Mode crops only the end(s) off of a sample, Chop Mode divides the sample into multiple 
regions called slices. We recommend using Chop Mode when working with a long sample with different 
sounds throughout (e.g., a drum loop or a long melodic or harmonic passage). 

 

To enter Chop Mode, tap the Trim/Chop button in the lower-left corner so it says Chop. 

 

 
Chop Mode. 

 

Use the Start and End fields to set the position of the start point and end point (respectively) of the 
currently selected slice. Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first 
bank Q-Link Knobs to adjust the start point or the second bank of Q-Link Knobs to adjust the end point. 
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Use the selector in the lower-left corner of the touchscreen to choose how you want to use Chop Mode: 

 

Manual  

This method lets you insert slices at locations you select. 

 

Threshold  

This method uses an adjustable detection algorithm that derives the number of slices created from the 
volume levels present in the sample. 

Use the Threshold field to set the threshold level. Alternatively, turn the second Q-Link Knob in the 
third bank. The higher the selected value, the more slices will be created. 

Use the Min Time field to set the minimum length of a slice in milliseconds.  

 

Regions 

This method divides a sample into several slices of equal length. 

Use the Regions field to set how many regions the sample will be divided into. Alternatively, turn the 
second Q-Link Knob in the third bank. The higher the selected value, the more slices will be created. 

 

BPM 

This method divides a sample into several slices based on the tempo (beats per minute). 

Use the Bars field to set how many bars are in the sample. Alternatively, turn the second Q-Link Knob 
in the third bank. 

Use the Beats field to set how many beats are in each bar. Alternatively, turn the third Q-Link Knob in 
the third bank. 

Use the Time Div field to set a note division. Alternatively, turn the bottom-most Q-Link Knob in the 
third bank. The slice markers will be placed according to this setting. You can select 1/4, 1/8, 1/16, or 
1/32. (In most cases, you should set this parameter to 1/16.) 
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To play a slice, do either of the following: 

• Press the pad that corresponds to the slice. If your sample has more than 16 slices, use the 
additional pad banks. 

• When the headphones icon (in the upper-right corner) is selected, tap your finger on a slice in the 
waveform. 

 

When the One Shot feature is enabled, you can press a pad once to play the entire slice. When this is 
disabled, pressing the pad and holding it will play the slice; releasing it will stop playback. 

To enable or disable One Shot, press and hold Shift, and then tap One Shot. 

 

To select a slice to edit, do either of the following: 

• Use the Slice field. 

• Turn the top-most Q-Link Knob in the fourth bank. 

• When the headphones icon (in the upper-right corner) is selected, tap your finger on a slice in the 
waveform. 

 

To add a slice at the current playhead position, tap Slice+ at the bottom edge of the touchscreen. 
You can do this at any point during sample playback.  

 

To split or combine slices, tap the glue-and-scissors 
icon. 

In the Split/Combine Region window that appears, tap 
one of the following buttons: 

• Split: This splits the currently selected region into 
two equal slices. 

• Combine: This combines the currently selected 
region with the one before it. 

• Back: This closes the window. 
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When Link Slices is enabled, changing the start point of a slice will also change the end point of the 
previous slice. Similarly, changing the end point of a slice will also change the start point of the next 
slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. 

To enable or disable this feature, tap the Link Slices button. 

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping. 

 

To remove all slices from a sample, press and hold Shift and tap Clear All. 

 

The cue playhead is useful when manually inserting slice markers. You can set its position and behavior 
to suit your workflow.  

Use the Cue field to adjust the position of the cue playhead. Alternatively, tap and drag the translucent 
marker with the triangle (). 

To play the sample from the cue playhead, tap Play Cue at the bottom edge of the touchscreen. 

To create a slice marker at the cue playhead position, tap Slice+ at the bottom edge of the touchscreen. 

To set how the cue playhead behaves, use the Settings window (see below). 

 

0 Snap forces start points and end points to occur only at the waveform’s “zero-crossings.” This can 
help to avoid clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom edge of the 
touchscreen. 
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Converting or Assigning Slices 
 
You can assign your new sample directly to a pad from Chop Mode. You can also convert it into a new 
program or patched phrase. 

To convert or assign a sample, press and hold Shift, and then tap Convert at the bottom edge of the 
touchscreen to open the Convert or Assign Slices window. 

 
If you set the Convert To field to New program using slices, this 
will create a new program and assign the sample’s slices to its 
pads. The pads will simply refer to the slices in this sample instead 
of creating new samples. This is useful for reducing clutter in your 
project. The new program will be named after the sample and 
appended with ch. 

 
Use the Slice Type field to select how each pad’s layer settings 
will be set when the slices are assigned to them (see Program 
Edit Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice: Each pad’s Slice setting will be set 
to the slice number. 

• Pad Parameters: Each pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End parameters will be set to the 
slice’s start point and end point values, and the Loop Pos 
parameter will be set to the slice’s start point but with Pad 
Loop deactivated. 

 
Check the Create Events box to automatically create a new track 
for the new program in which each pad plays its corresponding 
slice in ascending sequence by pad number.  

 
If Create Events is checked, use the Number of Bars field to set 
how many bars the slices’ events will occupy. 

 
To convert the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Convert To field to New program with new 
samples, this will create a new sample from each slice and 
assign them to pads in a new program. 

The new program will be named after the sample and 
appended with ch. The new samples will be appended with 
SI-# (where # is a consecutive number). 

 

Check the Crop Samples box to delete the unused parts from 
the sample when they’re created and assigned. This feature is 
destructive, though the project will still contain your original 
sample. 

Leave this box unchecked to keep the unused parts of the 
samples when they’re created and assigned. This way, you will 
still be able to edit the entire samples further even though you 
are using only part of them at the moment. 

 

By default, this option already will create a new program. You 
can uncheck the Create New Program box to convert each 
slice into a sample that is placed in the project’s sample pool 
but not assigned to a program or pad. 

 

If Create New Program is checked, check the Create Events 
box to automatically create a new track in which each pad plays 
its corresponding slice in ascending sequence by pad number.  

 

If Create Events is checked, use the Number of Bars field to 
set how many bars the slices’ events will occupy. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Convert To field to Assign the slice to a pad, 
the pad will simply refer to the slice in this sample instead of 
creating a new sample. This is useful for reducing clutter in 
your project. 

Important: Assigning a sample to a pad in this way will 
replace the sample on the first layer of the pad. 

 

Use the Pad field to select the desired pad. Alternatively, 
press the desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings 
will be set when the slice is assigned to it (see Program Edit 
Mode to learn more about the parameters mentioned below): 

• Non-Destructive Slice: The pad’s Slice setting will be 
set to the slice number. 

• Pad Parameters: The pad’s Slice setting will be set to 
Pad. The Pad Start and Pad End will be set to the slice’s 
start point and end point values, and the Loop Position 
will be set to the slice’s start point but with Pad Loop 
deactivated. 

 

Use the Program field to specify the program to which you 
want to add the slice. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Convert To field to Make new sample, this will 
create a new sample in your project. (The original sample will 
remain as it is.) 

Important: Assigning a sample to a pad in this way will 
replace the sample on the first layer of the pad. 

 

Use the Pad field to select the desired pad. Alternatively, 
press the desired pad. 

 

Check the Crop Sample box to delete the unused parts from 
the sample when it’s created and assigned. This feature is 
destructive, though the project will still contain your original 
sample. 

Leave this box unchecked to keep the unused parts of the 
sample when it is created and assigned. This way, you will still 
be able to edit the entire sample further even though you are 
using only part of it at the moment. 

 

Use the Program field to specify the program to which you 
want to add the slice. 

 

To convert the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Convert To field to Patched phrase, this will 
create a new sample that will play based on the tempo of your 
Sequence, and places it in the current project. The patched 
phrase will have the same name as the original sample but 
appended with pp and will use a different icon when viewing 
your project information.  

Use the Number of Bars field to set how many bars long the 
patched phrase is meant to be. 
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Processing Slices 
 
Press and hold Shift, and then tap the Process button to open the 
Process window, where you can select an editing option for the currently 
selected slice. (This has fewer options than Trim Mode. Unavailable ones 
are darkened.) 

Use the Function field to select an editing process. Double-tap it or tap 
Function at the bottom of the touchscreen to open the Function 
window, which gives an overview of all available editing processes. 

Important: Chop Mode is non-destructive: You can choose the 
slice/edit behavior without destroying your original sample, giving you 
more control over sample playback; you can save your sliced sample 
and but also reuse all of the slice data in another project. See the 
Program Edit Mode chapter to learn more about setting a pad to play 
the entire sample, a specific slice of a sample, or a specific region of the 
sample (independent of its slice markers). 

 

 
The Process window in Chop Mode. 

 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top edge of the touchscreen. 

Note: All processes here will affect only the currently selected slice. 
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Silence 

This process replaces the region between the start point and end 
point with silence. 

 

 

 

 

 

Extract 

This process deletes the regions before the start point and after 
the end point and saves it as a new sample (with a name you 
enter) in your current project. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use 
separately in the project. 

 

 
Normalize 

This process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level 
settings when working with samples with a wide range of 
amplitudes.  
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Reverse 

This process reverses the region between the start point and end 
point. 

 

 

 

 
 

Fade In 

This process sets a fade-in between the start point and end point. 
The following types are available:  

• Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

• Log fades the audio in with a logarithmic curve—quickly rising at 
the start and flattening out towards the end. 

• Exp fades the audio in with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 

 

Fade Out 

This process sets a fade-out between the start point and end point. 
The following types are available:  

• Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

• Log fades the audio out with a logarithmic curve—quickly rising 
at the start and flattening out towards the end. 

• Exp fades the audio out with an exponential curve—slowly rising 
in the beginning and growing steeper towards the end. 



                 

 
167 

 

 

Pitch Shift 

This process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence 
without affecting the sample’s tempo or duration. You can adjust it 
up to 12 semitones, up or down. Keep in mind that the audio 
quality may decrease at more extreme settings. 

 

 

 

Gain Change 

This process raises or lowers the volume of the sample. You can 
adjust it up to 18 dB, higher or lower. This function is different than 
Normalize because it will allow volumes beyond clipping level. This 
may be a desired effect, but remember to watch your output level! 
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Program Mode 

 

Program Mode lets you edit a sample in the context of the program in which you’ll use it. You can adjust 
the pad parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound 
in the program’s audio path. 

 

To enter Program Mode, tap the Program button at the bottom of the touchscreen. The pads will show 
their assigned samples in the current Program. 

       
Use the Start and End fields to set the position of the start point and end point of the sample 
(respectively). Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first bank 
Q-Link Knobs to adjust the start point or the second bank of Q-Link Knobs to adjust the end point. 

 

 

Program Mode includes a loop function. When on, the region of the sample between the loop point and 
end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop 
cannot be earlier than the start point. 

 

To adjust the loop point, do any of the following: 

• Use the Loop field.  

• Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off). 

• Use the first bank of Q-Link Knobs (if Loop Lock is on) or the third bank Q-Link Knobs (if Loop 
Lock is off). The top-most Q-Link Knob provides coarse adjustment. The bottom-most Q-Link Knob 
provides fine adjustment. 

 

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the 
start point. When off, the loop point is independent from the start point. 
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To turn the loop function on or off, tap the Loop button to cycle between the three modes: 

• Forward: When the loop reaches its end point, it will start playing again from the loop point.  

• Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point 
again, it will return to the end point and continue playing in reverse. 

• Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop 
point again, it will start playing forward again from the loop point. 

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the 
touchscreen. 

 

Tap each pad to hear its sample(s). The sample on its first layer will automatically appear in the 
waveform display for editing. 

 

Use the Tune field to transpose the sample up or down from its original pitch. 

 

Tap From BPM to open the Calculate BPM window, which lets 
you tune a sample to the current sequence. 

Use the Number Of Beats field to match the number of beats 
in the sequence. 

To tune the sample to the sequence, tap Match. The Tune 
field will adjust automatically and close the window. The sample 
is now tuned to the sequence. 

To tune the sample to the sequence, tap Match. The Tune 
field will adjust automatically and close the window. The sample 
is now tuned to the sequence. 

To tune the sample to the sequence and adjust the 
sequence tempo, tap To Seq. This is the same as tapping 
Match but it also changes the sequence’s tempo to the BPM 
shown in the Tempo field on the right. 

To close the window, tap Close. 
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Use the Root Note field to set the root note of the sample. This defines which note will play the sample 
at its original pitch when in a keygroup program. 

 

Use the Slice field to display either the sample as it has been edited (Pad) or the entire sample (All). 

 

The Link Slices button does not work in Program Mode. 

 

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-
crossings.” This can help to avoid clicks and glitches when playing a sample. 

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom edge of the 
touchscreen. 

 

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the 
touchscreen. This switches the loop function between Forward and off. The loop function is described 
earlier. 
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Assigning Samples 

 

You can assign your new sample directly to a pad from Program Mode. 

To assign a sample, tap Assign at the bottom edge of the touchscreen to open the Assign Sample window. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To field to Assign the slice to a pad, the pad 
will simply refer to the slice in this sample instead of creating a new 
sample. This is useful for reducing clutter in your project. 

 

Use the Pad field to select the desired pad. Alternatively, press the 
desired pad. 

 

Use the Slice Type field to select how the pad’s layer settings will 
be set when the slice is assigned to it (see Program Edit Mode to 
learn more about the parameters mentioned below): 

• Non-Destructive Slice: The pad’s Slice setting will be set to 
the slice number. 

• Pad Parameters: The pad’s Slice setting will be set to Pad. 
The Pad Start and Pad End will be set to the slice’s start point 
and end point values, and the Loop Position will be set to the 
slice’s start point but with Pad Loop deactivated. 

 

Use the Program field to specify the program to which you want to 
add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 
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If you set the Assign To field to Make new sample, this will create a 
new sample in your project. (The original sample will remain as it is.) 

 

Use the Pad field to select the desired pad. Alternatively, press the 
desired pad. 

 

Check the Crop Sample box to delete the unused parts from the 
sample when it’s created and assigned. This feature is destructive, 
though the project will still contain your original sample. 

Leave this box unchecked to keep the unused parts of the sample 
when it is created and assigned. This way, you will still be able to 
edit the entire sample further even though you are using only part of 
it at the moment. 

 

Use the Program field to specify the program to which you want to 
add the slice. 

 

To assign the sample, tap Do It. 

To cancel the operation, tap Close. 
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Processing Slices 
 
Press and hold Shift, and then tap the Process button to open the 
Process window, where you can select an editing option for the currently 
selected slice. (This has fewer options than Trim Mode. Unavailable ones 
are darkened.) 

Use the Function field to select an editing process. Double-tap it or tap 
Function at the bottom of the touchscreen to open the Function 
window, which gives an overview of all available editing processes. 

Important: Program Mode is non-destructive: You can choose the 
slice/edit behavior without destroying your original sample, giving you 
more control over sample playback; you can save your sliced sample 
and but also reuse all of the slice data in another project. See the 
Program Edit Mode chapter to learn more about setting a pad to play 
the entire sample, a specific slice of a sample, or a specific region of the 
sample (independent of its slice markers). 
 

 
The Process window in Program Mode. 

 

You can use any of these functions as described below. 

To return to Sample Edit Mode, tap Cancel. 

To return to the Process window, tap the top edge of the touchscreen. 

Note: All processes here will affect only the currently selected slice. 
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Silence 

This process replaces the region between the start point and end 
point with silence. 

 

 

 

 

 

 

Extract 

This process deletes the regions before the start point and after 
the end point and saves it as a new sample (with a name you 
enter) in your current project. 

Tip: This is useful if you recorded a drum loop and wanted to 
remove just a snare drum hit, a kick drum hit, etc. to use 
separately in the project. 
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Normalize 

This process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level 
settings when working with samples with a wide range of 
amplitudes.  

 

 

 

Reverse 

This process reverses the region between the start point and end 
point. 

 

 

 

 
 

Fade In 

This process sets a fade-in between the start point and end point. 
The following types are available:  

• Linear fades the audio in with a linear curve—a straight line 
between the start and end. 

• Log fades the audio in with a logarithmic curve—quickly 
rising at the start and flattening out towards the end. 

• Exp fades the audio in with an exponential curve—slowly 
rising in the beginning and growing steeper towards the end. 
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Fade Out 

This process sets a fade-out between the start point and end 
point. The following types are available:  

• Linear fades the audio out with a linear curve—a straight line 
between the start and end. 

• Log fades the audio out with a logarithmic curve—quickly 
rising at the start and flattening out towards the end. 

• Exp fades the audio out with an exponential curve—slowly 
rising in the beginning and growing steeper towards the end. 

 

Pitch Shift 

This process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence 
without affecting the sample’s tempo or duration. You can adjust it 
up to 12 semitones, up or down. Keep in mind that the audio 
quality may decrease at more extreme settings. 

 

 

 

Gain Change 

This process raises or lowers the volume of the sample. You can 
adjust it up to 18 dB, higher or lower. This function is different than 
Normalize because it will allow volumes beyond clipping level. This 
may be a desired effect, but remember to watch your output level! 
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Settings 
 

The Settings window lets you select certain Sample Edit Mode settings. 

To view the Settings, tap the gear icon. 

 

 
The Settings window in Sample Edit Mode. 

 

Use the Cue Play Mode selector to set how the cue playhead will play audio. 

• One Shot: Tapping Play Cue will play the entire sample from the cue playhead. 

• Toggle: Tapping Play Cue once will start playback from cue playhead. Tapping it once more will 
stop playback. 
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Use the Cue Preview selector to set if any audio plays as you move the cue playhead. As you move the 
cue playhead through the sample waveform, you can set it to play the small part of the sample Before 
the cue playhead, play the small part of the sample After the cue playhead, or not play at all (Off). 

Use the Slice Preview selector to set if any audio plays as you move a slice marker. As you move the 
slice marker through the sample waveform, you can set it to play the small part of the sample Before the 
slice marker, play the small part of the sample After the slice marker, or not play at all (Off). 

 

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead. 

• Follow: Depending on the zoom setting, the waveform will scroll along in the background, keeping 
the audio playhead centered. 

• Page: The waveform display will “turn over” to follow the audio playhead. 

• Off: The waveform display will not move at all. 

These functions also apply to the sample waveform in Grid View. 

 

Use the Timeline Units selector to set the measurement units shown above the sample waveform. You 
can select one of the following options: 

• Time: hours (HH), minutes (MM), seconds (SS), and frames (FF) 

• Samples: number of samples 

• Beats: bars, beats, and ticks 
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Sampler 
 

The Sampler lets you record audio samples to use in your projects.  

Important: To record any audio, you need to connect an audio source to 
your MPC Touch or to your computer’s audio interface. 

 

To open the Sampler, press Menu and then tap Sampler. 

 

 

Recording using the Sampler. 
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To record using the Sampler: 

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors 
before you make any connections to avoid “pops” or feedback. 

2. Connect a microphone, audio player, etc. to the input(s) of your MPC Touch.  

3. Turn the Rec Gain knob to set the input level while speaking into the microphone. You should now 
see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be 
“peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Tap the Arm button to record-arm the Sampler.  

6. Speak/sing into the microphone or play your audio source. The Sampler will start recording 
immediately when the input level reaches the threshold value. Alternatively, tap the round Record 
button to manually start recording. 

Tip: You can record a sample while playing a sequence. 

7. To stop recording, tap the round Stop button. Use the options in the Keep or Discard Sample 
window that appears to continue. 
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The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

 

The upper-left Input Source field defines whether you are going to 
record an external audio signal (External) or an internal signal from 
the software (Resampler). Resampling does not require an audio 
connection because the source is within the software and is therefore 
recorded without any loss in audio quality. You can, for example, use 
Resample to record two or more samples by pressing the 
corresponding pads simultaneously. For each method, there are 
options for using the left (L) channel, right (R) channel, or both (L+R). 

 

Use the second upper-left Mono/Stereo field to choose whether your 
recorded samples will be in Mono audio or Stereo audio. 

 

The Inserts field shows any enabled or disabled effects for the 
Sampler. Tap the pencil icon to open a window where you can change 
and enable or disable the effects. 

Important: These effects are applied to the audio as you record it. 
This means that the effects cannot be “removed” from the sound later. 
Learn more about how effects work in General Features > Effects. 
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Tap the Monitor button to enable or disable input monitoring. When on, the audio you hear in your 
headphones will be taken before it reaches the software, ensuring zero latency. When off, the audio you 
hear in your headphones will be taken after it is processed in the software, so there may be some 
latency, but you will hear the audio source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources. 

 

Use the Thresh slider to adjust the threshold. Alternatively, turn the bottom-most Q-Link Knob. 

When the Sampler is record-armed, the software automatically starts recording when the level of the 
incoming source exceeds this setting. If you set it too high, the recording may not start when you play 
the input source, or the start of the material you wanted to record may be missing. If you set it too low, 
the recording may start too early, before you play the external source. Set this parameter to an 
appropriate level using the level meter. 

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it. 

 

For reference, the Sample Length display shows you the length of your 
sample during the recording procedure. 

 

Tap the Arm button to record-arm the Sampler. The button will then change 
to Record. 

When the button says Record, start recording by doing either of the following: 

• Start performing so that the incoming audio level exceeds the threshold 
(Thresh). 

• Tap the Record button to start recording. 

To disarm the track instead, tap Cancel. 

 

Use the Max Length field to define the maximum sampling time. Alternatively, turn the top-most and 
second Q-Link Knobs. 

You can record up to 20 minutes and 59 seconds per sample. We recommend setting these to values 
that roughly match your estimated recording duration. 
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After you stop your recording, the Keep or Discard Sample window will appear. 

 

 
Keeping or discarding the recorded sample. 

 

Use the Edit Name field to name the new sample. Tap it and use the virtual keyboard that appears.  

 

Use the Program field to assign the new sample to a program. Select <none> if you want to save it to 
the project without assigning it to a program. 

 

Use the Assign to Pad field to assign the sample to a pad in the program. If you recorded a sample 
while a sequence was playing, this window will show a few additional options if you select a pad. See 
the next page to learn more. 

 

Use the Root Note field to set where the sample’s original pitch will be on the keyboard. 

 

To confirm your selections, tap Keep at the bottom edge of the touchscreen.  

To discard the recording and return to the Sampler, tap Discard at the bottom edge of the touchscreen. 

To play the recording, tap Play at the bottom edge of the touchscreen. 

Tip: We recommend editing your recorded sample in Sample Edit Mode. 
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You can record a sample while playing a 
sequence. This is helpful when you want to record 
a sample that is at the same tempo as a specific 
sequence. 

If you recorded a sample while a sequence was 
playing, the Keep or Discard Sample window will 
show a few additional options after you select a 
pad. 

Check the Add Event box to automatically add 
the sample to the currently playing sequence. 

Use the @ field to select where you want the event 
to start: 

• Start: The sample will be a note event at the 
start of the currently playing sequence. 

• Trigger: The sample will be as a note event 
where you began recording it in the currently 
playing sequence.  

Use the Track field to set which track will contain 
the new event. 

 

To confirm your selections, tap Keep at the 
bottom edge of the touchscreen.  

To discard the recording and return to the 
Sampler, tap Discard at the bottom edge of the 
touchscreen. 

To play the recording, tap Play at the bottom 
edge of the touchscreen. 

Tip: We recommend editing your recorded sample 
in Sample Edit Mode. 
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Pad Mute Mode 
 

Pad Mute Mode lets you easily mute pads within a program or set mute 
groups for each pad. 

 

To enter Pad Mute Mode, press Menu, and then tap Pad Mute.  

 

There are two tabs you can view in this mode: Pad Mute or Pad Group. Tap each button in the lower-left 
corner to select it. See the following Pad Mute and Pad Group sections to learn about each. 

 

Use the Program field at the top of the touchscreen to select a program. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

Time Correct lets you quantize pad mutes. This is useful when you want your mutes to line up with a 
specific time division. For example, with Time Division set to 1 Bar, your mutes will always align with 
the beginning of the measure immediately after you press the pad. 

Tap Time Division at the bottom edge of the touchscreen, and select a value from 1/16 to 2 Bars (T 
indicates a triplet-based time division).  

Tap TC at the bottom edge of the touchscreen to enable or disable the Time Correct feature. 
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Pad Mute 

 
You can mute or unmute individual sounds (on a single track) in real time by pressing the pads. This is 
useful if you want to hear a track without a particular sound or if you want to isolate specific sounds or 
combinations of sounds.  

Tip: This function is similar to, but probably more convenient than, muting pads one at a time in the grid. 

 

 
Pad Mute. 

 

To mute pads in this mode: 

1. If the Pad Mute tab in the lower-left corner is not already selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank Buttons or tap a pad bank shown on the left side of 
the touchscreen. 

3. To mute or unmute a pad’s sound, press it or tap it in the 
touchscreen. Muted pads are lit red. Unmuted pads are lit yellow. 
Unused pads do not show any sample names. 
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Pad Group 

 
The pad group feature extends the concept of pad mutes: you can mute or unmute multiple pads (on a 
single track) by pressing one pad that you have assigned to a mute group. This is useful if you want to 
hear a track without a particular group of sounds or if you want to isolate specific sounds in various 
combinations. You can create up to 16 different pad groups. 

 

 
Pad Group. 

 

To use pad groups: 

1. If the Pad Group tab in the lower-left corner is not already selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank Buttons or tap a pad bank shown on the left side of 
the touchscreen. 

3. To select a pad to add to a mute group, press it or tap it on the touchscreen. The selected pad is lit 
green. If there are other pads in the same mute group, they will flash yellow. 

4. Tap the number of the desired mute group. To remove it from a mute group, tap Off. 
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Pad Mixer 
 

In the Pad Mixer, you can set a program’s levels, stereo panning, routing, 
and effects. 

 

For drum programs, this mode shows a pad with controls for each individual pad (of 128). For keygroup 
programs, this mode has a pad for each individual keygroup (up to 128). For MIDI programs and plugin 
programs, this mode has no channel strips. 

For more information on how these programs differ, please see General Features > Programs. 

 

To enter the Pad Mixer, press Menu, and then tap Pad Mixer. 

 

 
The Pad Mixer. 
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The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of 
their functionality is identical. If a sample has been assigned to a pad, its name is displayed at the top of it. 

 

To select a pad, press its corresponding pad or tap it on the touchscreen. Alternatively, use the Pad 
field in the upper-left corner. 

 

To view more channels, use the Pad Bank Buttons. 

 

Use the Program field in the upper-left corner to select the program whose pads you want to view. 
Remember that only drum programs or keygroup programs will display properly in the Pad Mixer. 

 

Use the Track field at the top of the touchscreen to select the desired track. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

To view a specific setting on all channels, tap the Level, Pan, Mute, Send, Insert, or Route button 
on the bottom edge of the touchscreen. You can tap the Send or Insert buttons multiple times to cycle 
through the four available slots for each. 
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When a channel is selected, you can view and adjust all of its settings in 
the left side of the touchscreen rather than using the tab buttons at the 
bottom edge. 

When viewing the channel strip: 

• The first field shows the current pad number, which you can change. 

• The second field shows where the pad’s audio is routed, which you 
can change. 

• The Inserts field shows any enabled or disabled insert effects for that 
pad. Tap the pencil icon to open a window where you can change 
and enable or disable the effects. 

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To change the pad’s automation, tap the automation button to cycle 
through its three states: 

When off, the pad will ignore automation data. If you have already recorded or 
entered automation, tapping this will switch between Read (R) and Write (W) only, 
but you can override this and turn it off by pressing and holding Shift while 
tapping the button. 

Important: If you have already recorded automation and turn it off, the track will 
still use the effect and its parameter values at the point where you turned it off. 

When set to Read (R), the pad will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. 
(Think of this as a protective feature to prevent accidental changes to your 
automation while recording.) 

When set to Write (W), the pad can record automation. (If you have any Q-Link 
Knobs assigned to automatable parameters, make sure not to touch any 
accidentally while you are recording.) 

Tip: You can quickly set all pads to the same automation in XYFX Mode. See the 
XYFX Mode chapter to learn how to do this. 

• To turn direct monitoring on or off, tap the Monitor button. 

• To change the panning or level of the pad, adjust the pan knob or Level slider. 
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Levels 

 

When the Level tab is selected, use the 
Data Dial or –/+ buttons to adjust the 
level of the currently selected pad.  

The level sliders and meters in each pad 
show a visual representation of the level. 
Double-tap a pad in the touchscreen to 
open a large version of the level slider and 
meter. 

 

 

 

 

 

Panning 

 

When the Pan tab is selected, use the 
Data Dial or –/+ buttons to adjust the 
panning of the currently selected pad.  

The pan sliders in each pad show a visual 
representation of the level. Double-tap a 
pad in the touchscreen to open a large 
version of the pan knob. 
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Mute 

 

When the Mute tab is selected, mute the 
currently selected pad by doing any of the 
following: 

• Turn the Data Dial. 

• Use the –/+ buttons. 

• Tap the pad in the touchscreen. 

When a pad is muted, its M button will light red. 

 

 

Send Effects 

 

When the Send tab is selected, use the Data 
Dial or –/+ buttons to adjust the send level of 
the currently selected pad. 

The level sliders in each pad show a visual 
representation of the level. Double-tap a pad 
in the touchscreen to open a large version of 
the level slider. 

You can select up to four send effects for 
each pad. You can use various effects 
included in your MPC software as well as 
other VST and AU plugins installed on your 
computer. Tap the Send button to cycle 
through the four available slots for each. 

To learn how to use send effects, please see General Features > Effects > Send/Return Effects.  

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the 
Channel Mixer. 
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Insert Effects 

 

When the Insert tab is selected, use the Data 
Dial or –/+ buttons to adjust the insert effect 
level of the currently selected pad. 

The level sliders in each pad show a visual 
representation of the level. Double-tap a pad 
in the touchscreen to open a large version of 
the level slider. 

You can select up to four insert effects for 
each pad. You can use various effects 
included in your MPC software as well as 
other VST and AU plugins installed on your 
computer. Tap the Insert button to cycle 
through the four available slots for each. 

To learn how to use insert effects, please see General Features > Effects > Insert Effects.  

Important: 

When using keygroup insert effects, they will be applied to the entire keygroup program. This is because 
a keygroup program uses the same sound across all pads, as opposed to drum programs where each 
pad can have its own insert effect. 

If a routing is set to anything other than Program, then a program insert effect will not be applied to that 
pad or keygroup. 
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Routing 

 

When the Route tab is selected, use the 
Data Dial or –/+ buttons to select the 
output of the currently selected pad. 
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Next Sequence Mode 
 

Next Sequence Mode lets you trigger different sequences simply by playing 
the pads. This is useful for live performances, letting you change a song’s 
structure in real time. 

 

To enter Next Sequence Mode, press Menu, and then tap Next Sequence. 

 

 
Next Sequence Mode. 
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The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

The sequence playlist on the left side shows a list-style overview of all used 
sequences in your project: 

• The Sequence column shows the name of the song’s sequences. 

• The Length column shows the bar length of a sequence.  

• The BPM column shows the tempo of a sequence in beats per minute. 

The currently selected sequence is highlighted in the list. Tap a sequence in the 
list to select it. 

 

 

In Next Sequence Mode, every pad is assigned to a 
sequence, starting from Pad A01 with Sequence 1 
and ascending from there. The pads will show the 
names of their corresponding sequences. Blank 
pads correspond to sequences that are blank 
(unused). The currently selected pad will flash green. 

 

During playback, change the next sequence that will 
play by pressing the corresponding pad or tapping it 
in the touchscreen. If you do not select another 
sequence, the current sequence will repeat 
indefinitely. 
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As a sequence plays, you can use the buttons at the bottom edge of the touchscreen to change how 
playback works: 

• To switch to the currently selected sequence at the beginning of the next bar, tap Next Bar. 
This is useful if you want to switch to another sequence before the current one ends without having 
to worry about timing issues. 

• To switch to the currently selected sequence immediately, tap Sudden. The new sequence will 
start playing whether or not the current sequence is done. This is useful in live performances if you 
need to switch to the next sequence instantly at a certain cue. 

• To delete the currently selected sequence from the sequence playlist, tap Clear. This option is 
available only if that sequence is not playing at that moment. 

• To repeat the current sequence indefinitely and temporarily ignore pad presses, tap Hold. To 
return to normal operation, tap it again. This is useful if you want to select other pads without 
selecting them to play next. 

 

While not playing, tap Copy to Song to copy the sequence playlist to a song.  

In the Copy to Song window that appears, select a song, and then tap Do It to continue or Close to 
cancel. 

To read more about Song Mode, please see the Song Mode chapter. 
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Program Edit Mode 

 

Program Edit Mode contains all parameters for editing your Programs. 

 

For drum programs, this mode includes the parameters of four layers as well as all synthesis parameters 
and insert effect settings. See the Drum Programs section to learn more. 

For keygroup programs, this mode requires you to use the software window rather than the 
touchscreen. Keygroup programs have slightly more parameters than drum programs. See the 
Keygroup Programs section to learn more. 

For plugin programs or MIDI programs, skip to Plugin Programs and MIDI Programs to learn more. 

For more general information on the differences between these four kinds of programs, please see 
General Features > Programs. 

 

To enter Program Edit Mode, press Menu, and then tap Program Edit. 

 

 
The Samples tab in Program Edit Mode. 
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Program Edit Mode lets you edit the parameters for each pad. 

To select a pad, press it. Its parameters will appear on the screen immediately. 

To view a specific tab of parameters, tap the Master, Samples, Pan Velocity, Filter Env, LFO 
Modulation, or Effects button on the bottom edge of the touchscreen. You can tap the Samples button 
multiple times to cycle through its four available sections. 

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop position is the same as the 
pad start (as determined in the third and fourth Samples tabs). When off, the loop position is 
independent from the pad start. 

 

Drum Programs 

 

Tap the icon in the upper-right corner to open the Edit Zones 
window, which is a feature for drum programs only. This 
window displays an overview of any selected pads. Use the 
Mode selector to set how the selected pads will be edited: 

• Current: Only the currently selected pad can be edited.  

• Multiple: All selected pads can be edited simultaneously.  

• All: All pads can be edited simultaneously. 

Tip: You can immediately select multiple pads while on any 
tab in Program Edit Mode (regardless of the current Edit 
Zones setting) by pressing and holding the Shift button and 
pressing each desired pad. The Edit Zones setting will 
automatically change to Multiple. 
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Master 

In the Master tab, you can set the playback mode and tuning for the overall Program. 

 

 
The Master tab for a drum program. 

 

Polyphony sets the playback mode for the program’s pads. In Mono Mode, only one pad will sound at a 
time. If a pad is played while another (or the same one) is still playing its sample(s), the new pad will 
immediately mute all other currently playing pads in that program. In Poly Mode, several pads can be 
triggered at the same time (limited only by the total number of voices available). 

 

Semi lets you transpose the selected program up to 12 semitones up or down. 

 

Fine provides fine-tuning of the program by fractions of a semitone up or down. 



                 

 
201 

 

 

The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad 
only. This function is useful for triggering a stack of sounds (e.g., layered bass drums). Use each Pad 
field to select the desired pad. 

 

The Mute Targets tab lets you select up to four pads for the currently selected pad. When the currently 
selected pad is played, it will immediately silence its mute targets. Use each Pad field to select the 
desired mute target. 

Tips: 

• This feature is useful for programming realistic hi-hats, especially if only the open or closed hat 
should be heard. 

• This feature is similar to the mute group feature, available for both drum programs and keygroup 
programs. 
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Samples 

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has 
identical, independently assignable parameters. 

Tap the Samples button to cycle through its four available sections.  

 

 
The first Samples tab for a drum program. 

 

Use the Sample field to select the sample file for that layer. Remember that the sample has to be loaded 
into the project’s sample pool beforehand. For information on how to load samples into a project, please 
see the Browser chapter. 

 

Semi lets you transpose the selected layer 12 up to semitones up or down. 

 
Fine provides fine-tuning of each layer by fractions of a semitone. 

 
Level lets you adjust the each layer’s volume, letting you control the “balance” of the samples assigned 
to the pad. 
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Important: The parameters on the second, third, and fourth Samples tabs work in conjunction with 
Chop Mode (in Sample Edit Mode). Here’s how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, 
you can convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample 
remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see 
that the pad/layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice 
number in the original sample. Playing that pad will cause it to refer to that slice marker like a 
“bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have 
to clutter your Project with a new sample for every slice (though you can still use this earlier method, if 
you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The 
difference is that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down 
menus set to Pad (instead of the slice number), and the Pad Start and Pad End points will correspond 
to the slice markers in the original sample. 

 

 
The second Samples tab for a drum program. 



                 

 
204 

 

 

Use the Slice field to select what part(s) of the sample will play: 

• All: The entire sample will play. 

• Pad: The sample will play from the Pad Start position to the Pad End position, described below. 
This also lets you activate Pad Loop. 

• Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play 
when you trigger the pad. 

 

Use the Direction selector to select in which direction the sample will play: 

• Fwd: The sample will play in the normal forward direction. 

• Rev: The sample will play in reverse. 

 

Use the Offset slider to determine a time offset for the sample’s playback.  

• Positive values (right of center): When the pad is played, playback will start immediately but at a 
later point in the sample specified by the offset value.  

• Negative values (left of center): When the pad is played, playback will be delayed by the amount 
specified by the offset value. 
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The third Samples tab for a drum program. 

 

Use the Pad Start slider to determine the position (in samples) where the pad’s playback will start. The 
minimum value is 0, and the maximum value is the Pad End value. 

Note: When Loop Lock is on, the loop position (as determined in the fourth Samples tab) is the same as 
the pad start. When off, the loop position is independent from the pad start. 
 

Use the Pad End slider to determine the position (in samples) where the pad’s playback will stop. The 
minimum value is the Pad Start value, and the maximum value is the sample’s total length (in samples). 
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The fourth Samples tab for a drum program. 

 

Use the Pad Loop button to enable or disable Pad Loop. When enabled, you can hold down the pad to 
cause that sample to repeat from the Loop Position (Loop Pos) to the end of the sample. Release the 
pad to stop the repeating playback. 

Important: For Pad Loop to work, you must set Sample Play to Note On instead of One Shot. 

 

Use the Loop Position slider to determine the position (in samples) where the pad’s playback will repeat 
when Pad Loop is activated. 

Note: When Loop Lock is on, the loop position is the same as the pad start (as determined in the third 
Samples tab). When off, the loop position is independent from the pad start. 
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Pan Velocity 

 

 
The Pan Velocity tab of a drum program. 

 

Use the Pan knob to adjust the stereo placement of the respective layer. 

 
Use the Vel Start and Vel End knobs to define the velocity range of each layer. Set the values by doing 
one of the following: 

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the 
respectve pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity 
levels. By assigning several samples of one instrument, you can create a realistic-sounding “multi-
sample” by adjusting the velocity ranges of each layer accordingly. (For example, you may have three 
samples of a drum hit with low force, medium force, and high force. You can set each sample to a layer 
and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities 
trigger the medium-force sample, and only high velocities trigger the high-force sample.) 
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Filter Envelope 

 

 
The Filter Envelope tab of a drum program. 

 

 

Use the Type field to select a filter for the selected pad. See Appendix > Glossary > Filter for an 
explanation of the available filter types. 

 

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center 
frequency for band-pass and band-stop filter types. 

 

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound 
will result in a strong audible boost around the cutoff frequency.  
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Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher 
settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle 
changes of the filter Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay 
values as well as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter 
opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, 
on the other hand, can sound much more “alive” with low Env settings and a high Atk value, resulting in 
a slight fade-in of the higher frequencies.  

 

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other 
parameters:  

• Vel>Sta (VelocityStart) sets how much velocity is needed (for a triggered pad) to modulate the 
sample startpoint. 

• Vel>Atk (VelocityAttack) sets how much velocity is needed (for a triggered pad) to modulate the 
Attack phase for the Amp envelope.  

• Vel>Env (VelocityEnvelope) enables velocity information to control the amount of the filter 
envelope’s effect on the cutoff frequency. 

• Vel>Flt (VelocityFilter) uses the velocity of a pad to modulate the cutoff frequency directly. 

 

The Filter Envelope controls affect the filter frequency. Use the fields or “handles” of the envelope to 
shape the envelope or time-variant modulation output. Adjust envelope’s influence on the filter 
frequency with the Env knob. See the later Anatomy of an Envelope section to learn about the 
envelope parameters. 

 

The Amp Envelope controls affect level changes over time. Use the fields or “handles” of the envelope 
to shape the envelope or time-variant modulation output. Adjust envelope’s influence on the filter 
frequency with the Env knob. See the later Anatomy of an Envelope section to learn about the 
envelope parameters. 
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LFO Modulation 

 

 

The LFO Modulation tab of a drum program. 
 

The Modes controls let you set the behavior for each pad’s samples in a drum program. 

 

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads 
assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in 
that mute group. 

Tip: This feature is useful for programming realistic hi-hats, especially if only the open or closed hat 
should be heard. 
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Use the Layer Play selector to determine how multiple samples assigned to the same pad are played: 

• Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the 
samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

• Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.  

• Random (Ran): Each time the pad is played, it will play one its layer’s samples at random.  

 

Use the Sample Play selector to determine how much of the sample is played.  

• One-Shot: The entire sample will play from start to end. Use this when you want to play short 
sounds. 

• Note-On: The sample will play only as long as the pad is held. This is better for longer samples so 
you can control a sound’s duration by pressing and holding its corresponding pad. 

 

Use the Pad Polyphony selector to determine how the pad’s sound behaves when multiple hits are 
registered:  

• Mono: Only one pad will sound at a time. If a pad is played while another (or the same one) is still 
playing its sample(s), the new pad will immediately mute all other currently playing pads in that 
program. 

• Poly: Several pads can be triggered at the same time (limited only by the total number of voices 
available). 

 

The Velocity Sensitivity controls determine how much the velocity affects the sound’s Pitch, Filter 
Envelope Attack, Volume (Amp) and Panning (Pan). 

When you press a pad softly, only minimal modulation is applied. When you press it harder, the 
modulation amount also gets stronger depending on the setting of the corresponding knob. 
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A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape 
which can be used for modulation purposes. 

 

Use the Wave field to select the LFO waveform type: 

• Triangle (best suited for smooth modulations) 

• Sine (best suited for smooth modulations) 

• Square (interesting results with hard-panning modulations) 

• Saw (can generate interesting filter or volume changes) 

• Saw Down (can generate interesting filter or volume changes) 

• Noise (generates random values and glides) 

• S&H (samples a random value and holds it until the next value is generated) 

 

Use the Rate field to determine the LFO frequency when Sync is on. At lower values, it might take some 
time for the LFO to complete a cycle, while higher values will come closer to audible range. 

 

Use the Sync field to set whether the LFO’s rate is synchronized with the tempo. When None is 
selected, Sync is off. 

 

Use the Destinations sliders to determine how much the LFO affects the Pitch, Filter Cutoff frequency 
(Filter), Volume (Amp) and Panning (Pan). 
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Effects 

 

 
The Effects tab of a drum program. 

 

You can select up to four insert effects for each pad. You can use various effects included in your MPC 
software as well as other VST and AU plugins installed on your computer. 

To learn how to use insert effects in the MPC software, please see General Features > Effects > Insert 
Effects. 

 

To add an effect: 

1. Double-tap the desired Inserts slot. A list of effects will appear. 

2. Swipe up or down to move through the list. 

You can tap the Type and Manufacturer buttons to sort your effects by those categories. 

3. To load an effect, double-tap it, or tap Select. 

To close the list, tap Close. 
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To remove an effect from its slot, tap the trash can icon.  

 

To enable or disable the effect, tap the On/Off button for the slot. 

 

To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner. 

 

To adjust the effect’s parameters, tap the pencil icon. Use the sliders to set the value of each 
parameter. These values affect only this instance of the effect; insert effects are not global.  

 

 

Editing an effect’s parameters. 
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The audio of the pad will be routed to send effects (if you have any loaded) at their designated send 
levels. The send effects will then return the audio at the designated return levels. 

Use the Send knobs to set the volume level of the signal the pad will route to each send effect. 

You can select up to four send effects for each pad. You can use various effects included in your MPC 
software as well as other VST and AU plugins installed on your computer. 

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the 
Channel Mixer. See Channel Mixer > Return Mixer to learn more how to do this. To learn about MPC 
send effects in general, please see General Features > Effects > Send/Return Effects. 
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Keygroup Programs 

 

For the current release, Program Edit Mode is available in the touchscreen for drum programs, plugin 
programs, and MIDI programs. For keygroup programs, use the software window. 

 

This part of the chapter describes how to use the software window to use Program Edit Mode with a 
keygroup program. 

 

 
The Program Edit Mode sections for a keygroup program in the software window. 
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Master 

 

In the Master section, you can set the playback mode and tuning for the 
overall program as well as the number of total key groups. 

 

Number of KG (keygroups) lets you create up to 128 keygroups within a 
keygroup program. This is very useful when working with multi-samples. For example, if you want to 
create a realistic piano, you can use different keygroups (e.g., 88 for a grand piano) with every keygroup 
containing its own sampled note (with up to 4 possible velocity layers). 

Use KG Select in the Key Group section to edit a keygroup—or all keygroups simultaneously. 

 

The Polyphony drop-down menu sets the playback mode for the program. When set to Mono, only one 
pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample(s), 
the new pad will immediately mute all other currently playing pads in that program. When set to Poly, 
several pads can be triggered at the same time, limited only by the total number of voices available. 

 

Semi lets you transpose the selected program up to 12 semitones up or down. 

 

Fine provides fine-tuning of the program by fractions of a semitone up or down. 

 

Trans transposes incoming notes; it does not change the pitch of a sample. 
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Click the Automation button in the upper-right corner to switch the program’s automation between Off, 
Read (R), and Write (W). 

• When set to Off, the program will ignore automation data. If you have already recorded or 
entered automation, clicking the button will switch between Read (R) and Write (W) only, 
but you can override this and set it to Off by pressing and holding Shift on your computer 
keyboard while clicking the button. 

• When set to Read (R), the program will read automation data but will not record any 
additional automation over it, though you can still manually edit and enter automation. 
(Think of this as a protective feature to prevent accidental changes to your automation while 
recording.) 

• When set to Write (W), the Program can record automation. If you have any Q-Link Knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording. 

Tip: Set all programs to the same automation setting by clicking the Global Automation button in 
the upper-right corner of the software window. 
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Key Group  

 

Here, you can set additional keygroup program parameters.  

Tips: 

• The loaded sample’s root key will determine where the original pitch is 
located. For example, if the root key is C3, the original sample is located 
at Pad D13. 

• In a keygroup program, you can also use the pads on your MPC 
hardware to play samples assigned to keygroups. The 128 pads (A01 to 
H16) correspond to MIDI notes from from note number 0 to 127, allowing 
you to easily play a melody with a single sample over a wide range. 

 

KG Select (Keygroup Select) lets you select a specific keygroup for editing. This parameter works in 
conjunction with the Number of KG (keygroups) parameter in the Edit Layers section, which lets you 
create up to 128 keygroups within one keygroup program. A default keygroup program contains only 
one single keygroup. When you have created more than one keygroup with Number of KG, use KG 
Select to select any keygroup for editing. All selects all available keygroups of a keygroup program for 
simultaneous editing. 

 

Key Track allows you to switch a sample’s automatic transposition on or off. If this is off, you will always 
hear the same pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard. 

 

Level controls the overall volume level of the loaded sample(s). 

 

Pan controls the overall panning of the loaded sample(s) in the stereo field. 

 

Note Range lets you restrict the key range used for a sample’s playback. Only notes with a key number 
higher or equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo 
and Hi are also shown in the virtual keyboard in the Edit Layers section. 

Tip: Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano. 



                 

 
220 

 

 

Semi lets you transpose the sample 12 semitones up or down, while Fine provides fine-tuning of each 
layer by fractions of a semitone up or down.  

Tip: The Edit Layers section has some parameters similar to those in this section (Level, Pan, Semi, 
Fine, Note Range). Remember that Key Group parameters control the overall settings for the sample, 
while Edit Layer parameters control the settings for each layer (up to 4). 
 

KG Poly (keygroup polyphony) lets you set the playback mode for the currently selected keygroup (in 
the KG Select menu). When set to Mono, only one pad will sound at a time. If a pad is played while 
another (or the same one) is still playing its sample(s), the new pad will immediately mute all other 
currently playing pads in that program. When set to Poly, several pads can be triggered at the same 
time, limited only by the total number of voices available. 

 

Mute Groups let you assign the selected pad to one of the 32 available groups. When pads assigned to 
the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute 
group. 

 

Layer Play determines how multiple samples assigned to the same pad are played: 

• Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the 
samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc. 

• Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.  

• Random (Ran): Each time the pad is played, it will play one its layer’s samples at random.  

 

Sample Play determines how much of the sample is played: 

• One-Shot: The entire sample will play from start to end. Use this when you want to play short 
sounds. 

• Note-On: The sample will play only as long as the pad is held. This is better for longer samples so 
you can control a sound’s duration by pressing and holding its corresponding pad. 
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Layers 
 

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has 
separate parameters. 

 

 

 

Click the Sample drop-down menu to select the sample file for that layer. Remember that the sample 
has to be loaded into the project’s sample pool beforehand. 

 

Semi lets you transpose the selected layer 12 up to semitones up or down. 

 
Fine provides fine-tuning of each layer by fractions of a semitone. 

 
Level lets you adjust the each layer’s volume, letting you control the “balance” of the samples assigned 
to the pad. 
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Important: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, 
you can convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample 
remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that 
the pad/layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice number 
in the original sample. Playing that pad will cause it to refer to that slice marker like a “bookmark” instead 
of creating an entirely new sample of that slice. This means that you no longer have to clutter your project 
with a new sample for every slice (though you can still use this earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The 
difference is that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down 
menus set to Pad (instead of the slice number), and the Pad Start and Pad End points will correspond 
to the slice markers in the original sample. 

 

Use the Slice drop-down menu to select what part(s) of the sample will play: 

• All: The entire sample will play. 

• Pad: The sample will play from the Pad Start position to the Pad End 
position, described below. This also lets you activate Pad Loop. 

• Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can 
select which slice will play when you trigger the pad. 

Use the Dir drop-down menu to select in which direction the sample will play: 

• Fwd: The sample will play in the normal forward direction. 

• Rev: The sample will play in reverse. 

Use the Offset field to determine a time offset for the sample’s playback. 
Alternatively, double-click the field and type in a number. 

• Positive values (right of center): When the pad is played, playback will start 
immediately but at a later point in the sample specified by the offset value.  

• Negative values (left of center): When the pad is played, playback will be delayed by the amount 
specified by the offset value. 
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• Pad Start: Click and drag this field up or down to 
determine the position (in samples) where the pad’s 
playback will start. Alternatively, double-click the 
field and type in a number. The minimum value is 0, 
and the maximum value is the Pad End value. 

• Pad End: Click and drag this field up or down to 
determine the position (in samples) where the pad’s 
playback will stop. Alternatively, double-click the 
field and type in a number. The minimum value is the 
Pad Start value, and the maximum value is the 
sample’s total length (in samples). 

• Pad Loop: Click this box to activate or deactivate 
Pad Loop. When activated, you can hold down the 
pad to cause that sample to repeat from the Loop 
Position (Loop Pos) to the end of the sample. 
Release the pad to stop the repeating playback. 

Important: For Pad Loop to work, you must set 
Sample Play (in the Key Group section) to Note On 
instead of One Shot. 

• Loop Pos (position): Click and drag this field up or 
down to determine the position (in samples) where 
the pad’s playback will repeat when Pad Loop is 
activated. Alternatively, double-click the field and 
type in a number. 
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Pan adjusts the stereo placement of the respective layer. 

 

Velocity defines the velocity range of each layer. To set the values, click 
in the segment chain on the right side of the Layer area and drag its left 
and right ends to the desired values. 

A range from 0 to 127 lets the layer respond to the entire velocity range 
which is input from the respective pad while, for example, a range from 
100 to 127 lets the layer respond only to higher velocity levels. By 
assigning several samples of one instrument, you can create a realistic-
sounding “multi-sample” by adjusting the velocity ranges of each layer 
accordingly. (For example, you may have three samples of a drum hit with 
low force, medium force, and high force. You can set each sample to a 
layer and set the Velocity ranges so only low velocities trigger the low-
force sample, only mid-range velocities trigger the medium-force sample, 
and only high velocities trigger the high-force sample.) 

 

Use the Root Note field to set the root key of each loaded sample. 

 

The virtual keyboard shows the Note Range, which can be set in the Key Group section. You can also 
drag the left or right range with your computer mouse. 
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Filter 

 

The Filter Type drop-down menu lets you select a filter for the selected pad. 
See Appendix > Glossary > Filter for an explanation of the available filter 
types. 

 

Cutoff controls the cutoff frequency for low-pass and high-pass filter types or 
the center frequency for band-pass and band-stop filter types. 

 

Reso controls the resonance/emphasis of the frequencies around the cutoff 
point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values 
higher than 80, the sound will result in a strong audible boost around the 
cutoff frequency.  

 

Env determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings 
will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes 
of the filter Cutoff over time. 

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay 
values as well as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter 
opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, 
on the other hand, can sound much more “alive” with low Env settings and a high Atk value, resulting in 
a slight fade-in of the higher frequencies.  
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The Modulation Sources set the amount for different modulation. The following modulation sources are 
available:  

• Kbd>Flt (KeyboardFilter) sets how much aftertouch data (from a pad) is needed to modulate the 
cutoff frequency.  

• V>Atk (VelocityAttack) sets how much velocity is needed (for a triggered pad) to modulate the 
Attack phase for the Amp envelope.  

• V>Env (VelocityEnvelope) enables velocity information to control the amount of the filter 
envelope’s effect on the cutoff frequency. 

• V>Flt (VelocityFilter) uses the velocity of a pad to modulate the cutoff frequency directly. 

 

The Filter Envelope controls affect the filter frequency. The knobs control the envelope shape or time-
variant modulation output. Adjust envelope’s influence on the filter frequency with the Env knob. See the 
later Anatomy of an Envelope section to learn about the envelope parameters. 

 

The Amp Envelope controls affect level changes over time. The knobs control the envelope shape or 
time-variant modulation of a sound’s level. See the later Anatomy of an Envelope section to learn about 
the envelope parameters. 
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Velocity Sensitivity 
 

Here, you can set how much velocity affects various sound parameters: 
Pitch, Filter Envelope Attack (Atk), Volume (Amp) and Panning (Pan). 

When you press a pad softly, only minimal modulation is applied. When 
you press it harder, the modulation amount also gets stronger depending 
on the setting of the corresponding knob. 
 

 

LFO 
 

A low-frequency oscillator (LFO) generates a periodic waveform with an 
adjustable frequency and shape which can be used for modulation purposes. 
 

Wave sets the LFO waveform. Click the drop-down menu and select one 
of the following:  

• Sine (best suited for smooth modulations) 

• Triangle (best suited for smooth modulations) 

• S&H (samples a random value and holds it until the next value is generated) 

• Saw (can generate interesting filter or volume changes) 

• Saw Down (can generate interesting filter or volume changes) 

• Square (interesting results with hard-panning modulations) 

• Noise (generates random values and glides) 
 

Rate determines the LFO frequency when Sync is on. At lower values, it might take some time for the 
LFO to complete a cycle, while higher values will come closer to audible range.  
 

Sync will synchronize the LFO to the tempo, based on the rate selected in the drop-down menu. When 
None is selected, Sync is off.  
 

The LFO modulation Destinations determine the amount of effect of the LFO has on Pitch, Filter Cutoff 
frequency (Filter), Volume (Amp) and Panning (Pan). 
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Controller Mod 

 

The Controller Mod section determines the influence of additional 
play controllers on various sound parameters.  

Important: To use these parameters, make sure that a connected 
MIDI device can send pitch bend messages as well as aftertouch and 
modulation wheel data. 

 

Pitch Bend sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel. 

 

Whl>LFO (WheelLFO) determines how much a connected MIDI keyboard’s modulation wheel affects 
the LFO intensity. 

 

Aft>Filt (AftertouchFilter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data 
affects the filter cutoff. 
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Insert Effects 

 

You can select up to four insert effects for each pad or keygroup or for 
the entire program. You can use various effects included in your MPC 
software as well as other VST and AU plugins installed on your 
computer. 

To learn how to use insert effects in the MPC software, please see 
General Features > Effects > Insert Effects.  

Important: 

When using keygroup insert effects, they will be applied to the entire 
keygroup program. This is because a keygroup program uses the same 
sound across all pads, as opposed to drum programs where each pad 
can have its own insert effect. 

If the Keygroup Audio Route menu is set to anything other than 
Program, then program insert effect will not be applied to that pad or 
keygroup. 

 
 

Keygroup Audio Route 

 

This menu lets you select where the audio for currently selected pad or 
keygroup will be routed. 

Click the drop-down menu, and select any one of the following outputs: 
Program, Submix 1–8, or Out 1,2–Out 31,32.  

This will determine where the audio of the entire program is sent. This is because a keygroup program 
uses the same sound across all pads, as opposed to drum programs where each pad can have its own 
insert effect. 

Important: If the Keygroup Audio Route menu is set to anything other than Program, then Program 
insert effect will not be applied to that pad. 
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Plugin Programs 

 

For plugin programs, you will see an overview of all available parameters of your loaded virtual 
instrument with a slider for each. 

 

 

Program Edit Mode for a plugin program. 
 

Use the sliders to set the value of each parameter. 

 

Use the 6 tabs at the bottom edge of the touchscreen to access the available parameters. 
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MIDI Programs 

 

For MIDI programs, you will see an overview of all available MIDI CCs with a slider for each. 
 

 

Program Edit Mode for a MIDI program. 
 

Use the sliders to set the value of each parameter. 

 

Use the 6 tabs at the bottom edge of the touchscreen to access the available parameters. 

 

To assign a parameter to one of the controls, use the software window: Click the drop-down menu 
above the corresponding knob, and select the desired MIDI CC number. 
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Anatomy of an Envelope 

 

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings 
of a sound over a given period of time. 

 

For drum programs, use the AD/AHDS selector to select an AD or AHDS envelope. 

Keygroup programs always use AHDS envelopes. 

 

 

 

With AHDS envelopes, the following happens when you trigger a sample: 

1. Within the period of time you have defined with the Attack (Atk) parameter, the sample volume rises 
to its maximum value. 

2. The sample’s maximum volume will be maintained during the Hold phase. 

3. During the Decay phase, the sample’s volume will gradually drop to the sustain level. 

4. The sample’s volume will stay at the sustain level (Sust) until the pad is released.  
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With AD envelopes, the following happens when you trigger a sample: 

1. Within the period of time you have defined with the Attack (Atk) parameter, the sample volume rises 
to its maximum value. 

2. The sample’s maximum volume will be maintained until its Decay phase, when the sample’s volume 
will gradually drop to zero over the set duration. Click the Type drop-down menu to select how the 
decay functions: 

• Decay From Start: The volume will start decreasing immediately after reaching its maximum level. 

• Decay From End: The maximum volume will be maintained for a hold phase until it reaches the 
decay phase. 

 



                 

 
234 

 

 
Looper 

 

The Looper lets you record and overdub audio in real time—a great tool for 
live performance as well as spontaneous moments in the studio. You can 
export the loop as a sample to use in your project. 

 

To open the Looper, press Menu, and then tap Looper. 

 

 

Recording in the Looper. 
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To get started using the Looper: 

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors 
before you make any connections to avoid “pops” or feedback. 

2. Connect a microphone, audio player, etc. to the input(s) of your MPC Touch.  

3. Turn the Rec Gain knob to set the input level while speaking into the microphone. You should now 
see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be 
“peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Tap the Record To selector so Overdub is selected. 

6. Tap the Rec/Record button in the lower-right corner to record-arm the Looper. 

7. Speak/sing into the microphone or play your audio source. The Looper will start recording 
immediately when the input level reaches the threshold value. Alternatively, tap /Play at the bottom 
edge of the touchscreen to manually start recording. 

Each time the Looper repeats, its contents are being overdubbed—a new layer of audio will be 
added each time you let the Looper repeat as it records.  

Tip: You can record a loop while playing a sequence in the background for reference. 

8. To stop recording, tap /Play at the bottom edge of the touchscreen.  

To export your loop as a sample, tap Export to open the Keep or Discard Sample window. 

To clear the contents of the Looper, tap Clear. 

 

Continue reading this chapter to learn how to use the Looper in different cases. 
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The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

The upper-left Input Source field defines whether you are going to 
record (External L) channel, right (External R) channel, or both 
(External L+R). 

 

Use the second upper-left Mono/Stereo field to choose whether 
your recorded samples will be in Mono audio or Stereo audio. 

 

The Inserts field shows any enabled or disabled effects for the 
Looper. Tap the pencil icon to open a window where you can change 
and enable or disable the effects. 

Important: These effects are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. 
Learn more about how effects work in General Features > Effects. 

 

Tap the Monitor button to enable or disable input monitoring. When 
on, the audio you hear in your headphones will be taken before it 
reaches the software, ensuring zero latency. When off, the audio you 
hear in your headphones will be taken after it is processed in the 
software, so there may be some latency, but you will hear the audio 
source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, 
reduce the level of the audio sources. 
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Use the Thresh slider to adjust the threshold. Alternatively, turn the bottom-most Q-Link Knob. 

When the Looper is record-armed, the software automatically starts recording when the level of the 
incoming source exceeds this setting. If you set it too high, the recording may not start when you play 
the input source, or the start of the material you wanted to record may be missing. If you set it too low, 
the recording may start too early, before you play the external source. Set this parameter to an 
appropriate level using the level meter. 

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it. 

 

Use the Bars field to define the length of your loop. Regardless of how much or how little audio you 
record, this is how long your loop will be. 

 

Use the Sync button to sync or un-sync the looper with sequence playback. When on, the Looper will 
stay in step with your current sequence. When you play or record into the Looper, it will wait until the 
sequence starts playing Bar 1 to start. 

 

Use the Record To selector to determine the loop recording behavior: 

• Play: Before recording, you must first tap the /Play button on the touchscreen, which will start 
playing the Looper. 

• Overdub: Before recording, you must first tap the Rec/Record button in the lower-right corner to 
record-arm the Looper.   

 

Use the Output Gain slider to set the output signal level of the Looper. 
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To record with the Looper: 

Important: To record without erasing any audio you’ve 
already recorded in the loop, use the Overdub button. 
To overwrite the audio you’ve already recorded, use the 
Replace button. 

• If Record To is set to Play: 

To start recording, tap the Replace or Overdub 
button as the loop is playing. The Looper will 
start recording immediately. 

To stop recording, tap the Replace or Overdub 
button. The Looper will stop recording but 
continue playing. 

To stop playback and recording, tap the /Play 
button. 

• If Record To is set to Overdub: 

To start recording, tap the /Play button on the 
touchscreen. 

If Sync is off, you can also speak/sing into the 
microphone or play your audio source so that 
the input level reaches the threshold value. 

If Sync is on, you can also press the Play or 
Play Start button to start playing a sequence; 
recording will start when the sequence starts 
on Bar 1.  

To stop recording, tap Overdub. The Looper will 
stop recording but continue playing. 

To stop playback and recording, tap the /Play 
button, or press stop to stop sequence playback. 
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To play or stop the loop (without recording), tap the /Play button on the touchscreen. 

 

To reverse loop playback, tap Reverse. If Sync is on, playback will reverse once the Looper’s 
playhead reaches the end of the loop. If Sync is off, playback will reverse immediately. 

 

To erase the loop immediately, tap Clear. 

 

To export the loop as a sample: 

1. Tap Export to open the Export Loop as a Sample window. 

2. Tap the Edit Name field and use the virtual keyboard that appears to enter a new name. 

3. Optional: Use the Program field to assign it directly to a program. To ignore this feature, select <none>. 

4. Optional: If you’re assigning the sample to a program, use the Assign to Pad field to assign it to a 
specific pad. Alternatively, just press the pad. To ignore this feature, select Off. 

5. Use the Root Note field to select the sample’s root note. 

6. Optional: Tap and hold your finger on Play to play the sample. 

7. Tap Do It to confirm your choice, or Cancel to cancel. 

 

When your loop is done exporting, it will be added to your project’s sample pool with the name you 
entered and will be assigned to the program and pad you selected (if any). 
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Track Mute Mode 
 

Track Mute Mode lets you easily mute tracks within a sequence or set 
mute groups for each track.  

 

To enter Track Mute Mode, press Menu, and then tap Track Mute.  

 

There are two tabs you can view in this mode: Track Mute or Track Group. Tap each button in the lower-
left corner to select it. See the following Track Mute and Track Group sections to learn about each. 

 

Use the Sequence field at the top of the touchscreen to select a sequence. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ 
buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, 
and Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

Time Correct lets you quantize track mutes. This is useful when you want your mutes to line up with a 
specific time division. For example, with Time Division set to 1 Bar, your mutes will always align with 
the beginning of the measure immediately after you press the pad. 

Tap Time Division at the bottom edge of the touchscreen, and select a value from 1/16 to 2 Bars (T 
indicates a triplet-based time division).  

Tap TC at the bottom edge of the touchscreen to enable or disable the Time Correct feature. 
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Track Mute 

 
This is useful if you want to hear a sequence without a particular track (e.g., muting your keyboard track 
to focus on the bass) or if you want to isolate specific sounds or combinations of sounds that are 
separated by track.  

Tip: This function is similar to, but more convenient than, muting tracks one at a time in Track View. 

 

 
Track Mute. 

 

To mute tracks in this mode: 

1. If the Track Mute tab in the lower-left corner is not already selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank Buttons or tap a pad bank shown on the left side of 
the touchscreen. 

3. To mute or unmute a track, press the corresponding pad or tap it in 
the touchscreen. Pads for muted tracks are lit red. Pads for unmuted 
tracks are lit yellow. Pads for unused tracks do not show any 
information. 
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Track Group 

 
The track group feature extends the concept of track mutes: you can mute or unmute multiple tracks (in 
a single sequence) by pressing one pad that you have assigned to a track group. This is useful if you 
want to hear a track without a particular group of sounds or if you want to isolate specific sounds in 
various combinations. You can create up to 16 different track groups. 

 

 
Track Group. 

 

To use track groups: 

1. If the Pad Group tab in the lower-left corner is not already selected, tap it. 

2. Select the desired pad bank. Use the Pad Bank Buttons or tap a pad bank shown on the left side of 
the touchscreen. 

3. To select a track to add to a mute group, press the corresponding pad or tap it on the touchscreen. 
The pad for the selected track is lit green. If there are other pads for tracks in the same mute group, 
they will flash yellow. 

4. Tap the number of the desired mute group. To remove it from a mute group, tap Off. 
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Channel Mixer 
 

In the Channel Mixer, you can set levels, stereo panning, and other settings 
for your tracks, programs, returns, submixes, and masters. 

 

To open the Channel Mixer, press Menu, and then tap Channel Mixer. 

 

 

The Channel Mixer. 
 

The Channel Mixer works like an audio mixer with various settings for each channel, shown in a 4x4 
array. Their functionality is mostly identical. The name of the track, program, or channel displayed at the 
top of it. 

 

Use the Mixer field at the top of the touchscreen to select which mixer you want to view: Tracks, 
Programs, Returns, Submixes, or Masters. Each page has slight differences, described in each section.  
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The following controls and tabs are available for all of the mixers (or most of them, as indicated): 

To select a channel, press its corresponding pad or tap it on the touchscreen. Alternatively, use the 
field in the upper-left corner. 

To view more channels (while viewing tracks of programs), use the –/+ buttons at the top of the 
touchscreen or the Pad Bank Buttons. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

Levels 

When the Level tab is selected, use the Data Dial or –/+ buttons to adjust the level of the currently 
selected track, program, return, submix, or master. 

The level sliders and meters in each pad show a visual representation of the level. Double-tap a pad in 
the touchscreen to open a large version of the level slider and meter. 

 

Panning 

When the Pan tab is selected, use the Data Dial or –/+ buttons to adjust the panning of the currently 
selected track, program, return, submix, or master. 

The pan sliders in each pad show a visual representation of the level. Double-tap a pad in the 
touchscreen to open a large version of the pan knob. 
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Mute 

When the Mute tab is selected, mute the currently selected track, program, return, submix, or master by 
doing any of the following: 

• Turn the Data Dial. 

• Use the –/+ buttons. 

• Press the pad. 

• Tap the pad in the touchscreen. 

When a track, program, return, submix, or master is muted, its M button will light red. 

 

Send Levels (Programs and Submixes only) 

When the Send tab is selected, use the Data Dial or –/+ buttons to adjust the send level of the currently 
selected program or submix. 

The level sliders in each pad show a visual representation of the level. Double-tap a pad in the 
touchscreen to open a large version of the level slider. 

You can use up to four send channels. Tap the Send button to cycle through the four available slots for each. 

To learn how to use send effects, please see General Features > Effects > Send/Return Effects. 

Important: When using send channels, make sure you have already loaded an effect to it using the 
return mixer. See Return Mixer below to learn how to do this. 
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Insert Effects (Programs, Returns, Submixes, and Masters only) 

When the Insert tab is selected, use the Data Dial or –/+ buttons to adjust the insert effect level of the 
currently selected program, return, submix, or master. 

The level sliders in each pad show a visual representation of the level. Double-tap a pad in the 
touchscreen to open a large version of the level slider. 

You can select up to four insert effects for each program, return, submix, or master. You can use various 
effects included in your MPC software as well as other VST and AU plugins installed on your computer. 
Tap the Insert button to cycle through the four available slots for each. 

To learn how to use insert effects, please see General Features > Effects > Insert Effects. 

 

Routing (Programs, Returns, and Submixes only) 

When the Route tab is selected, use the Data Dial or –/+ buttons to select the output of the currently 
selected program, return, or submix. 
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Track Mixer 

 

The track mixer shows levels, panning, 
and mute states for all used tracks. 

 

To view a specific setting on all tracks, 
tap the Level, Pan, or Mute button on 
the bottom edge of the touchscreen. 

 

 

 

 

 

 

When a track is selected, you can view and adjust all of its settings in the left side of the touchscreen 
rather than using the tab buttons at the bottom edge. 

When viewing the track channel strip: 

• The first field shows the current track, which you can change. 

• The second field shows the current program the track is using, which you can change (to a program 
of the same type).  

• To solo or mute the pad, tap Solo or Mute (respectively). 

• To change the panning of velocity of the track, adjust the pan knob or Velocity slider. 

Note: If the track is using a plugin program, then the slider will send CC #7 (Volume) and the knob will send 
CC #10 (Pan) to your instrument plugin. The plugin will then handle these messages as it normally would. 
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Program Mixer 

 

The program mixer shows levels, 
panning, mute states, send and insert 
effects, and routing for all used tracks. 

 

To view a specific setting on all 
programs, tap the Level, Pan, Mute, 
Send, Insert, or Route button on the 
bottom edge of the touchscreen. You 
can tap the Send or Insert buttons 
multiple times to cycle through the four 
available slots for each. 

 

 

 

When a program is selected, you can view and adjust all of its settings in the left side of the touchscreen 
rather than using the tab buttons at the bottom edge. 

When viewing the program channel strip: 

Note: This is the same as the program channel strip in Main Mode. 

• The first field shows the current program number and name, which you can change. 

• The second field shows where the program is routed, which you can change. 

• The Inserts field shows any enabled or disabled effects for that program. Tap the pencil icon to 
open a window where you can change and enable or disable the effects. 

• To solo or mute the program, tap Solo or Mute (respectively). 
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• To change the program’s automation, tap the automation button to cycle through its three states: 

o When off, the program will ignore automation data. If you have already 
recorded or entered automation, tapping this will switch between Read (R) 
and Write (W) only, but you can override this and turn it off by pressing and 
holding Shift while tapping the button. 

Important: If you have already recorded automation and turn it off, the track 
will still use the effect and its parameter values at the point where you turned 
it off. 

o When set to Read (R), the program will read automation data but will not 
record any additional automation over it. You can still manually edit and 
enter automation. (Think of this as a protective feature to prevent accidental 
changes to your automation while recording.) 

o When set to Write (W), the program can record automation. (If you have any 
Q- Link Knobs assigned to automatable parameters, make sure not to touch 
any accidentally while you are recording.) 

Tip: You can quickly set all programs to the same automation in XYFX 
Mode. See the XYFX Mode chapter to learn how to do this. 

• To change the panning or level of the program, adjust the pan knob or Level slider. 
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Return Mixer 

 

Pads and programs can each be sent 
to up to 4 send channels. Their audio 
signals will be routed to the send 
channels at their designated send 
levels. After being processed by the 
effect(s) on those channels, their 
signals are then sent back based on 
their return settings (levels, panning, 
etc.). This view displays the 4 return 
channels. The return mixer shows 
levels, panning, mute states, insert 
effects, and routing for all used tracks. 

 

To view a specific setting on all 
returns, tap the Level, Pan, Mute, 
Insert, or Route button on the bottom 
edge of the touchscreen. You can tap 
the Insert button multiple times to 
cycle through the four available slots. 

 

When a return is selected, you can view and adjust all of its settings in the left side of the touchscreen 
rather than using the tab buttons at the bottom edge. 

When viewing the return channel strip: 

• The first field shows the current return number, which you can change. 

• The second field shows where the return is routed, which you can change. 

• The Inserts field shows any enabled or disabled effects for that return. Tap the pencil icon to open 
a window where you can change and enable or disable the effects. 

• To mute the return, tap Mute. 

• To change the panning or level of the program, adjust the pan knob or Level slider. 
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Submixer  

 

The submixer shows levels, panning, 
mute states, send and insert effects, 
and routing for the 8 available 
submixes. 

 

To view a specific setting on all 
submixes, tap the Level, Pan, Mute, 
Send, Insert, or Route button on the 
bottom edge of the touchscreen. You 
can tap the Send or Insert buttons 
multiple times to cycle through the 
four available slots for each. 

 

 

When a return is selected, you can view and adjust all of its settings in the left side of the touchscreen 
rather than using the tab buttons at the bottom edge. 

When viewing the submix channel strip: 

• The first field shows the current submix, which you can change. 

• The second field shows where the submix is routed, which you can change. 

• The Inserts field shows any enabled or disabled effects for that submix. Tap the pencil icon to 
open a window where you can change and enable or disable the effects. 

• To mute the submix, tap Mute. 

• To change the panning or level of the submix, adjust the pan knob or Level slider. 
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Master Mixer 

 

The master mixer shows levels, 
panning, mute states, and insert effects 
for all used stereo pair of outputs. 

 

To view a specific setting on all 
outputs, tap the Level, Pan, Mute, or 
Insert button on the bottom edge of 
the touchscreen. You can tap the 
Insert button multiple times to cycle 
through the four available slots. 

 

 

 

 

When viewing the master channel strip: 

• The first field shows the current pair of outputs, which you can change. 

• The Inserts field shows any enabled or disabled effects for that pair of outputs. Tap the pencil icon 
to open a window where you can change and enable or disable the effects. 

• To mute that pair of outputs, tap Mute.  

• To change the panning or level of the master output, adjust the pan knob or Level slider. 
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Song Mode 
 

Song Mode lets you arrange sequences in a specific order and/or repetition to create songs. You can 
edit the structure of a song during playback for easy, on-the-fly composing. 

A project can contain up to 32 songs, each consisting of up to 999 “steps.” Each step can have an 
assigned sequence as well as the number of times that sequence will repeat. 

 

To open Song Mode, press Menu, and then tap Song Mode. 

 

 
Song Mode. 
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Use the Song field to select the song you want to show. 

 

Use the BPM field to adjust the tempo of the sequence.  

To set whether the sequence follows its own tempo or a master tempo, tap the 
Seq/Mst button next to the BPM field. Alternatively, press and hold Shift+Tap Tempo. 

 

The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

The sequence playlist on the left lists of the “steps” of a song. 

Each step has (in columns, left to right): 

• a step number (each song can contain up to 999 steps) 

• a sequence number and name 

• how many times the sequence plays (each step can play up to 
999 times; set it to Hld [the lowest/minimum value] to set the 
sequence to repeat indefinitely until you stop playback) 

• the tempo of the sequence 

• the number of bars the step occupies (based on how many 
times it plays) 
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Each used sequence is assigned to a pad. Empty pads correspond to 
unused sequences. You can use the Pad Bank buttons to access the 
sequences assigned to pads in other banks. 

 

To insert a step:  

1. Tap a step in the sequence playlist after which you want to insert a step. 

2. Tap Insert in the lower-right corner of the touchscreen.  

 

To change a step’s sequence: 

1. In the desired step, tap the sequence name. 

2. Use the Data Dial or –/+ buttons to select another sequence. 

 

To delete a step, tap it, and then tap Delete in the lower-right corner of the touchscreen. 

 

To clear the entire sequence playlist (delete all steps), tap Clear. 

 

To convert the current song to a single sequence: 

1. Tap Convert > Seq to open the Convert to Sequence window. 

2. Use the To Sequence field to select which sequence you want the song to export to. 

3. Use the Track Status field to select whether you want the song to Ignore Muted Tracks or Include 
Muted Tracks in the new sequence. 

4. To confirm your selections, tap Do It. 

To cancel the process, tap Close. 
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Browser 
 

The browser lets you navigate your computer’s internal and external hard disks to load samples, 
sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your 
preferred workflow. You can also audition (preview) your samples before loading them. 

 

To show the Browser, do any of the following: 

• Press Shift+Menu/Browse. 

• Double-press Menu/Browse. 

• Press Menu and then tap Browser. 

 

  

                            Viewing folders in the Browser.                                            Viewing files in the Browser. 

 

To view the files and folders on your computer, tap Project in the lower-left corner. 

 

To view the project’s sample pool and pads, tap Samples in the lower-left corner. 
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When the Project tab is selected, you can do any of the following: 

• To move to the previous folder, tap the up (∧) button in the upper-left corner. 

• To enter another hard disk, double-tap the file path field at the top of the touchscreen. In the list 
that appears, tap the desired location. Alternatively, tap the file path field and then use the Data 
Dial or the –/+ buttons to select a location. 

• To move through a list, swipe up or down. 

• To select a file or folder, tap it. 

• To enter a selected folder, tap it once more or tap Open. 

• To load a selected sample file, tap it once more or tap Load. This will load it to the currently 
selected pad (lit green) and the project’s sample pool. 

• To load all samples in a selected folder, press and hold Shift and then tap Load All in the lower-
right corner. You should not be in the folder when you do this—the folder itself should be 
highlighted in the Browser list. 

• To preview a selected sound, tap Play () at the bottom of the touchscreen.  

• To enable or disable the audition function, tap Audition at the bottom of the touchscreen. In the 
window that appears, tap Auto to enable or disable it. To adjust the level, tap and drag the Level 
slider up or down. Tap Audition once more to hide the window. 

Important: Only audio samples can be previewed. Also, make sure that your audio hardware is 
connected properly to listen to the audio file. 

 

To get the most efficient use of the Browser, set the file path 
to your hard disk(s) first. There are five folder buttons 
labeled 1–5 in the upper-right corner. You can set these to 
be shortcuts to five locations on your hard disk(s), giving 
you quick access to your files.  

Note: The browser will not display irrelevant files (e.g., text documents, spreadsheets, pictures, etc.).  

 

To assign the current location to a folder button, press and hold Shift, and then tap one of the folder 
buttons (1–5). Now, when you tap that folder button again, the Browser will display that folder’s content 
immediately. 
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You can use the filter buttons to show only 
specific types of files in the Browser. The 
selected button will be underlined red.  

• To show project files only, tap the P/page icon. 

• To show sequence files only, tap the bars icon. 

• To show program files only, tap the four-squares icon.  

• To show sample files only, tap the waveform icon. 

• To show all file types, tap All. 

 

The Project panel can show you the available 
programs, sequences, and samples that are 
already in your project. This is useful for 
checking your project’s available sounds without 
having to exit the Browser. 

To show or hide the Project panel, tap the 
Project button with the P/page icon at the 
bottom of the touchscreen. 

In the Project panel, you can do any of the 
following: 

• To move through a list, swipe up or down. 

• To expand or collapse the list of programs 
or sequences, tap the arrow (∨ or >) to its 
left. 

• To select a program, sequence, or sample, 
tap it. 

• To immediately select a sample and 
enter Sample Edit Mode, double-tap it. 

 Projects     Sequences   Programs        Samples       All Files 

The Project panel in the Browser. 
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When the Samples tab is selected, you can do any of the following: 

• To move through the Sample Pool, swipe up or down. 

• To preview a selected sound in the Sample Pool, tap Play () at the bottom of the touchscreen.  

• To select another program, double-tap the Program field at the top of the touchscreen. In the list 
that appears, tap the desired program. Alternatively, tap the Program field and then use the Data 
Dial or the –/+ buttons to select a location. 

• To enable or disable the audition function, tap Audition at the bottom of the touchscreen. In the 
window that appears, tap Auto to enable or disable it. To adjust the level, tap and drag the Level 
slider up or down. Tap Audition once more to hide the window. 

Important: Only audio samples can be previewed. Also, make sure that your audio hardware is 
connected properly to listen to the audio file. 

• To assign a sample to a pad, tap it (or press it) so it lights green. Then, in the Sample Pool list, 
double-tap the desired sample. Alternatively, use the Data Dial or –/+ buttons to assign a sample 
to and/or change the assigned sample on the selected pad. 

• To clear a sample from a pad, tap it (or press it) so it lights green, and then press the Data Dial. 

 

 
The Samples tab in the Browser. 
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Pad Perform Mode 
 

Pad Perform Mode lets you assign musical scales/modes, chords, or 
progressions to the pads for more creative performance. 

 

To enter Pad Perform Mode, press Menu, and then tap Pad Perform while using a keygroup program, 
MIDI program, or plugin program. 

 

 

Pad Perform Mode. 
 

The display will show the current pad bank’s mapping of notes or chords. 
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The counter indicates the current playhead position. 

To adjust the position, tap it, and then use the use the Data Dial or the –/+ buttons. 

To switch the time increments, double-tap it. You can view it in Bars, Beats, and 
Ticks or in hours (HH), minutes (MM), seconds (SS), and frames (FF). 

 

Use the Type selector to determine what will be mapped over the pads: 

• Notes: Each pad is assigned a note, ascending by one scale degree with each pad. 

• Chords: Each pad is assigned a chord, the root note ascending by one scale degree with each 
pad. All available chords will play in the key determined by the Scale. 

• Chromatic Chords: Each pad is assigned a chord, the root note ascending by one scale degree 
with each pad. You can play any chord type regardless of the key determined by the Scale. 
Essentially, this is like the Chords setting but with more options to play chords out of the set key. 

• Progressions: Each pad is assigned a chord in a chord progression. You can play the pads in (or 
out of) order to construct songs quickly. The available chords are determined by the Chord field. 

 

  

       Notes in Pad Perform Mode.            Chords in Pad Perform Mode. 
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            Chromatic Chords in Pad Perform Mode.           Progressions in Pad Perform Mode. 

 

Use the Scale & Octave fields to determine the root note and the scale type. 

• Root Note (pitch and register): This is the starting point of the scale. The available notes are all 
chromatic notes across the range of the pads. The pad that’s assigned the root note will be lit 
differently (and highlighted in the display) to indicate where the scale starts in each octave. 

• Scale Type: This is the scale or mode based on the root note. (This is disabled when Type is set to 
Progressions.) The available scales are: 

Major Gypsy Dorian 

Minor (melodic) Hungarian Gypsy Phrygian 

Pentatonic Major Persian Lydian 

Pentatonic Minor Major Bebop Mixolydian 

Blues (minor) Whole Tone Aeolian 

Flamenco Chromatic Locrian 
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Use the Chord fields to determine what chord type will play when pressing a pad. The resulting chord 
will use those scale degrees based off of the pad’s root note. You can use this only when the Type is set 
to Chords or Chromatic Chords. 

When set to Chords, the available chords are: 

1-3-5 (major/minor) 1-3-5-7 (major7/minor7) 

1-4-5 (sus4) 1-3-5-7b (dominant) 

1-2-5 (sus2)  
 

When set to Chromatic Chords, the available chords are: 

Major Major7 Augmented 

Minor Minor7 Diminished 

Sus2 Major9  

Sus4 Minor9  
 

Use the Banks selector to determine how the notes are mapped across the pad banks. 

• Start on Root: Pad 01 will always be the root note of the scale in every pad bank. 

• Continuous: Pad 01 of one bank is always one scale degree higher than Pad 16 of the previous bank. 

 

You can use the buttons at the bottom edge of the touchscreen to quickly select different Types and Chords: 

• Tap Notes to automatically set the Type to Notes. 

• Tap 1-3-5 to automatically set the Type to Chords and set the Chord to 1-3-5 (major/minor). 

• Tap 1-3-5-7 to automatically set the Type to Chords and set the Chord to 1-3-5-7 (major7/minor7). 

• Tap Progressions to automatically set the Type to Progressions. 

• Tap Octave –/+ to shift the pad assignments down or up by an octave. 

• Press Shift+1-4-5 to automatically set the Type to Chords and set the Chord to 1-4-5 (sus4). 

• Press Shift+1-3-5-7b to automatically set the Type to Chords and set the Chord to 1-3-5-7b 
(dominant). 

• Press Shift+Note –/+ to shift the pad assignments down or up by a scale degree. 
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Pad Color Mode 
 

Pad Color Mode lets you assign specific colors to your pads in each 
program. 

 

To enter Pad Color Mode, press Menu, and then tap Pad Color. 

 

 

Pad Color Mode. 
 

Use the Program field to select the program whose pad colors you want to set. 
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Use the field in the upper-left corner to set how the pad lights will display: 

• Off: The pads will be unlit whether you are playing them or not. 

• Classic Velocity: The pads will be unlit while you are not playing them. When you press them, they will 
light with colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity.  

• Fixed: The pads will be lit with their assigned colors whether you are playing them or not. 

• Off->Velocity: The pads will be unlit when you are not playing them. When you press them, they 
will light with their assigned color with a brightness that corresponds with the velocity. 

• Dim->Velocity: The pads will be dimly lit when you are not playing them. When you press them, 
they will light with their assigned color with a brightness that corresponds with the velocity. 

• Bright->Velocity: The pads will be brightly lit when you are not playing them. When you press 
them, they will light with their assigned color with a brightness that corresponds with the velocity. 

 

Use the Empty Pads field in the upper-left corner to set how empty pads will display: 

• Empty pads off: Pads without any sounds will remain off. 

• Empty pads dim: Pads without any sounds will remain more dimly lit than pads with sounds assigned. 

• Empty pads normal: Pads without any sounds will appear the same as pads with sounds assigned. 

 

Use the Single Pad/All Pads select to determine whether you are setting the color for a Single Pad or 
All Pads. 

Tip: To quickly assign that color to all pads in the program, press and hold Shift while tapping a color button. 

 

Use the color buttons to select which color you are assigning. 

Tip: To select the color button corresponding a specific pad’s color, press and hold Shift, and then 
press the pad or tap it on the touchscreen. 

 

Press a pad on MPC Touch or tap it on the touchscreen to select it. 
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Appendix 
 
Effects and Parameters 
 

This chapter lists the available effects in the software. To learn more about how effects work in the 
software, please see General Features > Effects. 

Note: Some of these effects have a “sync” version (e.g., Flanger Sync, Autopan Sync, etc.) whose 
rates will be affected by the current tempo. While viewing the rate of these effects, a . next to the time 
division indicates a triplet-based rate. 

 
 
Reverbs 
 

Options: Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, and 
Reverb Out Gate. 

 

Reverb Small 

This is a spatial effect, designed to 
emulate a small room. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 
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Reverb Medium 

This is a spatial effect, designed to 
emulate a medium room. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Reverb Large 

This is a spatial effect, designed to 
emulate the sound of a large hall. 

 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 
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Reverb Large 2 

This is a less CPU-intensive spatial 
effect, emulating the sound of a large 
hall. 

 
 

 

 

 

 

 

 

 

Reverb In Gate 

This is a hall reverb with an additional 
control. The reverb effect is cut off when 
the input drops below the level set in the 
Gate In parameter.  

 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate In 0–100 0 
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Reverb Out Gate 

This is a hall reverb that has an 
additional control. The reverb effect is 
cut off when the output drops below the 
level set in the Gate Out parameter.  
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate Out 0–100 0 
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Delays 
 

Delays the original signal for a specified period of time and plays it back over an adjustable period of time. 

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, 
Delay Analog, Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, and Delay Multi-Tap. 

 

Delay Mono 
 
 
 
 
 
 
 
 
 
 
 
Delay Mono Sync 
 
 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 25 

Damping 0–100 100 
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Delay Stereo 

Stereo Delay operates similarly to 
Mono Delay but in true stereo. 
 
 
 
 
 
 
 
 
Delay Sync (Stereo) 

Stereo Delay operates similarly to 
Mono Delay but in true stereo. 
 
 
 

 

 

 

Delay LP 

LP Delay is identical to the Mono 
Delay, but it uses a resonant low-
pass filter in the delay line. 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Damping 0–100 100 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 500 

Feedback 0–100 50 

Cutoff 0–100 50 

Resonance 0–100 20 



                 

 
272 

 

 

Delay HP 

HP Delay is identical to the Mono 
Delay, but it uses a resonant high-
pass filter in the delay line. 

 
 

 

 

 

Delay Analog 

Analog Delay is similar to the 
Mono Delay, except that it’s 
designed to emulate an analog 
“bucket brigade”-style delay. This 
delay has a unique character to it 
that gives a warmer sound by 
adding subtle inaccuracies in 
phase and timing. 

 
 
 
Delay Analog Sync 

Analog Delay is similar to Mono 
Delay, except that it’s designed to 
sound like an analog “Bucket 
Brigade”-style delay. This delay 
has a unique character to it that 
gives a warmer sound by adding 
subtle inaccuracies in phase and 
timing. 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 50 

Cutoff 0–100 33 

Resonance 0–100 33 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 
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Delay Tape Sync 

Tape Delay emulates a delay 
system using an analog tape loop 
and a series of tape heads to 
produce an echo effect. This delay 
type yields a very distinct echo 
sound often heard in reggae and 
dub-style music.  

 

 
 
 
 
 
 
 
 
 
 
Delay Ping Pong 

This stereo delay allows you to set 
different delay times for its left and 
right repeats. 

 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 

Head 1 0–100 100 

Head 2 0–100 0 

Head 3 0–100 0 

Head 4 0–100 0 

Tone 0–100 50 

Spread 0–100 50 

Wow & Flutter 0–100 50 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time, Left 2–2000 ms 100 

Time, Right 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 
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Delay Multi-Tap 

This delay is a mono delay which 
has three delay generators with 
independently adjustable delay 
times and stereo position. 

 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 50 

Time 1 2–2000 ms 100 

Time 2 2–2000 ms 100 

Time 3 2–2000 ms 100 

Feedback 0–100 25 

Pan 1 0–100 50 

Pan 2 0–100 50 

Pan 3 0–100 50 

Damping 0–100 100 

Gain 1 0–100 25 

Gain 2 0–100 25 

Gain 3 0–100 25 
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Flangers 
 

A flanger is a modulated delay to emulate the sound created when running two analog tape machines in 
parallel with a slight time disalignment. Slow Rate settings can produce a “whooshing” jet engine sound, 
while faster rates result in more of a “warble.” 

Options: Flanger and Flanger Sync. 

 

Flanger 
 
 
 
 
 
 
 
 
 
 
 
Flanger Sync 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Feedback -100 – 100  0 

Delay 0–100 20 

Width 0–100 80 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/16 triplets 1/4 

Feedback -100 – 100 0 

Delay 0–100 20 

Width 0–100 80 
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Chorus 
 

A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added 
to the dry signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up 
the Feedback and Depth for more pronounced “shimmering” and “watery” sounds. 

Options: Chorus 2-Voice and Chorus 4-Voice. 

 

Chorus 2-Voice 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chorus 4-Voice 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 
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Autopans 
 

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a 
rotary effect. 

Options: Autopan and Autopan Sync. 

 

Autopan 
 
 
 
 
 
 
 
Autopan Sync 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/32 1/4 
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Tremolos 
 

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO 
shape, this can produce a smooth wave effect (sine wave) or a stuttering “on-off” effect (square wave). 

Options: Tremolo and Tremolo Sync. 

 

Tremolo 
 
 
 
 
 
 
 
 
Tremolo Sync 
 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Sine to Square 0–100 (sine–square) 0 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 

Sine to Square 0–100 (sine–square) 0 
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Phasers 
 

The phaser is a classic effect, created by multiple ganged all-pass filters to create “notches,” or sharp 
spikes, in the frequency spectrum. The frequencies of these all-pass filters are usually modulated by an 
LFO to create a sweeping sound. 

Options: Phaser 1, Phaser 2, and Phaser Sync. 

 

Phaser 1 
 
 
 
 
 
 
Phaser 2 
 
 
 
 
 
 
Phaser Sync 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 
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HP (High-Pass) Filters 
 

Options: HP Filter, HP Filter Sweep, HP Filter Sync, and HP Shelving Filter. 

 

HP Filter 

This effect is a static filter without 
modulation. 
 
 
 
HP Filter Sweep 

This effect is a high-pass filter with 
its cutoff frequency modulated by 
an LFO.  
 
 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 50 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 
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HP Filter Sync 

This effect is a high-pass filter with 
its cutoff frequency modulated by 
an LFO.  
 
 
 
 
 
 
 
 
 
HP Shelving Filter 

This filter differs from the standard 
filter type, as it attenuates all 
frequencies after the cutoff point 
equally. 
 
 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 
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LP (Low-Pass) Filters 
 

Options: LP Filter, LP Filter Sweep, LP Filter Sync, and LP Shelving Filter. 

 

LP Filter 

This effect is a static filter without 
modulation. 

 
 
 
 
LP Filter Sweep 

This effect is a low-pass filter with 
its cutoff frequency modulated by 
an LFO.  

 
 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 
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LP Filter Sync 

This effect is a low-pass filter with 
its cutoff frequency modulated by 
an LFO.  
 
 
 
 
 
 
 
 
LP Shelving Filter 

This filter differs from the standard 
filter type, as it attenuates all 
frequencies after the cutoff point 
equally. 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

Parameter Value Range Default Value

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 
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Parametric EQs 
 

Options: PEQ 2-Band, 2-Shelf and PEQ 4-Band. 

 

PEQ 2-Band, 2-Shelf 

This effect is a combination of one 
two-band parametric equalizer 
and two shelving filters. 

 
 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220  

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 0 

Q2 0–100 0 

Low Gain -18.0 – 18.0 dB 0.0  

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0  

High Gain -18.0 – 18.0 dB 0.0  



                 

 
285 

 

 

PEQ 4-Band 

This effect is a powerful four-band 
parametric equalizer with four 
independent EQ ranges. 

 
 

Parameter Value Range Default Value

Low Frequency 22–1000 Hz 220 

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 5 

Q2 0–100 5 

Q3 0–100 5 

Q4 0–100 5 

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0 

Gain 3 -18.0 – 18.0 dB 0.0  

Gain 4 -18.0 – 18.0 dB 0.0  
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Distortions 
 

Options: Distortion Amp, Distortion Fuzz, Distortion Grimey, Distortion Overdrive, and Distortion 
Custom. 

 

Distortion Amp 

This effect is designed to reproduce 
the sound of a tube amplifier at 
high volumes. 

 
 
 
 
 
 
 
Distortion Fuzz 

This popular effect uses hard 
clipping of the audio signal, which, 
at extreme settings, can turn a 
standard waveform into a square 
wave, producing a “razor” effect.  

 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Tone 0–100 50 

Dynamics 0–100 50 

Output 0–100 50 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Output 0–100 50 

Low 0–100 50 

Low-Mid 0–100 50 

High-Mid 0–100 50 

High 0–100 50 
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Distortion Grimey 

This is a unique distortion effect 
that distorts a frequency range in a 
selectable band. 

 
 
 
 
 
 
 
 
 

Distortion Overdrive 

This distortion is designed to sound 
like a mildly distorting amplifier at 
medium volumes. It is the 
smoothest distortion type available.  

 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Grime 0–100 50 

Center 0–100 50 

Width 0–100 50 

Resonance 0–100 50 

Output 0–100 50 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Tone 0–100 50 

Output 0–100 50 
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Distortion Custom 

This effect is a highly customized 
distortion, capable of a wide range 
of useable sounds. 

 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

+Soft 5–75 2 

+Clip 5–50 25 

–Soft 5–75 2 

–Clip 5–50 25 

Low -18.0 – 18.0 dB 0.0  

Mid -18.0 – 18.0 dB 0.0  

High -18.0 – 18.0 dB 0.0  

Output -18.0 – 18.0 dB 50  
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Compressors 
 

A compressor is an effect that changes the dynamic range of a signal by automatically reducing its gain. 

 

Options: Compressor Master, Compressor Opto, Compressor VCA, and Compressor Vintage. 

 

Compressor Master 

This is the most transparent 
compressor, able to perform 
substantial volume adjustments 
without artifacts. 

 
 

 

 

 
Compressor Opto 

The Opto Compressor is modeled 
after a vintage compressor type 
using an optical circuit to control 
the volume reduction of the input 
signal. These compressors are 
usually associated with soft and 
unobtrusive attack and release 
characteristics. 

 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Oldskool Off, On Off 

Output -6 – 24 dB 0 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 
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Compressor VCA 

This compressor is more modern-
sounding, with a slightly more 
transparent sound. A VCA 
Compressor tends to have quicker 
attack and release times than an 
Opto Compressor.  

 

 

 

 

 

Compressor Vintage 

This compressor has a sound 
similar to classic tube 
compressors, with their gentle yet 
pumping response and a dash of 
tube saturation. 

 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 
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Bit Reducers 
 

Options: Decimator and Resampler. 

 

Decimator 

Decimator down-samples the 
incoming signal by removing bits 
from the digital signal. The 
difference between decimation 
and resampling is that Decimator 
does not use any filtering to mask 
or correct digital artifacts. The 
result is an effect ranging from 
mild to almost completely pure 
digital distortion, depending on the 
setting and the source material. 

 
 

Resampler 

Resampler is similar to Decimator 
in that it removes bits from an 
incoming signal. The difference is 
that Resampler applies a complex 
suite of filters and anti-aliasing to 
attempt to retain the original 
sound quality. This is a method 
used by popular vintage samplers 
and sampling drum machines from 
the 1980s. Resampler can be used 
to achieve a “dirty” sound on drum 
loops, without the harshness of 
distortion.  

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Decimate 0–100 0 

Bit Reducer 4–32 32 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 0 

Decimate 0–100 0 



                 

 
292 

 

 
Other 
 

Options: Auto Wah, Frequency Shifter, and Transient Shaper. 

 

Auto Wah 

This effect is a low-pass filter 
modulated by an envelope that 
yields a classic funky “wah-wah”- 
like sound. The envelope is 
triggered by the incoming signal’s 
amplitude. The amount of the 
envelope on the cutoff frequency 
is user-definable.  
 

 

 

 

Frequency Shifter 

A frequency shifter changes the 
frequencies of an input signal by a 
fixed amount and alters the 
relationship of the original 
harmonics. This can produce a 
chorus-like effect as well as very 
crazy artificial timbres. 
 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Resonance 0–100 75 

Attack 0–100 30 

Release 0–100 30 

Center 0–100 50 

Sensitivity 0–100 50 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Frequency -1000 – 1000 0 

Asynchrony 0–1000 0 

A Pan 0–100 0 

B Pan 0–100 100 

A Gain 0–100 75 

B Gain 0–100 75 
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Transient Shaper 

A transient shaper can be used to 
enhance or soften the Attack and 
Release phases of audio material. 

 
 

Parameter Value Range Default Value

Dry/Wet 0–100 (dry–wet) 100 

Attack 0–100 50 

Release 0–100 50 

Output 0–100 50 
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Glossary 
 

A lot of the terms in this manual are based on the MPC parameter names. This glossary briefly explains 
many of the technical terms used throughout. 

 

Aftertouch The majority of contemporary keyboards are capable of generating aftertouch 
messages. On this type of keyboard, when you press harder on a key you are already 
holding down, a MIDI aftertouch message is generated. This feature makes sounds even 
more expressive (e.g., through vibrato). 

Aliasing Aliasing is an audible side effect arising in digital systems as soon as a signal contains 
harmonics higher than half the sampling frequency. 

Amount Describes to which extent a modulation source influences a given parameter. 

Amplifier An amplifier is a component that influences the volume level of a sound via a control 
signal. It can be modulated by a control signal (e.g., generated by an envelope or an LFO). 

Attack An envelope parameter. This term describes the ascent rate of a time-relevant process 
(e.g., an envelope from its starting point to the point where it reaches its highest value). 
The attack phase is initiated immediately after a trigger signal is received (e.g., after you 
play a note on a trigger pad or a keyboard). 

Bit Rate Bit rate (also known as word length), is the number of bits used to store the level 
information of each single sample slice within a whole sample. The higher the bit rate, 
the more precise the information about a sample (i.e., its dynamics’ resolution). Normal 
audio CDs use 16-bit. MPC supports full 24-bit resolution. 

Clipping Clipping is a sort of distortion that occurs when a signal exceeds the maximum value 
that can be handled by a signal processing system it is fed into. The curve of a clipped 
signal is dependent on the system where the clipping occurs. In the analog domain, 
clipping effectively limits the signal to a given maximum level. In the digital domain, 
clipping is similar to a numerical overflow, resulting in negative polarity of the signal’s 
portions exceeding the maximum level. 
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Control Change 

(Controllers) 

MIDI messages enable you to manipulate the behavior of a sound generator to a 
significant degree. This message essentially consists of two components: 

• The controller number, which defines the parameter to be influenced. It can 
range from 0 to 127. 

• The controller value, which determines the extent of the modification. 

Controllers can be used for effects such as slowly swelling vibrato, changing the 
stereo panning position and influencing filter frequency. 

Cutoff The cutoff frequency is a significant factor for filters. A low-pass filter for example 
dampens the portion of the signal that lies above this frequency. Frequencies 
below this value are allowed to pass through without being processed. 

Decay Decay describes the descent rate of an envelope once the attack phase has reached 
its maximum and the envelope drops to the level defined by the sustain value. 

Envelope An envelope is used to modulate a sound-shaping component within a given time. 
For instance, an envelope that modulates the cutoff frequency of a filter opens and 
closes this filter over a period of time. An envelope is started via a trigger, usually a 
MIDI note. The classic ADSR envelope consists of four individually variable phases: 
attack, decay, sustain, and release. Attack, decay and release are time or slope 
values, while sustain is an adjustable level. Once an incoming trigger is received, the 
envelope runs through the attack and decay phases until it reaches the programmed 
sustain level. This level remains constant until the trigger is terminated. The envelope 
then initiates the release phase until it reaches the minimum value. 

Filter A filter is a component that allows some of a signal’s frequencies to pass through it 
and dampens other frequencies. The most important aspect of a filter is the filter 
cutoff frequency. Filters generally come in four categories: low-pass, high-pass, 
band-pass, and band-stop. A low-pass filter dampens all frequencies above the 
cutoff frequency. A high-pass filter in turn dampens the frequencies below the 
cutoff. The band-pass filter allows only those frequencies around the cutoff 
frequency to pass; all others are dampened. A band-stop filter does just the 
opposite; it dampens only the frequencies around the cutoff frequency. The most 
common type is the low-pass filter. 
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LFO LFO is an acronym for low-frequency oscillator. The LFO generates a periodic 
oscillation at a low frequency and features variable waveshapes. Similar to an 
envelope, an LFO can be used to modulate a sound-shaping component. 

MIDI MIDI stands for musical instrument digital interface. Developed in the early 1980s, 
MIDI enables interaction between various types of electronic music instruments from 
different manufacturers. At the time a communications standard for heterogeneous 
devices did not exist, so MIDI was a significant advance. It made it possible to link 
various devices with one another through simple, standardized connectors. 

Essentially, this is how MIDI works: One sender is connected to one or several 
receivers. For instance, if you want to use a computer to play a MIDI synthesizer, the 
computer is the sender and the synthesizer acts as the receiver. With a few exceptions, 
the majority of MIDI devices are equipped with two or three ports for this purpose: MIDI 
In, MIDI Out and in some cases MIDI Thru. The sender transfers data to the receiver via 
the MIDI Out jack. Data are sent via a cable to the receiver’s MIDI In jack. 

MIDI Thru has a special function. It allows the sender to transmit to several receivers. 
It routes the incoming signal to the next device without modifying it. Another device is 
simply connected to this jack, thus creating a chain through which the sender can 
address a number of receivers. Of course it is desirable for the sender to be able to 
address each device individually. To achieve this, a MIDI channel message is sent 
with each MIDI event. 

MIDI Channel This is a very important element of most messages. A receiver can only respond to 
incoming messages if its receive channel is set to the same channel as the one the 
sender is using to transmit data. Subsequently, the sender can address specific 
receivers individually. MIDI Channels 1–16 are available for this purpose. 

MIDI Clock The MIDI clock message transmits real-time tempo information to synchronize 
processes among several connected devices (e.g., a sound generator’s delay time to 
a MIDI sequencer). 

Modulation A modulation influences or changes a sound-shaping component via a modulation 
source. Modulation sources include envelopes, LFOs or MIDI messages. The 
modulation destination is a sound-shaping component such as a filter or a VCA. 



                 

 
297 

 

 

Note On and  
Note Off 

This is the most important MIDI message. It determines the pitch and velocity of 
a generated note. A note-on message will start a note. Its pitch is derived from 
the note number, which can range from 0 to 127. The velocity lies between 1 and 
127. A velocity value of 0 is equivalent to a note-off message. 

Normalize Normalization is a function to raise the level of a sample to its maximum (0 dB) 
without causing distortion. This function automatically searches a sample for its 
maximum level and consequently raises the entire sample’s level until the 
previously determined maximum level reaches 0 dB. In general this results in a 
higher overall volume of the sample. 

Panning The process or the result of changing a signal’s position within the stereo 
panorama. 

Pitch-Bend Pitch-bend is a MIDI message. Although pitch-bend messages are similar in 
function to control change messages, they are a distinct type of message. The 
resolution of a pitch-bend message is substantially higher than that of a 
conventional controller message. The human ear is exceptionally sensitive to 
deviations in pitch, so the higher resolution is used because it relays pitch-bend 
information more accurately. 

Program A program is a file that contains a list of all samples to be used, and settings for 
each sample (e.g., pad assignments, loop points, pitch tuning, effects, etc.) 
MPC’s Program Edit Mode is where you can edit and assign samples. The 
software can have a total of 128 programs in a project. 

There are two kinds of programs that use samples for their sound source: drum 
programs, mostly used for creating drum programs and easy and quick 
assigning of samples to a pad, and keygroups programs. With keygroup 
programs, you can use one sample (or more) and spread it across two or more 
keys and play the sample chromatically over a keyboard. That way, there is no 
need to sample every key of, for instance, a piano. 

Program Change These are MIDI messages that select sound programs. Program numbers 1 
through 128 can be changed via program change messages. 
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Release An envelope parameter. This term describes the descent rate of an envelope to its 
minimum value after a trigger is terminated. The release phase begins immediately after 
the trigger is terminated, regardless of the envelope’s current status. For instance, the 
release phase may be initiated during the attack phase. 

Resonance Resonance or emphasis is an important filter parameter. It emphasizes the frequencies 
around the filter cutoff frequency by amplifing them with a narrow bandwidth. This is 
one of the most popular methods of manipulating sounds. If you increase the emphasis 
to a level where the filter enters a state of self-oscillation, it will generate a relatively 
pure sine waveform. 

Root Key The root key defines the original pitch of a recorded instrument or of a sample. 
Samples in the software contain the dedicated root key information. This information 
will be created automatically during recording or importing. 

Sample When you tap the pads on your MPC hardware, you can trigger sounds that we call 
samples. Samples are digitized snippets of audio that can either be recorded using the 
recording function of your MPC software or loaded from the Browser. 

Once a sample is present in the software, it can be manipulated in different ways. For 
example, a sample can be trimmed, looped, pitch-shifted or processed, using various 
effects offered by the software. When you have finished editing your sample, you can 
assign it to one or more drum pads to play it. Samples can be either mono or stereo. 

Sample Rate This is the frequency representing the amount of individual digital sample scans per 
second that are taken to capture an analog siginal digitally. For normal CD audio 
recordings, 44100 samples per second are used, also written as 44.1 kHz. The 
software offers sampling rates up to 96 kHz. 

Sequence A sequence is the most basic building-block of music you can compose on the 
software. MIDI information from the MPC hardware pads, buttons, and Q-Link Knobs 
are recorded to the tracks of a sequence. Each sequence contains 64 tracks. Each 
project can store up to 128 separate sequences. 

The length of a sequence can be set from 1 to 999 bars, which would be enough to 
create an entire song using only one sequence. However, the software has a dedicated 
Song Mode that lets you chain sequences together to create a song. 
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Song The software has a special Song Mode that allows you to arrange different sections 
(verse, chorus, hook, etc.) in order to build a song. Each song can have up to 999 
“steps” (stages in which a sequence may play one or more times). Each project can 
store up to 32 songs. 

Sustain This term describes the level of an envelope remaining constant after it has passed the 
attack and decay phases. Once reached, the sustain level is kept until the trigger is 
terminated. 

Track A sequence contains 64 tracks and each track can record notes and controller data. 
For example, you can record the verses of a song on Track 1, while recording the 
choruses on Track 2. Alternatively, you can record different instruments on each track. 

Note that your performances are recorded as MIDI events and the actual digital audio is 
not recorded onto a track. That way, you can edit your performance in many different 
ways once the performance has been captured. 

Trigger A trigger is a signal that initiates events. Trigger signals are very diverse. For instance, a 
MIDI note or an audio signal can be used as a trigger. The events a trigger can initiate 
are also very diverse. A common application for a trigger is its use to start an envelope. 
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Trademarks and Licenses 
 

Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other 
countries. 

AAX and RTAS are trademarks or registered trademarks of Avid Technology, Inc. in the U.S. and other 
countries. 

ASIO, Cubase, and VST are trademarks of Steinberg Media Technologies GmbH. 

Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

All other product or company names are trademarks or registered trademarks of their respective owners. 
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